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1 Printer basics

● Product comparison

● Product features

● Product walkaround
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Product comparison
The HP Color LaserJet CP3505 is available in the configurations described below.

Table 1-1  HP Color LaserJet CP3505 configurations

HP Color LaserJet CP3505 HP Color LaserJet
CP3505n

HP Color LaserJet
CP3505dn

HP Color LaserJet
CP3505x

● 22 ppm (letter-size) or 21 ppm
(A4) print speed

● 100-sheet multipurpose tray
(tray 1) and 250-sheet input tray
(tray 2)

● Hi-Speed USB 2.0 port and EIO
slot

● 256 megabytes (MB) of random
access memory (RAM)

HP Color LaserJet
CP3505, plus:

● HP Jetdirect full-
featured embedded
print server to
connect to 10Base-T/
100Base-TX
networks

HP Color LaserJet
CP3505, plus:

● 384 MB RAM

● Automatic 2-sided
(duplex) printing

● HP Jetdirect full-
featured embedded
print server to connect
to 10Base-T/
100Base-TX
networks

HP Color LaserJet
CP3505, plus:

● 384 MB RAM

● Automatic 2-sided
(duplex) printing

● HP Jetdirect full-
featured embedded
print server to
connect to 10Base-T/
100Base-TX
networks

● 500-sheet input tray
(tray 3).
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Product features
Table 1-2  Features

Feature HP Color LaserJet CP3505 Series printer

Performance ● 450 MHz processor

Memory ● HP Color LaserJet CP3505: 256 MB RAM

● HP Color LaserJet CP3505n: 256 MB RAM

● HP Color LaserJet CP3505dn: 384 MB RAM

● HP Color LaserJet CP3505x: 384 MB RAM

User interface ● Graphic display

● Control-panel help

● Windows and Macintosh printer drivers

● Embedded Web server to gain access to support and to order supplies (administrator tool for network-connected
models only)

Printer drivers ● HP PCL 5c

● HP PCL 6

● PostScript 3 emulation

Job storage ● Fonts, forms, and other macros

● Job retention

Fonts ● 80 internal fonts available for both PCL and PostScript 3 emulation

● 80 printer-matching screen fonts in TrueType format available with the software solution

Expandability ● Optional 500-sheet input tray (tray 3) (standard on the HP Color LaserJet CP3505x printer)

● Dual inline memory modules (DIMM)

Connectivity ● Hi-Speed USB 2.0 cable interface

● HP Jetdirect full-featured embedded print server (standard on the HP Color LaserJet CP3505n, CP3505dn, and
CP3505x printers) with IPv6

● HP Web Jetadmin software (standard on the HP Color LaserJet CP3505n, CP3505dn, and CP3505x models)

● Enhanced input/output (EIO) slot

Environmental ● Sleep Mode setting

● High content of recyclable components and materials

● Energy Star® qualified
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Feature HP Color LaserJet CP3505 Series printer

Paper handling ● Input

◦ Tray 1 (multipurpose tray): A multipurpose tray for paper, transparencies, labels, and envelopes. Holds up to
100 sheets of paper or 20 envelopes.

◦ Tray 2: 250-sheet tray that automatically detects standard paper sizes up to legal and allows printing on
custom-size paper.

◦ Tray 3: 500-sheet tray that automatically detect standard paper sizes up to legal and allows printing on custom-
size paper.

● Output

◦ Face-up output bin

◦ Face-down output bin

Supplies ● Supplies status page contains information about toner level, page count, and estimated pages remaining.

● No-shake cartridge design

● Printer checks for authentic HP print cartridges at cartridge installation.

● Internet-enabled supply-ordering capabilities (using HP Easy Printer Care Software)

Accessibility ● The online user guide is compatible with text screen-readers.

● Print cartridges can be installed and removed by using one hand.

● All doors and covers can be opened by using one hand.

● Media can be loaded in tray 1 by using one hand.

Table 1-2  Features (continued)
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Product walkaround
The following illustrations identify the locations and names of key printer components.

Figure 1-1  Front view (shown with optional 500-sheet paper feeder)

1
2

3

4

5

6

7

8

1 Output bin extender

2 Output bin

3 Top cover

4 Printer control panel

5 Front door

6 Tray 1 (holds 100 sheets of standard paper)

7 Tray 2 (holds 250 sheets of standard paper)

8 Tray 3 (optional; holds 500 sheets of standard paper)
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Figure 1-2  Back and side view

2

3

1

4

5

1 On/off switch

2 Power connection

3 EIO slot

4 Hi-Speed USB 2.0 port

5 Network port (available on the HP Color LaserJet CP3505n, CP3505dn, and CP3505x)

Figure 1-3  Sample model and serial number label

serial number

Model name Model number

HP Color LaserJet CP3505 CB441A
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HP Color LaserJet CP3505n CB442A

HP Color LaserJet CP3505dn CB443A

HP Color LaserJet CP3505x CB444A
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2 Control panel

● Control-panel overview

● Control-panel menus

● Retrieve Job menu

● Information menu

● Paper Handling menu

● Configure Device menu

● Diagnostics menu

● Change control-panel configuration settings

● Use the printer control panel in shared environments

ENWW 9



Control-panel overview
The control panel provides controls for printer functions and shows messages about the printer, print
jobs, and supplies status.

Figure 2-1  Control panel buttons and lights

?

101112 9

87654321

Number Button or light Function

1 Stop button Halts the current job, presents a choice to resume or cancel the
current print job, clears media from the printer, and clears any
continuable errors that are associated with the halted job. If the printer
is not printing a job, pressing Stop pauses the printer.

2 Menu button Opens and closes menus.

3 Ready light Indicates that the printer is online or offline. See Control-panel
indicator lights on page 11.

4 Data light Indicates whether or not the printer is receiving data. See Control-
panel indicator lights on page 11.

5 Attention light Indicates that a critical error has occurred. See Control-panel
indicator lights on page 11.

6 Back arrow ( ) button Navigates backward in nested menus.

7 Up arrow ( ) button Navigates menus and text, and increases the values of numerical
items in the display.

8 Select ( ) button Makes selections, resumes printing after continuable errors, and
overrides a non-HP print cartridge.

9 Help ( ) button Provides detailed information about printer messages or menus.

10 Down arrow ( ) button Navigates menus and text, and decreases the values of numerical
items in the display.

11 Supplies gauge Shows the print cartridge-consumption levels. See Display
on page 11.

12 Display Shows status information, menus, help information, and error
messages. See Display on page 11.
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The printer communicates through the display and the lights on the lower part of the control panel. The
display shows status information, as well as menus, help information, and error messages. The Ready,
Data, and Attention lights provide at-a-glance information about the printer state.

You can perform most routine printing tasks from the computer through the printer driver or any software
program. Use the control panel to access printer features not supported by the printer driver or software
program. Any changes that you make from the computer will override the printer control-panel settings.

Control-panel indicator lights

Indicator On Off Flashing

Ready

(green)

Printer is online (can accept
and process data).

Printer is offline (paused), or
is turned off.

Printer is attempting to stop
printing and go offline. This
usually results from a user's
request to pause the current
job.

Data

(green)

Processed data is present in
the printer, but more data is
needed to complete the job, or
the job is paused or waiting for
errors to be cleared.

Printer is not processing or
receiving data.

Printer is processing and
receiving data.

Attention

(amber)

A critical error has occurred.
Printer requires attention.

No conditions exist that
require attention.

An error has occurred. Printer
requires attention.

Display
The printer display gives you complete, timely information about the printer and print jobs. Graphics
illustrate levels of supplies. Menus provide access to printer functions and detailed information.

The top-level screen on the display has two areas: message/prompt and supplies gauge.

Figure 2-2  Printer display

1 2

3

1 Message/prompt area

2 Supplies gauge

3 Print cartridge colors from left to right: black, yellow, cyan, and magenta
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The message and prompt areas of the display alert you to the state of the printer and tell you how to
respond.

The supplies gauge shows the consumption levels of print cartridges (black, cyan, magenta, and yellow).
When a non-HP print cartridge is installed, a ? might appear instead of the consumption level. The
supplies gauge appears whenever the printer shows the Ready state, and whenever the printer shows
a warning or error message concerning a cartridge.
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Control-panel menus
To gain access to the control-panel menus, complete the steps below.

1. Press Menu.

2. Press  or  to navigate the listings.

3. Press  to select the appropriate option.

4. Press  to return to the previous level.

5. Press Menu to exit the menu.

6. Press  to see additional information about a menu.

The main menus are shown in the following table.

Main menus SHOW ME HOW

RETRIEVE JOB

INFORMATION

PAPER HANDLING

CONFIGURE DEVICE

DIAGNOSTICS

SERVICE
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Retrieve Job menu
NOTE: This menu appears only if the printer has a hard disk installed.

Use the RETRIEVE JOB menu to print or delete stored jobs from the control panel.

Menu item Value Description

<USER NAME> ALL PRIVATE JOBS

<JOB NAME>

ALL PRIVATE JOBS appears if you have more than one
stored job protected by a personal identification number
(PIN).

<JOB NAME> will be the name assigned to the print job when
you sent it from your computer.

Once you have selected a print job, you can print or delete it.

For more information about stored jobs, see Manage stored jobs on page 81.
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Information menu
Use the INFORMATION menu to gain access to and print specific printer information.

Sub-menu Description

PRINT MENU MAP Prints the control-panel menu map, which shows the layout and current settings of the
control-panel menu items. See Information pages on page 110.

PRINT CONFIGURATION Prints the printer configuration page.

PRINT SUPPLIES STATUS PAGE Prints information about toner level, page count, and estimated pages remaining.

SUPPLIES STATUS Shows the supplies status in a scrollable list.

PRINT USAGE PAGE Prints a count of all media sizes that have passed through the printer; lists whether they
were one-sided (simplex) , 2-sided (duplex), monochrome (black and white), or color;
and reports the page count.

PRINT COLOR USAGE JOB LOG Prints a report that shows the user name, application name and color usage information
on a job-by-job basis.

PRINT DEMO Prints a demonstration page.

PRINT RGB SAMPLES Prints an RGB color palette that can be used for color matching.

PRINT CMYK SAMPLES Prints a CMYK color palette that can be used for color matching.

PRINT FILE DIRECTORY Prints the names and directory of files stored in the printer.

PRINT PCL FONT LIST Prints the available PCL fonts.

PRINT PS FONT LIST Prints the available PS (emulated PostScript) fonts.
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Paper Handling menu
Use the PAPER HANDLING menu to configure trays by size and type.

NOTE: To configure the trays correctly, use this menu before you print for the first time.

Menu item Value Description

TRAY 1 SIZE A list of available sizes
appears.

Configures the paper size for tray 1. The default is ANY SIZE. See Supported
paper and print media sizes on page 61 for a complete list of available sizes.

TRAY 1 TYPE A list of available types
appears.

Configures the paper type for tray 1. The default is ANY TYPE. See Supported
paper and print media sizes on page 61 for a complete list of available types.

TRAY 2 SIZE

TRAY 3 SIZE

A list of available sizes
appears.

Configures the paper size for tray 2 or optional tray 3. The default size is letter
or A4, depending on the country/region. See Supported paper and print media
sizes on page 61 for a complete list of available sizes.

TRAY 2 TYPE

TRAY 3 TYPE

A list of available types
appears.

Configures the paper type for tray 2 or optional tray 3. The default is PLAIN.
See Supported paper and print media sizes on page 61 for a complete list of
available types.
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Configure Device menu
Use the CONFIGURE DEVICE menu to change or reset the default print settings, to adjust the print
quality, and to change the system configuration and I/O options. The five CONFIGURE DEVICE sub-
menus are described in the sections below.

Printing sub-menu
These settings affect only jobs that do not have identified properties. Most jobs identify all of the
properties and override the values that are set from this menu. This menu can also be used to set the
default paper size and type.

Menu item Values Description

COPIES 1-32,000 Sets the default number of copies. The default number of copies is 1.

DEFAULT PAPER
SIZE

A list of available sizes
appears.

Sets the default paper size.

DEFAULT CUSTOM
PAPER SIZE

UNIT OF MEASURE

X DIMENSION

Y DIMENSION

Sets the default size for any custom job without dimensions. Available
for tray 1.

DUPLEX

(HP Color LaserJet
CP3505dn and
CP3505x only)

OFF

ON

Enables or disables the duplex function (automatic 2-sided printing).
The default is OFF. You can override this setting in the printer driver.

DUPLEX BINDING

(HP Color LaserJet
CP3505dn and
CP3505x only)

LONG EDGE

SHORT EDGE

Defines whether a duplex job will be flipped on the long edge or the short
edge. You can override this setting in the printer driver.

OVERRIDE A4/
LETTER

NO

YES

Sets the printer to print an A4 job on letter-size paper when no A4 paper
is loaded, or to print a letter-size job on A4 when no letter-size paper is
loaded. The default is NO.

MANUAL FEED OFF

ON

The default is OFF. Setting it to ON makes MANUAL FEED the default
for jobs that do not select a tray. You can override this setting in the
printer driver.

COURIER FONT REGULAR

DARK

Selects a version of the Courier font. The default is REGULAR.

WIDE A4 NO

YES

Sets the printable area of A4 paper so that eighty 10-pitch characters
can be printed on a single line. The default is NO.

PRINT PS ERRORS OFF

ON

Select ON to print emulated PostScript (PS) error pages. The default is
OFF.

PRINT PDF ERRORS OFF

ON

Select ON to print portable document format (PDF) error pages. The
default is OFF.

PCL FORM LENGTH

ORIENTATION

Configures settings for the printer control language.

FORM LENGTH sets the number of lines per page. The default is 60.
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Menu item Values Description

FONT SOURCE

FONT NUMBER

FONT PITCH

FONT POINT SIZE

SYMBOL SET

APPEND CR TO LF

SUPPRESS BLANK
PAGES

MEDIA SOURCE
MAPPING

ORIENTATION determines long-edge versus short-edge page layout.
The default is PORTRAIT.

FONT SOURCE selects the source of the font used on the printer control
panel. The default is INTERNAL. FONT NUMBER is the number of the
font you select. If this font is a contour font, use FONT PITCH to set the
pitch of a fixed-space font. The default is 10.00.

FONT POINT SIZE sets the size of fixed-space fonts. The default font
is 12 points.

SYMBOL SET sets the symbol set used by the printer control panel.
The default is PC-8.

APPEND CR TO LF sets whether a carriage return is appended to each
line feed in a backward-compatible PCL job. The default is NO.

SUPPRESS BLANK PAGES sets whether jobs using PCL that include
blank form feeds will automatically suppress the blank pages. YES
indicates that form feeds will be ignored if the page is blank.

The PCL5 MEDIA SOURCE MAPPING command selects an input tray
by a number that maps to the various available trays.
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Print Quality sub-menu
Use this menu to adjust all aspects of print quality, including calibration, registration, and color half tone
settings.

Menu item Values Description

ADJUST COLOR HIGHLIGHTS

MIDTONES

SHADOWS

RESTORE COLOR
VALUES

Modifies the half tone settings for each color. The default for each color
is 0.

SET REGISTRATION PRINT TEST PAGE

SOURCE

ADJUST TRAY 1

ADJUST TRAY 2

ADJUST TRAY 3

Shifts the margin alignment to center the image on the page from top to
bottom, and left to right. You can also align the image that is printed on
the front with the image that is printed on the back.

AUTO SENSE MODE TRAY 1 SENSING

TRAY >1 SENSING

If a tray is configured to PLAIN or ANY SIZE, and the print job does not
specify the media type, the printer will adjust the print quality for the type
of print media it senses. The default for tray 1 is FULL SENSING, which
senses transparencies, glossy paper, and tough paper.

PRINT MODES A list of media types
appears. When you select
a type, a list of available
modes appears.

Associates each media type with a specific print mode.

OPTIMIZE A list of parameters
appears.

Optimizes certain parameters for all jobs rather than (or in addition to)
optimizing by paper type.

EDGE CONTROL OFF

LIGHT

NORMAL

MAXIMUM

Controls how edges are printed.

AUTO CLEANING OFF (default)

ON

Select this option to turn automatic cleaning on or off.

QUICK CALIBRATE
NOW

 Performs a limited printer calibration.

FULL CALIBRATE
NOW

 Performs all printer calibrations to optimize print quality.

DELAY
CALIBRATION AT
WAKE/POWER-ON

NO

YES

Prints before the calibration process after turning on the printer or
bringing it out of sleep mode.
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Menu item Values Description

CREATE CLEANING
PAGE

(HP Color LaserJet
CP3505 and CP3505n
only)

 Prints a cleaning page to be used for cleaning the printer. This page
contains instructions for processing the cleaning page. See Clean the
printer on page 126 for more information.

PROCESS
CLEANING PAGE

(HP Color LaserJet
CP3505dn and
CP3505x only)

 For duplexing printers, this command creates and processes the
cleaning page. For non-duplexing printers, after the cleaning page is
loaded in tray 1, this menu item processes the cleaning page that was
created by the CREATE CLEANING PAGE command. The cleaning
process takes a few moments. See Clean the printer on page 126 for
more information.

System Setup sub-menu
Use the SYSTEM SETUP menu to make changes to default settings for general printer configuration,
such as date/time, printer personality (language), and jam recovery. See Change control-panel
configuration settings on page 26 for more information.

Menu item Values Description

DATE/TIME DATE

DATE FORMAT

TIME

TIME FORMAT

Sets the time and date on the printer.

JOB STORAGE LIMIT 1–100 Limits the number of stored jobs that can be saved to the
printer.

JOB HELD TIMEOUT OFF

1 HOUR

4 HOURS

1 DAY

1 WEEK

Sets the amount of time that a stored job can remain on the
printer before it is automatically deleted. The default is
OFF.

SHOW ADDRESS AUTO

OFF

Select AUTO to show the printer IP address on the printer
control panel, alternating with the Ready message. The
default is OFF.

This menu item appears only if the printer is connected to a
network.

RESTRICT COLOR USE DISABLE COLOR

ENABLE COLOR

COLOR IF ALLOWED

Disables or restricts color use. The default is ENABLE
COLOR. To use the COLOR IF ALLOWED setting, set up
user permissions by using the embedded Web server. See
Use the embedded Web server on page 113.

COLOR/BLACK MIX AUTO

MOSTLY COLOR PAGES

MOSTLY BLACK PAGES

Establishes how the printer switches from color to
monochrome (black and white) mode for maximum
performance and print cartridge life.
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Menu item Values Description

AUTO will reset the printer to the factory default setting. The
default is AUTO.

Select MOSTLY COLOR PAGES if nearly all of your print
jobs are color with high page coverage.

Select MOSTLY BLACK PAGES if you print mostly
monochrome print jobs, or a combination of color and
monochrome print jobs.

TRAY BEHAVIOR USE REQUESTED TRAY

MANUALLY FEED
PROMPT

PS DEFER MEDIA

USE ANOTHER TRAY

SIZE/TYPE PROMPT

DUPLEX BLANK PAGES

Specifies settings for the tray selection behavior. (Use this
setting to configure the trays to behave like trays in some
previous HP printers.)

The default for USE REQUESTED TRAY is
EXCLUSIVELY.

The default for MANUALLY FEED PROMPT is ALWAYS.

PS DEFER MEDIA affects how paper is handled when
printing from an Adobe® PS print driver. ENABLED uses
HP's paper handling. DISABLED uses the Adobe PS paper
handling. The default is ENABLED.

USE ANOTHER TRAY defines whether the printer prompts
the user to use another tray when the selected tray is
unavailable. The default is ENABLED.

SIZE/TYPE PROMPT defines whether the printer prompts
the user to reconfigure the tray after loading and closing the
tray. The default is DISPLAY.

DUPLEX BLANK PAGES defines whether the printer flips
a page over even when a page is blank. The default is
AUTO (duplex models only).

See Tray Behavior menu options on page 26 for more
information.

SLEEP DELAY 1 MINUTE

15 MINUTES

30 MINUTES

45 MINUTES

60 MINUTES

90 MINUTES

2 HOURS

4 HOURS

Reduces power consumption when the printer has been
inactive for an extended period.

Sets the length of time the printer remains inactive before
going into sleep mode. The default is 30 MINUTES.

WAKE TIME MONDAY

TUESDAY

WEDNESDAY

THURSDAY

FRIDAY

Sets a “wake-up” time for the printer to warm up and calibrate
each day. The default for each day is OFF. If you set a wake
time, HP recommends setting an extended sleep delay time
period, so that the printer will not return to sleep mode soon
after waking.
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Menu item Values Description

SATURDAY

SUNDAY

OPTIMUM SPEED/ENERGY
USAGE

FASTER FIRST PAGE

SAVE ENERGY

Affects print speed by defining whether the fuser cools
between jobs. When FASTER FIRST PAGE is selected, the
fuser does not cool, and printing is faster. When SAVE
ENERGY is selected, the fuser cools between jobs. The
default is FASTER FIRST PAGE.

DISPLAY BRIGHTNESS 1–10 Adjusts the brightness of the printer control panel. The
default is 5. See Set the Display Brightness feature
on page 28.

PERSONALITY AUTO

PCL

PDF

PS

Sets the default personality to automatic switching, PCL,
PDF, or PostScript emulation. The default is AUTO.

See Personality feature on page 28 for more information.

CLEARABLE WARNINGS JOB

ON

Sets the amount of time that a clearable warning appears on
the printer control panel. The default is JOB, which appears
until the end of the job that generated the warning. ON
appears until the  is pressed.

See Clearable Warnings feature on page 29 for more
information.

AUTO CONTINUE OFF

ON

Determines printer behavior when the system generates an
auto-continuable error. The default is ON.

ON automatically continues printing after 10 seconds.

OFF pauses printing. Press  to continue printing.

See Auto Continue feature on page 29 for more
information.

REPLACE SUPPLIES STOP AT LOW

STOP AT OUT

OVERRIDE AT OUT

Sets low or out supplies operating options. The default is
STOP AT OUT.

STOP AT LOW pauses printing when a low supply is
reported. Press  to continue printing.

OVERRIDE AT OUT allows the printer to continue printing
even after some supplies have run out.

See Replace Supplies feature on page 30 for more
information.

ORDER AT 0–100 The user can set the percent remaining at which the ORDER
AT message is displayed. The default percentage is 15.

COLOR SUPPLY OUT STOP

AUTOCONTINUE BLACK

Sets the printer behavior when a color print cartridge is
empty. When the printer is set to AUTOCONTINUE BLACK,
the printer continues printing using black toner only. The
default is STOP.

JAM RECOVERY AUTO

OFF

ON

Sets whether the printer will attempt to reprint pages after a
jam. The default is AUTO.

See Jam Recovery feature on page 30 for more
information.
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Menu item Values Description

RAM DISK AUTO

OFF

Determines how the RAM disk feature is configured. Select
AUTO to allow the printer to determine the optimal RAM disk
size based on the amount of available memory. OFF
disables the RAM disk, but a minimal RAM disk is still
available. The default is AUTO.

LANGUAGE A list of available languages
appears.

Sets the default control-panel language.

See Language feature on page 31 for more information.

I/O sub-menu
Use the I/O menu to configure the printer input/output options.

See Network configuration on page 55.

Menu item Values Description

I/O TIMEOUT 5–300 Selects the I/O timeout in seconds.

PAGE BUFFERING OFF

ON

Sets whether the printer should maximize performance or
minimize engine wear while waiting for information to be
transferred. Select ON if the printer uses USB or Ethernet
10Base-T. The default is OFF.

EMBEDDED JETDIRECT Possible values are:

TCP/IP

IPX/SPX

APPLETALK

DLC/LLC

SECURE WEB

DIAGNOSTICS

RESET SECURITY

LINK SPEED

Configures the HP Jetdirect embedded print server.

EIO 1 JETDIRECT Values vary, depending
on the product in the EIO
slot.

See the documentation that came with the EIO device.

Resets sub-menu
Use the RESETS menu to reset factory settings and to disable and enable sleep mode.

Menu item Values Description

RESTORE FACTORY
SETTINGS

None Clears the page buffer, removes all perishable personality data, resets the
printing environment, and returns all default settings to factory defaults. This
menu does not restore HP Jetdirect network settings to factory default values.

SLEEP MODE OFF Enables and disables sleep mode. The default is ON.
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Menu item Values Description

ON
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Diagnostics menu
Use the DIAGNOSTICS menu to run tests that can help identify and solve problems with the printer.

Menu item Description

PRINT EVENT LOG Prints an event log that shows the last 50 entries in the printer event log, starting with the most recent.

SHOW EVENT LOG Shows the last 50 printer events on the control-panel display, starting with the most recent.

PQ
TROUBLESHOOTING

Prints a series of print-quality assessment pages that help troubleshoot many print-quality problems.

PRINT DIAGNOSTICS
PAGE

Prints the diagnostics page.

DISABLE
CARTRIDGE CHECK

Prints with one or more cartridges removed so that you can diagnose print cartridge-related problems.

PAPER PATH
SENSORS

Shows the values of the sensors. Values are updated as media passes each sensor. Jobs can be
initiated from the control panel or sent from the computer.

PAPER PATH TEST Tests the printer paper-handling features, such as the configuration of the trays.

MANUAL SENSOR
TEST

Allows a service representative to test the paper-path sensors and switches for correct operation.

COMPONENT TEST Activates individual parts independently to isolate noise, leaking, and other hardware issues.

PRINT/STOP TEST Isolates print-quality issues more accurately by stopping the printer in mid-print cycle. Stopping the
printer in mid-print cycle causes a jam that might need to be removed manually. Only a service
representative should perform this test.
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Change control-panel configuration settings
Use the printer control panel to make changes to default printer configuration settings, such as tray size
and type, sleep delay time, printer personality (language), and jam recovery.

You can also gain access to the printer control panel from a computer by using the Settings page of
the embedded Web server. The computer shows the same information as the control panel. For more
information, see Use the embedded Web server on page 113.

CAUTION: Configuration settings seldom need to be changed. Hewlett-Packard Company
recommends that only the system administrator change configuration settings.

Tray Behavior menu options
The TRAY BEHAVIOR menu provides the following user-defined options:

● USE REQUESTED TRAY: Select EXCLUSIVELY (the default value) to ensure that the printer will
not automatically select another tray when you indicate that a specific tray should be used. Select
FIRST to allow the printer to pull from a second tray if the specified tray is empty or contains a
different media type or size.

● MANUALLY FEED PROMPT: If you select ALWAYS (the default value), the system always
generates a prompt before pulling from the multipurpose tray. If you select UNLESS LOADED, the
system generates the prompt only if the multipurpose tray is empty or if it is configured for a different
type or size.

● PS DEFER MEDIA: If you select ENABLED (the default value), the printer uses HP's paper-
selection process. Select DISABLED to allow the printer to use the Adobe paper-selection process.

● USE ANOTHER TRAY. If you select ENABLED (the default value), the printer prompts users to
use another tray when the selected tray is unavailable. If you select DISABLED, the printer does
not prompt the user.

● SIZE/TYPE PROMPT. If you select DISPLAY (the default value), the printer prompts users to
confirm the media size or type loaded in the tray immediately after the tray has been loaded. If you
select DO NOT DISPLAY, the printer does not prompt the user.

● DUPLEX BLANK PAGES. If you select AUTO (the default value), the printer might not flip pages
in the duplexer for blank pages, which enhances printer performance. If you select YES, the printer
duplexer flips each page.

Set the Use Requested Tray feature
1. Press Menu.

2. Press  to highlight CONFIGURE DEVICE, and then press .

3. Press  to highlight SYSTEM SETUP, and then press .

4. Press  to highlight TRAY BEHAVIOR, and then press .

5. Press  to select USE REQUESTED TRAY.

6. Press  or  to select EXCLUSIVELY or FIRST.

7. Press  to save the selected behavior, and then press Menu to return to the Ready state.
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Set the Manually Feed Prompt feature
1. Press Menu.

2. Press  to highlight CONFIGURE DEVICE, and then press .

3. Press  to highlight SYSTEM SETUP, and then press .

4. Press  to highlight TRAY BEHAVIOR, and then press .

5. Press  to highlight MANUALLY FEED PROMPT, and then press .

6. Press  or  to select ALWAYS or UNLESS LOADED.

7. Press  to save the selected behavior, and then press Menu to return to the Ready state.

Set the PS Defer Media feature
1. Press Menu.

2. Press  to highlight CONFIGURE DEVICE, and then press .

3. Press  to highlight SYSTEM SETUP, and then press .

4. Press  to highlight TRAY BEHAVIOR, and then press .

5. Press  to highlight PS DEFER MEDIA, and then press .

6. Press  or  to select ENABLED or DISABLED.

7. Press  to save the selected behavior, and then press Menu to return to the Ready state.

Set the Use Another Tray feature
1. Press Menu.

2. Press  to highlight CONFIGURE DEVICE, and then press .

3. Press  to highlight SYSTEM SETUP, and then press .

4. Press  to highlight TRAY BEHAVIOR, and then press .

5. Press  to highlight USE ANOTHER TRAY, and then press .

6. Press  or  to select ENABLED or DISABLED.

7. Press  to save the selected behavior, and then press Menu to return to the Ready state.

Set the Size/Type Prompt feature
1. Press Menu.

2. Press  to highlight CONFIGURE DEVICE, and then press .

3. Press  to highlight SYSTEM SETUP, and then press .

4. Press  to highlight TRAY BEHAVIOR, and then press .

5. Press  to highlight SIZE/TYPE PROMPT, and then press .
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6. Press  or  to select DISPLAY or DO NOT DISPLAY.

7. Press  to save the selected behavior, and then press Menu to return to the Ready state.

Set the Duplex Blank Pages feature
1. Press Menu.

2. Press  to highlight CONFIGURE DEVICE, and then press .

3. Press  to highlight SYSTEM SETUP, and then press .

4. Press  to highlight TRAY BEHAVIOR, and then press .

5. Press  to highlight DUPLEX BLANK PAGES, and then press .

6. Press  or  to select AUTO or YES.

7. Press  to save the selected behavior, and then press Menu to return to the Ready state.

Set the Display Brightness feature
Change the brightness of the control-panel display by using the DISPLAY BRIGHTNESS option.

1. Press Menu.

2. Press  to highlight CONFIGURE DEVICE, and then press .

3. Press  to highlight SYSTEM SETUP, and then press .

4. Press  to highlight DISPLAY BRIGHTNESS, and then press .

5. Press  or  to select the appropriate setting, and then press  to set the selection.

6. Press Menu to return to the Ready state.

Personality feature
This printer features automatic personality (printer language) switching.

● AUTO: Configures the printer to automatically detect the type of print job and configure its
personality to accommodate that job.

● PCL: Configures the printer to use Printer Control Language.

● PDF: Configures the printer to use portable document format.

● PS: Configures the printer to use PostScript emulation.

Set the Personality feature

1. Press Menu.

2. Press  to highlight CONFIGURE DEVICE, and then press .

3. Press  to highlight SYSTEM SETUP, and then press .

4. Press  to highlight PERSONALITY, and then press .

28 Chapter 2   Control panel ENWW



5. Press  or  to select the appropriate personality, and then press  to set the personality.

6. Press Menu to return to the Ready state.

Clearable Warnings feature
Use this feature to determine the display time of control-panel clearable warnings by selecting ON or
JOB. The default value is JOB.

● ON: Clearable warnings appear until you press .

● JOB: Clearable warnings appear until the end of the job for which they were generated.

Set the Clearable Warnings feature

1. Press Menu.

2. Press  to highlight CONFIGURE DEVICE, and then press .

3. Press  to highlight SYSTEM SETUP, and then press .

4. Press  to highlight CLEARABLE WARNINGS, and then press .

5. Press  or  to select the appropriate setting, and then press  to set the selection.

6. Press Menu to return to the Ready state.

Auto Continue feature
Use this feature to determine printer behavior when the system generates an auto-continuable error.
ON is the default setting.

● ON: An error message appears for ten seconds before automatically continuing to print.

● OFF: Any time the printer shows an error message, the print job pauses until you press .

Set the Auto Continue feature

1. Press Menu.

2. Press  to highlight CONFIGURE DEVICE, and then press .

3. Press  to highlight SYSTEM SETUP, and then press .

4. Press  to highlight AUTO CONTINUE, and then press .

5. Press  or  to select the appropriate setting, and then press  to set the selection.

6. Press Menu to return to the Ready state.
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Replace Supplies feature
The printer has three options for low or exhausted supplies status:

● STOP AT OUT (the default setting): The printer continues printing while a print cartridge is low.
When the cartridge is out, the printer cannot print.

● STOP AT LOW: The printer pauses until you replace the low cartridge.

● OVERRIDE AT OUT: The printer continues printing even after some supplies have run out.

Set the Replace Supplies feature

1. Press Menu.

2. Press  to highlight CONFIGURE DEVICE, and then press .

3. Press  to highlight SYSTEM SETUP, and then press .

4. Press  to highlight REPLACE SUPPLIES, and then press .

5. Press  or  to select the appropriate setting, and then press  to set the selection.

● If you select OVERRIDE AT OUT and then press , a warning message appears. To accept
the override, select YES, USE OVERRIDE and press , and then set the page limit for the
override and press .

6. Press Menu to return to the Ready state.

Jam Recovery feature
Use this option to configure the printer response to jams, including how it handles the pages involved.
AUTO is the default value.

● AUTO: The printer automatically turns jam recovery on when sufficient memory is available.

● ON: The printer reprints any page involved in a jam. Additional memory is allocated to store the
last few pages printed. This might cause overall printer performance to suffer.

● OFF: The printer does not reprint any page that was involved in a paper jam. Because no memory
is used to store the most recent pages, performance is optimal.

Set the Jam Recovery feature

1. Press Menu.

2. Press  to highlight CONFIGURE DEVICE, and then press .

3. Press  to highlight SYSTEM SETUP, and then press .

4. Press  to highlight JAM RECOVERY, and then press .

5. Press  or  to select the appropriate setting, and then press  to set the selection.

6. Press Menu to return to the Ready state.
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Language feature
The option to set the default language might appear when the printer is turned on for the first time,
depending on the country/region in which you purchased the printer. As you scroll through the available
options, the list appears in the language that is highlighted. When the list appears in the appropriate
language, press  to set the language. You can also change the language at any time by performing
the following procedure.

Select a language

1. Press Menu.

2. Press  to highlight CONFIGURE DEVICE, and then press .

3. Press  to highlight SYSTEM SETUP, and then press .

4. Press  to highlight LANGUAGE, and then press .

5. Press  or  to select the appropriate language, and then press  to set the selection.

6. Press Menu to return to the Ready state.
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Use the printer control panel in shared environments
If your printer is shared with other users, adhere to the following guidelines to ensure successful printer
operation:

● Consult your system administrator before making changes to control-panel settings. Changing
control-panel settings could affect other print jobs.

● Coordinate with other users before changing the default printer font or downloading soft fonts.
Coordinating these operations conserves memory and avoids unexpected printer output.

● Be aware that switching printer personalities, such as switching emulated PostScript to PCL, affects
the printed output for other users.

NOTE: Your network operating system might automatically protect each user’s print job from the
effects of other print jobs. Consult your system administrator for more information.
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3 Software for Windows

● Supported operating systems for Windows

● Supported printer drivers for Windows

● Select the correct printer driver for Windows

● Priority for print settings

● Change printer-driver settings for Windows

● Install the Windows software

● Remove software for Windows

● Supported utilities

● Software for other operating systems
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Supported operating systems for Windows
The product comes with software for the following Windows operating systems:

● Windows 2000

● Windows Server 2003 (32-bit)

● Windows Server 2003 (64-bit) (PCL 5e printer driver only)

For more information about upgrading from Windows 2000 Server to Windows Server 2003, using
Windows Server 2003 Point and Print, or using Windows Server 2003 Terminal Services and
Printing, go to http://www.microsoft.com/.

● Windows XP (32-bit)

● Windows XP (64-bit)

● Windows Vista (32-bit)

● Windows Vista (64-bit)
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Supported printer drivers for Windows
● PCL 5

● PCL 6

● PS level 3 emulation

The printer drivers include online Help that has instructions for common printing tasks and also describes
the buttons, checkboxes, and drop-down lists that are in the printer driver.
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Select the correct printer driver for Windows
Printer drivers allow you to gain access to the device features and allow the computer to communicate
with the device (using a printer language). Check the installation notes and readme files on the device
CD for additional software and languages.

● Use the PCL 6 printer driver for the best overall performance.

● Use the PCL 5 printer driver for general office printing.

● Use the HP postscript level 3 emulation driver for printing from postscript level 3 emulation needs,
or for postscript flash font support.
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Priority for print settings
Changes to print settings are prioritized depending on where the changes are made:

NOTE: The names of commands and dialog boxes might vary depending on your software program.

● Page Setup dialog box: Click Page Setup or a similar command on the File menu of the program
you are working in to open this dialog box. Settings changed here override settings changed
anywhere else.

● Print dialog box: Click Print, Print Setup, or a similar command on the File menu of the program
you are working in to open this dialog box. Settings changed in the Print dialog box have a lower
priority and do not override changes made in the Page Setup dialog box.

● Printer Properties dialog box (printer driver): Click Properties in the Print dialog box to open
the printer driver. Settings changed in the Printer Properties dialog box do not override settings
anywhere else in the printing software.

● Default printer driver settings: The default printer driver settings determine the settings used in
all print jobs, unless settings are changed in the Page Setup, Print, or Printer Properties dialog
boxes.

● Printer control panel settings: Settings changed at the printer control panel have a lower priority
than changes made anywhere else.
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Change printer-driver settings for Windows
To change the settings for all print
jobs until the software program is
closed

To change the default settings for all
print jobs

To change the device configuration
settings

1. On the File menu in the software
program, click Print.

2. Select the driver, and then click
Properties or Preferences.

The steps can vary; this procedure is
most common.

1. Click Start, click Settings, and then
click Printers (Windows 2000) or
Printers and Faxes (Windows XP
Professional and Server 2003) or
Printers and Other Hardware
Devices (Windows XP Home).

For Windows Vista, click Start, click
Control Panel, and then click
Printer.

2. Right-click the driver icon, and then
select Printing Preferences.

1. Click Start, click Settings, and then
click Printers (Windows 2000) or
Printers and Faxes (Windows XP
Professional and Server 2003) or
Printers and Other Hardware
Devices (Windows XP Home).

For Windows Vista, click Start, click
Control Panel, and then click
Printer.

2. Right-click the driver icon, and then
select Properties.

3. Click the Device Settings tab.
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Install the Windows software
Install Windows software for direct connections

When installing the printing software in a direct-connect environment, always install the software before
connecting the USB cable. In addition, make sure to use a standard 2-meter USB cable.

Installing the printing system software

1. Close all software programs that are open or running.

2. Insert the printer CD-ROM into the CD-ROM drive.

If the welcome screen does not open, start it by using the following procedure:

◦ On the Start menu, click Run.

◦ Type the following: X:\setup (where X is the letter of the CD-ROM drive).

◦ Click OK.

3. When prompted, click Install Printer and follow the instructions on the computer screen.

4. Click Finish when the installation has completed.

5. You might need to restart the computer.

6. Print a test page or a page from any software program to make sure that the software is correctly
installed.

If installation fails, reinstall the software. If this fails, check the installation notes and readme files on the
printer CD-ROM or the flyer that came in the printer box, or go to http://www.hp.com/support/
cljcp3505 for help or more information.

Install Windows software for networks
The software on the printer CD-ROM supports network installation with a Microsoft network. For network
installation on other operating systems, go to http://www.hp.com/support/cljcp3505.

The installer does not support printer installation or printer object creation on Novell servers. It supports
only direct-mode network installations between Windows computers and a printer. To install your printer
and create objects on a Novell server, use an HP utility (such as HP Web Jetadmin) or a Novell utility
(such as NWAdmin).

Installing the printing system software

1. If you are installing the software on Windows 2000, Windows XP, or Windows Vista, make sure
that you have administrator privileges.

2. Make sure that the HP Jetdirect print server and printer are properly connected to the network.
Print a configuration page (see Information pages on page 110). On the second page of the
configuration page, locate the IP address that is currently configured. You might need this address
to initially identify the printer on your network and complete the installation.

3. Close all software programs that are open or running.

4. Insert the printer CD-ROM into the CD-ROM drive.
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If the welcome screen does not open, start it by using the following procedure:

◦ On the Start menu, click Run.

◦ Type the following: X:\setup (where X is the letter of the CD-ROM drive).

◦ Click OK.

5. When prompted, click Install Printer and follow the instructions on the computer screen.

6. Click Finish when installation has completed.

7. You might need to restart the computer.

8. Print a test page or a page from any software program to make sure that the software is correctly
installed.

If installation fails, reinstall the software. If this fails, check the installation notes and readme files
on the printer CD-ROM or the flyer that came in the printer box, or go to http://www.hp.com/support/
cljcp3505 for help or more information.

Software installation types for Windows
You can choose from the following types of software installations:

● Typical. Installs the PCL driver and included fonts.

● Typical with Fax. Installs the PCL driver, the fax driver, and included fonts.

● Custom. Use the Custom installation to select which drivers to install and whether to install the
internal fonts.
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Remove software for Windows
1. Click Start, and then click All Programs.

2. Click HP, and then click HP Color LaserJet CP3505.

3. Click Uninstall HP Color LaserJet CP3505, and then follow the onscreen instructions to remove
the software.
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Supported utilities
The HP Color LaserJet CP3505 printers are equipped with several utilities that make it easy to monitor
and manage the printer on a network.

HP Web Jetadmin
HP Web Jetadmin is a browser-based management tool for HP Jetdirect-connected printers within your
intranet, and it should be installed only on the network administrator’s computer.

To download a current version of HP Web Jetadmin and for the latest list of supported host systems,
visit www.hp.com/go/webjetadmin.

When installed on a host server, a Windows client can gain access to HP Web Jetadmin by using a
supported Web browser (such as Microsoft® Internet Explorer 4.x or Netscape Navigator 4.x or later)
by navigating to the HP Web Jetadmin host.

Embedded Web server
The device is equipped with an embedded Web server, which provides access to information about
device and network activities. This information appears in a Web browser, such as Microsoft Internet
Explorer, Netscape Navigator, Apple Safari, or Firefox.

The embedded Web server resides on the device. It is not loaded on a network server.

The embedded Web server provides an interface to the device that anyone who has a network-
connected computer and a standard Web browser can use. No special software is installed or
configured, but you must have a supported Web browser on your computer. To gain access to the
embedded Web server, type the IP address for the device in the address line of the browser. (To find
the IP address, print a configuration page. For more information about printing a configuration page,
see Information pages on page 110.)

For a complete explanation of the features and functionality of the embedded Web server, see Use the
embedded Web server on page 113.

HP Easy Printer Care Software
The HP Easy Printer Care Software is a program that you can use for the following tasks:

● Checking the device status

● Checking the supplies status

● Setting up alerts

● Viewing device documentation

● Gaining access to troubleshooting and maintenance tools

You can view HP Easy Printer Care Software when the device is directly connected to your computer
or when it is connected to a network. To download HP Easy Printer Care Software, go to www.hp.com/
go/easyprintercare.

For more information, see Use HP Easy Printer Care Software on page 116.
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Other components and utilities

Windows Macintosh OS

● Software installer — automates the printing system
installation

● Online Web registration

● The HP Printer Utility — change device settings, view
status, and set up printer-event notification from a Mac.
This utility is supported for Mac OS X V10.2 and later.
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Software for other operating systems
OS Software

UNIX For HP-UX and Solaris networks, go to www.hp.com/support/net_printing to download the
HP Jetdirect printer installer for UNIX.

Linux For information, go to www.hp.com/go/linuxprinting.

OS/2 The OS/2 drivers are available from IBM and are packaged with OS/2. They are not
available for Simplified Chinese, Korean, Japanese, or Traditional Chinese. For more
information, see www.hp.com/support/software.
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4 Use the product with Macintosh

● Software for Macintosh

● Use features in the Macintosh printer driver
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Software for Macintosh
Supported operating systems for Macintosh

The device supports the following Macintosh operating systems:

● Mac OS X V10.2.8, V10.3, V10.4 and later

NOTE: For Mac OS V10.4 and later, PPC and Intel Core Processor Macs are supported.

Supported printer drivers for Macintosh
The HP installer provides PostScript® Printer Description (PPD) files, Printer Dialog Extensions (PDEs),
and the HP Printer Utility for use with Macintosh computers.

The PPDs, in combination with the Apple PostScript printer drivers, provide access to device features.
Use the Apple PostScript printer driver that comes with the computer.

Priority for print settings for Macintosh
Changes to print settings are prioritized depending on where the changes are made:

NOTE: The names of commands and dialog boxes might vary depending on your software program.

● Page Setup dialog box: Click Page Setup or a similar command on the File menu of the program
you are working in to open this dialog box. Settings changed here override settings changed
anywhere else.

● Print dialog box: Click Print, Print Setup, or a similar command on the File menu of the program
you are working in to open this dialog box. Settings changed in the Print dialog box have a lower
priority and do not override changes made in the Page Setup dialog box.

● Printer Properties dialog box (printer driver): Click Properties in the Print dialog box to open
the printer driver. Settings changed in the Printer Properties dialog box do not override settings
anywhere else in the printing software.

● Default printer driver settings: The default printer driver settings determine the settings used in
all print jobs, unless settings are changed in the Page Setup, Print, or Printer Properties dialog
boxes.

● Printer control panel settings: Settings changed at the printer control panel have a lower priority
than changes made anywhere else.

Change printer-driver settings for Macintosh

To change the settings for all print
jobs until the software program is
closed

To change the default settings for all
print jobs

To change the device configuration
settings

1. On the File menu, click Print.

2. Change the settings that you want
on the various pop-up menus.

1. On the File menu, click Print.

2. Change the settings that you want
on the various pop-up menus.

3. On the Presets pop-up menu, click
Save as and type a name for the
preset.

1. In the Finder, on the Go menu, click
Applications.

2. Open Utilities, and then open Print
Center (Mac OS X V10.2) Printer
Setup Utility (Mac OS X V10.3 or
Mac OS X V10.4).
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To change the settings for all print
jobs until the software program is
closed

To change the default settings for all
print jobs

To change the device configuration
settings

These settings are saved in the
Presets menu. To use the new settings,
you must select the saved preset option
every time you open a program and print.

3. Click on the print queue.

4. On the Printers menu, click Show
Info.

5. Click the Installable Options
menu.

NOTE: Configuration settings might
not be available in Classic mode.

Software installation types for Macintosh

Install Macintosh software for direct connections (USB)
1. Connect a USB cable between the device USB port and the computer USB port. Use a standard

2-meter (6.56-foot) USB cable.

2. Insert the device CD into the CD-ROM drive and run the installer. If the CD menu not run
automatically, double-click the CD icon on the desktop.

3. Double-click the Installer icon in the HP LaserJet Installer folder.

4. Follow the instructions on the computer screen.

USB printer queues are created automatically when the device is attached to the computer.
However, the queue will use a generic PPD if the installer has not been run before the USB cable
is connected. Complete the following steps to change the queue PPD.

5. On the computer hard drive, open Applications, open Utilities, and then open Print Center or
Printer Setup Utility.

NOTE: If you are using Mac OS X V10.3 or Mac OS X V10.4, then the Printer Setup Utility has
replaced the Print Center.

6. Select the correct printer queue, and then click Show Info to open the Printer Info dialog box.

7. In the pop-up menu, select Printer Model, and then, in the pop-up menu in which Generic is
selected, select the correct PPD for the device.

8. Print a test page from any software program to make sure that the software is correctly installed.

If installation fails, reinstall the software. If this fails, see the installation notes or late-breaking
readme files on the device CD or the flyer that came in the box for help.

Install Macintosh software for networks
1. Connect the network cable between the HP Jetdirect print server and a network port.

2. Insert the CD into the CD-ROM drive. If the CD does not run automatically, double-click the CD
icon on the desktop.

3. Double-click the Installer icon in the HP LaserJet Installer folder.

4. Follow the instructions on the computer screen.
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5. On the computer hard drive, open Applications, open Utilities, and then open Print Center or
Printer Setup Utility.

NOTE: If you are using Mac OS X V10.3 or Mac OS X V10.4, then the Printer Setup Utility has
replaced the Print Center.

6. Click Add Printer.

7. Select Rendezvous or Bonjour as the connection type.

NOTE: Depending on product configuration, Appletalk or IP Printing might also be available.

8. Select the device from the list.

9. Click Add Printer.

10. Close the Print Center or the Printer Setup Utility.

Remove software from Macintosh operating systems
To remove the software from a Macintosh computer, drag the PPD files to the trash can.

Supported utilities for Macintosh

Embedded Web server
The device is equipped with an embedded Web server, which provides access to information about
device and network activities. This information appears in a Web browser, such as Microsoft Internet
Explorer, Netscape Navigator, Apple Safari, or Firefox.

The embedded Web server resides on the device. It is not loaded on a network server.

The embedded Web server provides an interface to the device that anyone who has a network-
connected computer and a standard Web browser can use. No special software is installed or
configured, but you must have a supported Web browser on your computer. To gain access to the
embedded Web server, type the IP address for the device in the address line of the browser. (To find
the IP address, print a configuration page. For more information about printing a configuration page,
see Information pages on page 110.)

For a complete explanation of the features and functionality of the embedded Web server, see Use the
embedded Web server on page 113.
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Use features in the Macintosh printer driver
Create and use printing shortcuts in Macintosh

Use printing shortcuts to save the current printer driver settings for reuse.

Create a printing shortcut

1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

3. Select the print settings.

4. In the Printing Shortcuts box, click Save As..., and type a name for the shortcut.

5. Click OK.

Use printing shortcuts

1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

3. In the Printing Shortcuts box, select the printing shortcut that you want to use.

NOTE: To use printer-driver default settings, select Factory Default.

Resize documents or print on a custom paper size
You can scale a document to fit on a different size of paper.

1. On the File menu, click Print.

2. Open the Paper Handling menu.

3. In the area for Destination Paper Size, select Scale to fit paper size, and then select the size
from the drop-down list.

4. If you want to use only paper that is smaller than the document, select Scale down only.

Print a cover page
You can print a separate cover page for your document that includes a message (such as “Confidential”).

1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

3. On the Cover Page or Paper/Quality tab, select whether to print the cover page Before
Document or After Document.

4. In the Cover Page Type pop-up menu, select the message that you want to print on the cover
page.

NOTE: To print a blank cover page, select Standard as the Cover Page Type.
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Use watermarks
A watermark is a notice, such as “Confidential,” that is printed in the background of each page of a
document.

1. On the File menu, click Print.

2. Open the Watermarks menu.

3. Next to Mode, select the type of watermark to use. Select Watermark to print a semi-transparent
message. Select Overlay to print a message that is not transparent.

4. Next to Pages, select whether to print the watermark on all pages or on the first page only.

5. Next to Text, select one of the standard messages, or select Custom and type a new message in
the box.

6. Select options for the remaining settings.

Print multiple pages on one sheet of paper in Macintosh
You can print more than one page on a single sheet of paper. This feature provides a cost-effective way
to print draft pages.

1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

3. Click the Layout pop-up menu.

4. Next to Pages per Sheet, select the number of pages that you want to print on each sheet (1, 2,
4, 6, 9, or 16).

5. Next to Layout Direction, select the order and placement of the pages on the sheet.

6. Next to Borders, select the type of border to print around each page on the sheet.
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Print on both sides of the page (duplex printing)

Use automatic duplex printing

1. Insert enough paper into one of the trays to accommodate the print job. If you are loading special
paper such as letterhead, load it in one of the following ways:

● For tray 1, load the letterhead paper face-up with the bottom edge feeding into the printer first.

● For all other trays, load the letterhead paper face-down with the top edge at the back of the
tray.

2. Open the printer driver (see Change printer-driver settings for Windows on page 38).

3. Open the Layout pop-up menu.

4. Next to Two Sided Printing, select either Long-Edge Binding or Short-Edge Binding.

5. Click Print.

Print on both sides manually

1. Insert enough paper into one of the trays to accommodate the print job. If you are loading special
paper such as letterhead, load it in one of the following ways:

● For tray 1, load the letterhead paper face-up with the bottom edge feeding into the printer first.

● For all other trays, load the letterhead paper face-down with the top edge at the back of the
tray.

CAUTION: To avoid jams, do not load paper that is heavier than 105 g/m2 (28-lb bond).

2. Open the printer driver (see Change printer-driver settings for Windows on page 38).

3. On the Finishing pop-up menu, select the Manual Duplex option.

NOTE: If the Manual Duplex option is not enabled, select Manually Print on 2nd Side.

4. Click Print. Follow the instructions in the pop-up window that appears on the computer screen
before replacing the output stack in tray 1 for printing the second half.

5. Go to the printer, and remove any blank paper that is in tray 1.

6. Insert the printed stack face-up with the bottom edge feeding into the printer first in tray 1. You
must print the second side from tray 1.

7. If prompted, press the appropriate control-panel button to continue.

Set the color options
Use the Color Options pop-up menu to control how colors are interpreted and printed from software
programs.

1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

3. Open the Color Options pop-up menu.
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4. If you are using Mac OS X, click Show Advanced Options.

5. Adjust the individual settings for text, graphics, and photographs.

Use the Services menu
If the device is connected to a network, use the Services menu to obtain device and supply-status
information.

1. On the File menu, click Print.

2. Open the Services menu.

3. Select a maintenance task from the drop-down list, and then click Launch. The embedded Web
server opens to the page that provides the information for the task that you selected.

4. To go to various support Web sites for this device, select an Internet Services option from the drop-
down list, and then click Go!.
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5 Connectivity

● USB configuration

● Network configuration
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USB configuration
All printer models support USB connections. The USB port is on the right side of the printer.

Connect the USB cable
Plug the USB cable into the printer. Plug the other end of the USB cable into the computer.

Figure 5-1  USB port connection

1

2

1 USB port

2 USB connector
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Network configuration
The HP Color LaserJet CP3505n, CP3505dn, and CP3505x models support network connections. The
network port is on the right side of the printer.

Connect the network cable
Plug the network cable into the printer.

Figure 5-2  Network port connection

1

2

1 Network port

2 Network cable

Configure the network product
You might need to configure certain network parameters on the printer. You can configure these
parameters from the printer control panel, the embedded Web server, or for most networks, from the
HP Web Jetadmin software.

NOTE: For more information about using the embedded Web server, see Use the embedded Web
server on page 113.

For a complete list of supported networks and for instructions on configuring network parameters from
software, see the HP Jetdirect Embedded Print Server Administrator’s Guide. The guide comes with
printers in which an HP Jetdirect embedded print server is installed.

Manually configure TCP/IP parameters from the printer control panel
Use manual configuration to set an IP address, subnet mask, and default gateway for an IPV4 network
card.

Set the IP address

1. Press Menu.

2. Press  to highlight CONFIGURE DEVICE, and then press .

3. Press  to highlight I/O, and then press .

4. Press  to highlight EMBEDDED JETDIRECT, and then press .

5. Press  to highlight TCP/IP, and then press .

6. Press  to select IPV4 SETTINGS.

7. Press  to select CONFIG METHOD.
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8. Press  to highlight MANUAL, and then press .

9. Press  to highlight MANUAL SETTINGS, and then press .

10. Press  to highlight IP Address:, and then press .

11. Press the  or  arrow to increase or decrease the number for the first byte of the IP address.

12. Press  to move to the next set of numbers. (Press  to move to the previous set of numbers.)

NOTE: To cycle through the numbers faster, hold down the arrow button.

13. Repeat steps 10 and 11 until the correct IP address is entered, and then press  to save the
setting.

14. Press Menu to return to the Ready state.

Set the subnet mask

1. Press Menu.

2. Press  to highlight CONFIGURE DEVICE, and then press .

3. Press  to highlight I/O, and then press .

4. Press  to highlight EMBEDDED JETDIRECT, and then press .

5. Press  to highlight TCP/IP, and then press .

6. Press  to select IPV4 SETTINGS.

7. Press  to select CONFIG METHOD.

8. Press  to highlight MANUAL, and then press .

9. Press  to highlight MANUAL SETTINGS, and then press .

10. Press  to highlight SUBNET MASK, and then press .

11. Press the  or  arrow to increase or decrease the number for the first byte of the subnet mask.

12. Press  to move to the next set of numbers. (Press  to move to the previous set of numbers.)

13. Repeat steps 10 and 11 until the correct subnet mask is entered, and then press  to save the
subnet mask.

14. Press Menu to return to the Ready state.

Set the default gateway

1. Press Menu.

2. Press  to highlight CONFIGURE DEVICE, and then press .

3. Press  to highlight I/O, and then press .

4. Press  to highlight EMBEDDED JETDIRECT, and then press .

5. Press  to highlight TCP/IP, and then press .

6. Press  to select IPV4 SETTINGS.
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7. Press  to select CONFIG METHOD.

8. Press  to highlight MANUAL, and then press .

9. Press  to highlight MANUAL SETTINGS, and then press .

10. Press  to highlight DEFAULT GATEWAY, and then press .

11. Press the  or  arrow to increase or decrease the number for the first byte of the default
gateway.

12. Press  to move to the next set of numbers. (Press  to move to the previous set of numbers.)

13. Repeat steps 10 and 11 until the correct default gateway is entered, and then press  to save the
default gateway.

14. Press Menu to return to the Ready state.

Disable network protocols (optional)
By factory default, all supported network protocols are enabled. Disabling unused protocols has the
following benefits:

● Decreases printer-generated network traffic

● Prevents unauthorized users from printing to the printer

● Provides only pertinent information on the configuration page

● Allows the printer control panel to display protocol-specific error and warning messages

Disable IPX/SPX

NOTE: Do not disable this protocol in Windows-based systems that print to the printer using IPX/SPX.

1. Press Menu.

2. Press  to highlight CONFIGURE DEVICE, and then press .

3. Press  to highlight I/O, and then press .

4. Press  to highlight EMBEDDED JETDIRECT, and then press .

5. Press  to highlight IPX/SPX, and then press .

6. Press  to select ENABLE.

7. Press  to highlight OFF, and then press .

8. Press Menu to return to the Ready state.

Disable AppleTalk

1. Press Menu.

2. Press  to highlight CONFIGURE DEVICE, and then press .

3. Press  to highlight I/O, and then press .

4. Press  to highlight EMBEDDED JETDIRECT, and then press .
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5. Press  to highlight APPLETALK, and then press .

6. Press  to select ENABLE.

7. Press  to highlight OFF, and then press .

8. Press Menu to return to the Ready state.

Disable DLC/LLC

1. Press Menu.

2. Press  to highlight CONFIGURE DEVICE, and then press .

3. Press  to highlight I/O, and then press .

4. Press  to highlight EMBEDDED JETDIRECT, and then press .

5. Press  to highlight DLC/LLC, and then press .

6. Press  to select ENABLE.

7. Press  to highlight OFF, and then press .

8. Press Menu to return to the Ready state.

Enhanced I/O (EIO) configuration
NOTE: If you are adding a print server to a base model (HP Color LaserJet CP3505), additional printer
memory might be required.

The enhanced input/output (EIO) slot holds compatible accessory devices, such as the HP Jetdirect
print server network cards or other devices. Plugging an EIO network card into the slot increases the
number of network interfaces available to the printer.

HP Jetdirect EIO print servers

HP Jetdirect print servers (network cards) can be installed in EIO slots. These cards support multiple
network protocols and operating systems. HP Jetdirect print servers facilitate network management by
allowing you to connect a printer directly to your network at any location. HP Jetdirect print servers also
support the Simple Network Management Protocol (SNMP), which provides network managers with
remote printer management and troubleshooting through the HP Web Jetadmin software.

NOTE: Configure the card either through the control panel, the printer installation software, or with
HP Web Jetadmin software. Refer to the HP Jetdirect print server documentation for more information.
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6 Paper and print media

This product supports a variety of paper and other print media in accordance with the guidelines in this
user guide. Media that does not meet these guidelines might cause the following problems:

● Poor print quality

● Increased jams

● Premature wear on the printer, requiring repair

For best results, use only HP brand paper and print media. Hewlett-Packard Company cannot
recommend the use of other brands. Because they are not HP products, HP cannot influence or control
their quality.

It is possible for media to meet all of the guidelines in this user guide and still not produce satisfactory
results. This might be the result of improper handling, unacceptable temperature and humidity levels,
or other variables over which Hewlett-Packard has no control.

Before you purchase a large quantity of media, test the media and make sure that it meets the
requirements specified in this user guide and in HP LaserJet Printer Family Media Guide. The guidelines
can be downloaded from http://www.hp.com/support/ljpaperguide/.

CAUTION: Using media that does not meet Hewlett-Packard's specifications might cause problems
for the printer, requiring repair. This repair is not covered by the Hewlett-Packard warranty or service
agreements.
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Understand paper and print media use
This product supports a variety of paper and other print media in accordance with the guidelines in this
user guide. Paper or print media that does not meet these guidelines might cause the following problems:

● Poor print quality

● Increased jams

● Premature wear on the product, requiring repair

For best results, use only HP-brand paper and print media designed for laserjets or multiuse. Do not
use paper or print media made for inkjet printers. Hewlett-Packard Company cannot recommend the
use of other brands of media because HP cannot control their quality.

It is possible for paper to meet all of the guidelines in this user guide and still not produce satisfactory
results. This might be the result of improper handling, unacceptable temperature and/or humidity levels,
or other variables over which Hewlett-Packard has no control.

CAUTION: Using paper or print media that does not meet Hewlett-Packard's specifications might
cause problems for the product, requiring repair. This repair is not covered by the Hewlett-Packard
warranty or service agreements.
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Supported paper and print media sizes
This product supports a number of paper sizes, and it adapts to various media.

NOTE: To obtain best print results, select the appropriate paper size and type in your print driver before
printing.

Table 6-1  Supported paper and print media sizes

Size Dimensions Tray 1 Tray 2 Optional tray 3

Letter 216 x 279 mm (8.5 x 11 inches)

Legal 216 x 356 mm (8.5 x 14 inches)

A4 210 x 297 mm (8.27 x 11.69 inches)

Executive 184 x 267 mm (7.24 x 10.51 inches)

A5 148 x 210 mm (5.83 x 8.27 inches)

A6 105 x 148 mm (4.13 x 5.83 inches)   

B5 (JIS) 182 x 257 mm (7.17 x 10.12 inches)

B5 (ISO) 176 x 250 mm (6.93 x 9.84 inches)

B6 (ISO) 125 x 176 mm (4.92 x 6.93 inches)   

16k 197 x 273 mm (7.75 x 10.75 inches)   

16k 184 x 260 mm (7.24 x 10.23 inches)   

16k 195 x 270 mm (7.68 x 10.63 inches)   

8.5 x 13
(custom)

216 x 330 mm (8.5 x 13 inches)   

Custom (148 - 216) x (210 - 356) mm ((5.83 - 8.5) x
(8.27 - 14) inches)

  

Table 6-2  Supported envelopes and postcards

Size Dimensions Tray 1 Tray 2 Optional tray 3

Envelope #10 105 x 241 mm (4.13 x 9.49 inches)   

Envelope DL 110 x 220 mm (4.33 x 8.66 inches)   

Envelope C5 162 x 229 mm (6.93 x 9.84 inches)   

Envelope B5 176 x 250 mm (6.7 x 9.8 inches)   

Envelope
Monarch

98 x 191 mm (3.9 x 7.5 inches)   
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Custom paper sizes
This product supports a variety of custom paper sizes. Supported custom sizes are sizes that are within
the minimum- and maximum-size guidelines for the product but are not listed in the supported paper
sizes table. When using a supported custom size, specify the custom size in the print driver, and load
the paper in a tray that supports custom sizes.
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Special paper or print media guidelines
This product supports printing on special media. Use the following guidelines to obtain satisfactory
results. When using special paper or print media, be sure to set the type and size in your print driver to
obtain the best print results.

CAUTION: HP LaserJet printers use fusers to bond dry toner particles to the paper in very precise
dots. HP laser paper is designed to withstand this extreme heat. Using inkjet paper not designed for this
technology could damage your printer.

Media type Do Do not

Envelopes ● Store envelopes flat.

● Use envelopes where the seam
extends all the way to the corner of
the envelope.

● Use peel-off adhesive strips that
are approved for use in laser
printers.

● Do not use envelopes that are
wrinkled, nicked, stuck together, or
otherwise damaged.

● Do not use envelopes that have
clasps, snaps, windows, or coated
linings.

● Do not use self-stick adhesives or
other synthetic materials.

Labels ● Use only labels that have no
exposed backing between them.

● Use Labels that lie flat.

● Use only full sheets of labels.

● Do not use labels that have wrinkles
or bubbles, or are damaged.

● Do not print partial sheets of labels.

Transparencies ● Use only transparencies that are
approved for use in laser printers.

● Place transparencies on a flat
surface after removing them from
the product.

● Do not use transparent print media
not approved for laser printers.

Letterhead or preprinted forms ● Use only letterhead or forms
approved for use in laser printers.

● Do not use raised or metallic
letterhead.

Heavy paper ● Use only heavy paper that is
approved for use in laser printers
and meets the weight specifications
for this product.

● Do not use paper that is heavier
than the recommended media
specification for this product unless
it is HP paper that has been
approved for use in this product.

Glossy or coated paper ● Use only glossy or coated paper
that is approved for use in laser
printers.

● Do not use glossy or coated paper
designed for use in inkjet products.
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Load media
The following sections describe how to load media into the different input trays.

CAUTION: If you try to print on media that is wrinkled, folded, or damaged in any way, a jam might
occur.

Load tray 1 (multipurpose tray)
Tray 1 is a multipurpose tray that holds up to 100 sheets of paper or 10 envelopes. It provides a
convenient way to print envelopes, transparencies, custom-size paper, or other types of paper without
having to unload the other trays.

Load paper in tray 1
CAUTION: Avoid adding print media to tray 1 while the printer is printing, or jams can occur.

1. Open tray 1.

NOTE: If printing on special media, such as envelopes, use tray 1. See Load envelopes in tray
1 on page 66 for more information.

2. Slide the output bin extension out from the bin.
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3. Slide out the tray extender and, if necessary, open the additional tray extender.

4. Slide the width guides slightly wider than the print media.

5. Place print media into the tray with the side to be printed down, and the top, short edge in first.

NOTE: If you are printing on two sides, see Print on both sides of the paper (duplex printing)
on page 95 for loading instructions.
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6. Slide the paper width guides inward until they lightly touch the print media stack on both sides
without bending it. Make sure that the media fits under the tabs on the width guides.

CAUTION: Wait for the printer to finish printing before closing tray 1 (optional). Closing the tray
before the printer finishes can cause jams.

Load envelopes in tray 1
Many types of envelopes can be printed from tray 1. Up to 10 envelopes can be stacked in the tray.
Printing performance depends on the construction of the envelope.

In the software, set margins at least 15 mm (0.6 in) from the edge of the envelope.

NOTE: Testing has shown that fusing performance is improved when the Extra Heavy fuser mode is
used when printing on C5 and B5 envelopes. To change this setting, press Menu. Then press  to
highlight CONFIGURE DEVICE, and then press . Press  to highlight PRINT QUALITY, and then
press . Press  to highlight PRINT MODES, and then press . Press  to highlight EXTRA
HEAVY, and then press .

CAUTION: Envelopes that contain clasps, snaps, windows, coated linings, exposed self-stick
adhesives, or other synthetic materials can severely damage the printer. To avoid jams and possible
printer damage, never try to print on both sides of an envelope. Before you load envelopes, make sure
that they are flat, undamaged, and not stuck together. Do not use envelopes that contain pressure-
sensitive adhesive. To avoid jams, do not remove or insert envelopes during printing.

1. Open tray 1.
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2. Slide out the tray extender and, if necessary, open the additional tray extender.

3. Set the paper-width guides.

4. Load as many as 10 envelopes in the center of tray 1 with the side to be printed on facing down,
with the stamp area farthest from the printer, and the short edge toward the printer. Slide the
envelopes into the printer as far as they will go without forcing them.

ENWW Load media 67



5. Adjust the guides to touch the envelope stack without bending the envelopes. Make sure that the
envelopes fit under the tabs on the guides.

Load tray 2
Tray 2 holds up to 250 sheets of standard paper and adjusts for many sizes.

CAUTION: The paper path for tray 3 passes through tray 2. If either tray 2 or tray 3 is partially pulled
out or removed, media from tray 3 cannot feed into the printer. This causes the printer to jam.

CAUTION: To avoid jams, never open or remove a tray during printing.

1. Pull tray 2 out of the printer and remove any media.

2. Slide the output bin extension out from the bin.
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3. Adjust the length guide until the arrow points to the size that you are loading.

4. Move the side width guides until the arrow on the right width guide points to the size that you are
loading.

5. Load the media into the tray. If this is special paper such as letterhead, load it face-up with the top
edge toward the front of the tray.

NOTE: If you are duplex printing, see Print on both sides of the paper (duplex printing)
on page 95 for loading instructions.
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6. Make sure that the stack of media is flat and that the media is below the height tabs.

7. Slide the tray back into the printer.

Load tray 3
Optional tray 3 holds up to 500 sheets of standard paper and adjusts for many sizes. Tray 3 is installed
underneath tray 2. When tray 3 is installed, the printer detects it and lists tray 3 as a choice in the control
panel CONFIGURE DEVICE menu.

CAUTION: The paper path for tray 3 passes through tray 2. If either tray 2 or tray 3 is partially pulled
out or removed, media from tray 3 cannot feed into the printer. This causes the printer to jam.

1. Pull the tray out of the printer and remove any media.
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2. Raise the output bin extension.

3. Adjust the length guide until the arrow points to the size that you are loading.

4. Move the side width guides until the arrow on the right width guide points to the size that you are
loading.
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5. Load the media into the tray. If this is special paper, such as letterhead, load it face-up with the top
edge toward the front of the tray.

NOTE: If you are duplex printing, see Print on both sides of the paper (duplex printing)
on page 95 for loading instructions.

6. Make sure that the stack of media is flat in the tray at all four corners, and keep it below the height
tabs.

7. Slide the tray back into the printer.
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Configure trays
You can configure the printer trays by type and size. Load different media in the printer trays and then
request media by type or size in the software program.

NOTE: If you have used previous HP Color LaserJet printers, you might be accustomed to configuring
tray 1 to first mode or cassette mode. To mimic the settings for first mode, configure tray 1 for ANY
SIZE and ANY TYPE. The printer will pull paper from tray 1 first (if paper is loaded in that tray) when
the print job does not specify another tray. This setting is recommended if you use different types or
sizes of paper in tray 1. To mimic the settings from cassette mode, set either the size or type for tray 1
to a setting other than ANY SIZE or ANY TYPE. This setting is recommended if you are using the same
size and type of paper in tray 1.

NOTE: If you use 2-sided printing, be sure that the media meets the specifications for duplex printing.
See Special paper or print media guidelines on page 63.

The following instructions are for configuring the trays at the printer control panel. You can also configure
the trays from your computer through the embedded Web server. See Use the embedded Web server
on page 113.

Configure the size
1. Press Menu.

2. Press  to highlight PAPER HANDLING, and then press .

3. Press  to highlight TRAY 1 SIZE, TRAY 2 SIZE, or TRAY 3 SIZE, and then press .

4. Press  or  to highlight the appropriate size, and then press .

5. Press Menu to return to the Ready state.

Configure the type
1. Press Menu.

2. Press  to highlight PAPER HANDLING, and then press .

3. Press  to highlight TRAY 1 TYPE, TRAY 2 TYPE, or TRAY 3 TYPE, and then press .

4. Press  or  to highlight the desired paper type, and then press .

5. Press Menu to return to the Ready state.

Configure tray 1 for custom paper
Use the ANY SIZE size setting when the selected media does not exactly match the size of the paper
specified in the document you are printing. If no source tray is specified, the printer looks first for paper
that exactly matches the document, and then it looks for and prints from a tray set to ANY SIZE or ANY
TYPE.

Use the ANY CUSTOM setting when you want to be able to print a number of custom sizes from the
tray without defining a set size for each job. Use the CUSTOM setting when you want to print a specific
print size from a particular tray. When you print a custom job, the printer looks for an exact size match.
If it does not find an exact match to the custom size specified, it looks for a tray set to ANY CUSTOM.
Finally, the printer looks for and uses media from a tray set to ANY SIZE.
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There are three steps to set up custom paper. When all are completed, the display returns to the PAPER
HANDLING menu. After a custom size is set for a tray, the printer retains the setting until you change
it in the control panel.

x

yy

1

2

1 X dimension

2 Y dimension

Unit of measure

1. Press  to highlight UNIT OF MEASURE, and then press .

2. Press  or  to highlight the correct measurement, and then press .

X dimension

The X dimension is the width of the page as it feeds into the printer.

1. Press  to highlight X DIMENSION, and then press .

2. Press  or  to highlight the correct value, and then press .

Y dimension

The Y dimension is the length of the page as it feeds into the printer.

1. Press  to highlight Y DIMENSION, and then press .

2. Press  or  to highlight the correct value, and then press .

Configure tray 1 for envelopes
1. If tray 1 is configured for a specific size, use the printer control panel to set the paper size for tray 1

to match the envelope size that you are printing.

2. Specify tray 1 in the software program.

3. If your software does not automatically format an envelope, specify Landscape for page orientation
in the software program. Use the guidelines in the table that follows to set margins for return and
destination addresses on Commercial #10 or DL envelopes.
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NOTE: For envelopes of other sizes, adjust the margin settings appropriately.

4. Click Print in the software program or printer driver.

Address type Left margin Top margin

Return 15 mm (0.6 in) 15 mm (0.6 in)

Destination 102 mm (4.0 in) 51 mm (2.0 in)

Configure tray 2 or tray 3 for custom paper
The printer automatically detects many sizes of paper, but you can also configure trays for custom paper
sizes. You must specify the following parameters:

● Unit of measure (millimeters or inches)

● X dimension (the width of the page as it feeds into the printer)

● Y dimension (the length of the page as it feeds into the printer)

1

2 3
4

X

Y

1 Page length (Y dimension)

2 Page width (X dimension)

3 Media length guides

4 Media width guides

Use the following procedure to configure a tray for a custom size. Once a custom size is set for a tray,
it will be retained until the media length guides are reset.

Set a custom size in tray 2 or tray 3

1. Open the tray and place the media face-up in the tray.

2. Set the media length guides to the appropriate non-standard position and close the tray.

3. When the tray configuration message appears, press .

4. Press  to change ANY CUSTOM to CUSTOM, and then press .

5. Press  or  to highlight the correct unit (either millimeters or inches), and then press .
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After the unit of measure is set properly, set the X dimension as follows:

6. Press  or  to highlight the correct value, and then press .

If the value entered is outside the valid range, Invalid value appears for two seconds. The control-
panel display prompts you to enter another value.

After the X dimension is set properly, set the Y dimension as follows:

7. Press  or  to highlight the correct value, and then press .

If the value entered is outside the valid range, Invalid value appears for two seconds. The control-
panel display prompts you to enter another value. The printer shows a message indicating the
dimensions for the custom size.

Automatic media type sensing (auto sense mode)
The HP Color LaserJet CP3505 automatically classifies media into one of the following categories:

● Plain

● Transparency

● Glossy

● Extra-heavy glossy

● Glossy film

● Heavy

● Light

The automatic media type sensor functions only when that tray is configured to Any Type Plain.
Configuring a tray to any other type, such as Bond or Glossy, deactivates the media sensor in that tray.

NOTE: Get optimal performance with the automatic media sensing feature when using original HP
media designed for use in HP color LaserJet printers.

NOTE: When printing on heavy media such as cardstock, glossy, or envelopes, achieve optimum print
quality by setting the media type through the control panel or software application before printing the
job.

Tray 1 sensing

Full sensing (default)

● The printer stops at each page to sense media type.

● This is the best mode for using mixed media in a single print job.

Expanded sensing

● Each time the printer begins a print job, it stops the first page to sense the type.

● The printer assumes that the second and all subsequent pages are of the same media type as the
first page.

● This is the second-fastest mode, and is useful for using stacks of the same media type.
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Transparency

● The printer does not stop any pages for sensing but distinguishes between transparencies
(Transparency mode) and paper (Normal mode).

● This is the fastest mode and is useful for high-volume printing in Normal mode.

Tray 2 or tray 3 sensing

Expanded sensing

● The printer stops the first five pages fed from each paper tray to sense the type and averages the
five results.

● The printer assumes that the sixth and all subsequent pages are of the same media type, until the
printer is turned off or goes into sleep mode, or until the tray is opened.

Transparency only (default)

● The printer does not stop any pages for sensing but distinguishes between transparencies
(Transparency mode) and paper (Normal mode).

● This is the fastest mode and is useful for high-volume printing in Normal mode.
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7 Use product features

● Sleep Delay and Sleep Mode features

● Manage stored jobs
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Sleep Delay and Sleep Mode features
The SLEEP DELAY feature determines how long the printer must be inactive before it switches to sleep
mode to reduce power consumption. You can set the length of time before the printer goes into sleep
mode to one of the following settings:

● 1 MINUTE

● 15 MINUTES

● 30 MINUTES (the default setting)

● 45 MINUTES

● 60 MINUTES

● 90 MINUTES

● 2 HOURS

● 4 HOURS

NOTE: The printer display appears dimmed when the printer is in sleep mode. Sleep mode does not
affect printer warm-up time, unless the printer is in sleep mode for more than 8 hours.

Set the sleep delay
1. Press Menu.

2. Press  to highlight CONFIGURE DEVICE, and then press .

3. Press  to highlight SYSTEM SETUP, and then press .

4. Press  to highlight SLEEP DELAY, and then press .

5. Press  or  to select the appropriate time period, and then press  to set the selected time
period.

6. Press Menu to return to the Ready state.

Disable or enable sleep mode
1. Press Menu.

2. Press  to highlight CONFIGURE DEVICE, and then press .

3. Press  to highlight RESETS, and then press .

4. Press  to highlight SLEEP MODE, and then press .

5. Press  or  to select ON or OFF, and then press  to set the selection.

6. Press Menu to return to the Ready state.

80 Chapter 7   Use product features ENWW



Manage stored jobs
NOTE: This feature is available only for printers with installed hard drives.

To store print jobs on the printer, use the Job Storage tab in the printer driver Properties dialog box.
After a job is stored, you can print it or delete it from the printer control panel.

Print a stored job

1. Press Menu.

2. Press  to highlight RETRIEVE JOB, and then press .

A list of users appears. If no jobs are stored , then the message NO STORED JOBS appears.

3. Press  to highlight your user name, and then press .

● If you have more than one stored job that is protected by a personal identification number
(PIN), the ALL PRIVATE JOBS menu item appears. If you want to print one of the PIN-
protected jobs, highlight ALL PRIVATE JOBS, and then press .

4. Press  to highlight the correct print job, and then press .

5. Press  to highlight PRINT, and then press .

● If the job is not PIN-protected, go to step 7.

6. If prompted, provide a PIN by pressing  or  to change the number. Press  after you have
specified each number of the four-digit PIN.

7. Press  and  to specify the number of copies, and then press  to print the job.

Delete a stored job

1. Press Menu.

2. Press  to highlight RETRIEVE JOB, and then press .

A list of users appears. If there are no stored jobs, then the message NO STORED JOBS appears.

3. Press  to highlight your user name, and then press .

● If you have more than one stored job that is PIN-protected, the ALL PRIVATE JOBS menu
item appears. If you want to delete one of the PIN-protected jobs, highlight ALL PRIVATE
JOBS, and then press .

4. Press  to highlight the correct print job, and then press .

5. Press  to highlight DELETE, and then press .

If the job is not PIN-protected, the printer deletes the job.

6. If prompted, provide a PIN by pressing  or  to change the number. Press  after you have
specified each number of the four-digit PIN.

The printer deletes the job after you set the fourth PIN digit and press .
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8 Print tasks

● Media type and tray loading

● Access the printer driver

● Control print jobs

● Cancel a print job

● Use different paper and print covers

● Print a blank first page

● Use watermarks

● Create and use printing shortcuts in Windows

● Resize documents

● Set a custom paper size from the printer driver

● Print on both sides of the paper (duplex printing)

● Print multiple pages on one sheet of paper in Windows

● Setting the color options

● Using the HP Digital Imaging Options dialog box

● Use the Services tab

ENWW 83



Media type and tray loading
Minimum media dimensions are 148 x 210 mm (5.83 x 8.27 inches).

Maximum media dimensions are 216 x 356 mm (8.5 x 14 inches).

Table 8-1  Tray 1 media information

Media type Media specifications Media quantity Driver settings Paper orientation

Paper and cardstock,
standard sizes

Range:

60 g/m2 (16 lb) bond to
163 g/m2 (43 lb) bond

Maximum stack height:
10 mm (0.6 inch)

Equivalent to 100
sheets of 75 g/m2 (20
lb) bond.

Plain or unspecified N/A

Envelopes Less than 60 g/m2 (16
lb) bond to 90 g/m2 (24
lb) bond

Up to 10 envelopes Envelope Short edge leading,
flap on right side facing
up

Labels Maximum 0.23 mm
(0.009 in.) thick

Maximum stack height:
10 mm (0.6 inch)

Labels Side to be printed on
facing down

Transparencies Minimum 0.13 mm
(0.005 in.) thick

Maximum stack height:
10 mm (0.6 inch)

Transparencies Side to be printed on
facing down

Heavy 0.13 mm (0.005 in.)
thick

Maximum stack height:
10 mm (0.6 in.)

Light glossy, glossy, or
heavy glossy

Side to be printed on
facing down

Glossy Range:

75 g/m2 (20 lb) bond to
176 g/m2 (47 lb) bond

Maximum stack height:
10 mm (0.6 in.)

Light glossy, glossy, or
heavy glossy

Side to be printed on
facing down

Cardstock Range:

163 g/m2 (43 lb) bond to
176 g/m2 (47 lb) cover

60 sheets Cardstock Side to be printed on
facing down

Table 8-2  Tray 2, tray 3, and tray 4 media information

Media type Media
specifications

Media quantity Driver settings Paper orientation Output

Paper and
cardstock,
standard sizes

Range:

60 g/m2 (16 lb)
bond to 120 g/m2

(32 lb) bond

Equivalent to 250
sheets (tray 2) or
500 sheets (tray 3)
of 75 g/m2 (20 lb)
bond.

Plain or
unspecified

N/A  

Labels Maximum 0.13 mm
(0.005 in.) thick

Maximum stack
height: 50 sheets
(tray 2), or 100
sheets (tray 3)

Labels Side to be printed
on facing up

 

Transparencies Minimum 0.13 mm
(0.005 in.) thick

Maximum stack
height: 50 sheets
(tray 2), or 100
sheets (tray 3)

Transparencies Side to be printed
on facing up

 

Heavy 0.13 mm (0.005
in.) thick

Maximum stack
height: 100 sheets

Light glossy,
glossy, or heavy
glossy

Side to be printed
on facing up
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Media type Media
specifications

Media quantity Driver settings Paper orientation Output

(tray 2), or 200
sheets (tray 3)

Glossy Range:

106 g/m2 (28 lb)
bond to 120 g/m2

(32 lb) bond

Maximum stack
height: 100 sheets
(tray 2), or 200
sheets (tray 3)

Light glossy,
glossy, or heavy
glossy

Side to be printed
on facing up

 

Table 8-2  Tray 2, tray 3, and tray 4 media information (continued)
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Access the printer driver
For information about opening the printer driver, see Change printer-driver settings for Windows
on page 38.
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Control print jobs
In Windows, three settings affect how the printer driver pulls media when you send a print job. The
Source, Type, and Size settings appear in the Page Setup, Print, or Print Properties dialog boxes in
most software programs. If you do not change these settings, the printer automatically uses the default
printer settings to select a tray.

CAUTION: Make printer setup changes through the software program or the printer driver whenever
possible, because changes that you make at the control panel become default settings for subsequent
print jobs. Settings selected in the software or the printer driver override control-panel settings.

Source
Print by Source to specify a tray from which the printer will pull media. The printer tries to print from this
tray, no matter what type or size is loaded in it. If you select a tray that is configured for a type or size
that does not match your print job, the job does not proceed until you load the tray with the correct type
or size. If you load the tray correctly, the printer begins printing. If you press , you can select another
tray.

NOTE: If you have difficulties printing by Source, see Priority for print settings on page 37.

Type and Size
Print by Type or Size when you want to pull media from the first tray that is loaded with the type or size
that you select. Selecting media by type rather than source is similar to locking out trays and helps
protect special media from accidental use. For example, if a tray is configured for letterhead, and you
specify that the driver print on plain paper, the printer will not pull media from that tray, but will pull paper
from a tray that has plain paper loaded and is configured for plain paper.

NOTE: Selecting the Any setting negates the tray lock-out function.

Selecting media by type and size results in significantly better print quality for heavy paper, glossy paper,
and overhead transparencies. Using the wrong setting can result in unsatisfactory print quality. Always
print by Type for special print media, such as labels or transparencies. Always print by Size for
envelopes.

● If you want to print by Type or Size and the trays have not been configured for a certain type or
size, load the media into tray 1. Then, in the printer driver, select the Type or Size in the Page
Setup, Print, or Print Properties dialog box.

● If you often print on a certain type or size of media, the printer administrator (for a network printer)
or you (for a local printer) can configure a tray for that type or size. Then, when you select that type
or size as you print a job, the printer pulls from the tray configured for that type or size. See
Configure trays on page 73.

● When you close tray 2 or optional tray 3, a message might appear prompting you to select a
Type or Size for the tray. If the tray is already configured correctly, press  to return to the
Ready state.
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Cancel a print job
You can stop a print request by using the printer control panel or using your software program. For
instructions on how to stop a print request from a computer on a network, see the online Help for the
specific network software.

NOTE: It can take some time for all printing to clear after you have canceled a print job.

Cancel the current print job from the printer control panel
1. Press Stop on the printer control panel.

2. Press  to highlight Cancel Current Job, and then press  to cancel the job.

If the print job is too far into the printing process, you might not have the option to cancel it.

Cancel the current print job from the software program
A dialog box will appear briefly on the screen, giving you the option to cancel the print job.

If several requests have been sent to the printer through your software, they might be waiting in a print
queue (for example, in Windows Print Manager). See the software documentation for specific
instructions about canceling a print request from the computer.

If a print job is waiting in a print queue (computer memory) or print spooler (Windows 2000 or XP), delete
the print job there.

For Windows 2000 and Windows XP, click Start and then click Printers. Double-click the HP Color
LaserJet CP3505 printer icon to open the print spooler. Select the print job that you want to cancel, and
then press Delete. If the print job is not cancelled, you might need to shut down and restart the computer.
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Use different paper and print covers
Follow these instructions for printing a first page that is different from other pages in the print job.

1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

3. Click the Paper/Quality tab.

4. In the Special pages list box, click Print pages on different paper.

5. Click Settings.

6. Select the settings that you want to use to print specific pages on different paper. Click Add.

7. Click OK to return to the Paper/Quality tab.

8. Click OK.

NOTE: The paper size must be the same for all pages of the print job.
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Print a blank first page
1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

3. Click the Paper/Quality tab.

4. In the Special pages list box, click Covers.

5. Click Settings.

6. Select the settings that you want to use to add blank or preprinted covers. Click Add.

7. Click OK to return to the Paper/Quality tab.

8. Click OK.
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Use watermarks
A watermark is a notice, such as "Confidential," that is printed in the background of each page of a
document.

1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

3. From the Effects tab, click the Watermarks drop-down list.

4. Click the watermark that you want to use. To create a new watermark, click Edit.

5. If you want the watermark to appear only on the first page of the document, click First Page
Only.

6. Click OK.

To remove the watermark, click (none) in the Watermarks drop-down list.
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Create and use printing shortcuts in Windows
Use printing shortcuts to save the current driver settings for reuse. Shortcuts are available on most
printer-driver tabs. You can save up to 25 printing shortcuts.

Create a printing shortcut

1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

3. Select the print settings that you want to use. Click Save As.

4. In the Printing Shortcuts box, type a name for the shortcut.

5. Click OK.

Use printing shortcuts

1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

3. Select the shortcut that you want to use from the Printing Shortcuts box.

4. Click OK.

NOTE: To use printer-driver default settings, select Factory Default.
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Resize documents
Use the document resizing options to scale a document to a percentage of its normal size. You can also
choose to print a document on a different size paper, with or without scaling.

Reduce or enlarge a document

1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

3. On the Effects tab, next to % of Actual Size, type the percentage by which you want to reduce or
enlarge your document.

You can also use the scroll bar to adjust the percentage.

4. Click OK.

Print a document onto a different paper size

1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

3. On the Effects tab, click Print Document On.

4. Select the paper size to print on.

5. To print the document without scaling it to fit, make sure that the Scale to Fit option is not selected.

6. Click OK.
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Set a custom paper size from the printer driver
1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

3. On the Paper or Paper/Quality tab, click Custom.

4. On the Custom Paper Size window, type the name of the custom paper size.

5. Type the paper-size length and width. If you type a size that is too small or too large, the driver
adjusts the size to the minimum or maximum size that is allowed.

6. If necessary, click the button to change the unit of measure between millimeters and inches.

7. Click Save.

8. Click Close. The name that you saved appears in the paper-size list for future use.
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Print on both sides of the paper (duplex printing)
NOTE: Two-sided printing is available for the HP Color LaserJet CP3505dn and CP3505x printers.

Use automatic duplex printing
1. Insert enough paper into one of the trays to accommodate the print job. If you are loading special

paper such as letterhead, load it in one of the following ways:

● For tray 1, load the letterhead paper with the front side down, top-edge first.

● For all other trays, load the letterhead paper with front side down, and the top edge at the
back of the tray.

CAUTION: To avoid jams, do not load paper that is heavier than 105 g/m2 (28 lb bond).

2. Open the printer driver (see Change printer-driver settings for Windows on page 38).

3. On the Finishing tab, click Print on Both Sides.

● If necessary, select Flip Pages Up to change the manner in which pages are turned, or select
a binding option in the Booklet Layout list box.

4. Click OK.

Control-panel settings for automatic 2-sided printing
Many software programs include 2-sided printing settings. If your software program or printer driver does
not include 2-sided printing options, you can adjust these settings through the control panel. The factory
default setting is OFF.

CAUTION: Do not use 2-sided printing when printing on labels, transparencies, or glossy paper.
Serious damage to the printer can result.

Turn 2-sided printing on or off from the control panel

NOTE: Changing settings for 2-sided printing from the printer control panel affects all print jobs.
Whenever possible, change settings for 2-sided printing in your software program or printer driver.

To select 2-sided printing from the printer driver, the driver must be configured correctly. For instructions,
see the online Help for the printer driver.

1. Press Menu.

2. Press  to highlight CONFIGURE DEVICE, and then press .

3. Press  to select PRINTING.

4. Press  to highlight DUPLEX, and then press .

5. Press  or  to select ON to turn on 2-sided printing or OFF to turn off 2-sided printing, and
then press .

6. Press Menu to return to the Ready state.
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Print on both sides manually
1. Insert enough paper into one of the trays to accommodate the print job. If you are loading special

paper such as letterhead, load it in one of the following ways:

● For tray 1, load the letterhead paper with the front side down, top-edge first.

● For all other trays, load letterhead paper with front side down, and the top edge at the back
of the tray.

CAUTION: To avoid jams, do not load paper that is heavier than 105 g/m2 (28 lb bond).

2. Open the printer driver (see Change printer-driver settings for Windows on page 38).

3. On the Finishing tab, select Print on Both Sides (manually).

4. Click OK.

5. Send the print job to the product. Follow the instructions in the pop-up window that appears before
feeding the output stack into tray 1 for printing the second half.

6. If prompted, press a control-panel button to continue.

Options for binding 2-sided printing jobs
Before printing a 2-sided document, use the printer driver to specify the edge on which you will bind
your finished document. Long-edge or book binding is the conventional layout used for books. Short-
edge or tablet binding is the typical calendar binding.

NOTE: The default setting is to bind on the long edge for pages in portrait orientation. To change to
short-edge binding, select the Flip Pages Up check box.
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Print multiple pages on one sheet of paper in Windows
You can print more than one page on a single sheet of paper.

1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

3. Click the Finishing tab.

4. In the section for Document Options, select the number of pages that you want to print on each
sheet (1, 2, 4, 6, 9, or 16).

5. If the number of pages is greater than 1, select the correct options for Print Page Borders and
Page Order.

● If you need to change the page orientation, click Portrait or Landscape.

6. Click OK. The product is now set to print the number of pages per sheet that you have selected.
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Setting the color options
Options on the Color tab control how colors are interpreted and printed from software programs. You
can choose either Automatic or Manual color options. For more information, see Manage color
on page 104.

● Select Automatic to optimize the color and halftone settings for text, graphics, and photographs.
The Automatic setting provides additional color options for programs and operating systems that
support color-management systems. This setting is recommended for printing all color documents.

● Select Manual to adjust the color and halftone settings for text, graphics, and photographs. If you
are using a PCL driver, you can adjust the RGB data. If you are using the PS driver, you can adjust
RGB or CMYK data.

To set the color options

1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

3. Click the Color tab.

4. In the Color Options area, select the option that you want to use.

5. If you selected Manual, click Settings to open the Color Settings dialog box. Adjust the individual
settings for text, graphics, and photographs. You can also adjust the general printing settings. Click
OK.

6. In the Color Themes area, select the RGB Color option that you want to use.

7. Click OK.

98 Chapter 8   Print tasks ENWW



Using the HP Digital Imaging Options dialog box
Use HP Digital Imaging Options to print better-quality photos and images.

NOTE: HP Digital Imaging Options are available for Windows 2000, Windows XP, Windows Server
2003, and Vista.

The following options are available on the HP Digital Imaging Options dialog box:

● Contrast Enhancement: Enhance colors and contrast for washed-out photos. Click Automatic
to allow the printer software to brighten areas of photos that need adjustment.

● Digital Flash: Adjust the exposure in dark areas of photos to bring out detail. Click Automatic to
allow the printer software to balance lightness and darkness.

● SmartFocus: Enhance the image quality and clarity of low resolution images such as those
downloaded from the Internet. Click On to allow the printer software to sharpen details in the image.

● Sharpness: Adjust the image sharpness to your preference. Click Automatic to allow the printer
software to set the level of sharpening for the image.

● Smoothing: Soften an image. Click Automatic to allow the printer software to set the level of
smoothing for the image.

Opening the HP Digital Imaging Options dialog box

1. Open the Printer Properties dialog box.

2. Click the Paper/Quality tab, and then click the HP Digital Imaging button.

NOTE: If you installed the HP Image Zone software, you can use it to edit and further enhance digital
photos.
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Use the Services tab
If the product is connected to a network, use the Services tab to obtain product and supply-status
information. Click the Device and Supplies status icon to open the Device Status page of the
HP Embedded Web Server. This page shows the current status of the product, the percentage of life
remaining for each supply, and information for ordering supplies. For more information, see Use the
embedded Web server on page 113.

In the Internet Services area, select an option from the list to go to various support Web sites for this
device. Click Go!.
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9 Color

● Use color

● Manage color

● Match colors
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Use color
The HP Color LaserJet CP3505 printers provide automatic color features that generate excellent color
results. Carefully designed and tested color tables provide smooth, accurate color rendition of all
printable colors.

The printers also provide sophisticated tools for the experienced professional.

HP ImageREt
HP ImageREt is a technology that provides the best color print quality without having to change printer
driver settings or make trade-offs between print quality, performance, and memory. ImageREt produces
photorealistic images.

The HP Color LaserJet CP3505 printers use HP ImageREt 3600 technology, which offers trapping
technologies, control over dot placement, and more precise control of the toner quality in a dot.
HP ImageREt 3600 produces a 600x600 dpi print resolution that provides 3600-dpi laser-class quality
with millions of smooth colors.

Media selection
For the best color and image quality, select the appropriate media type from the software printer menu
or from the printer control panel.

Color options
Color options automatically provide optimal color output. These options use object tagging, which
provides optimal color and halftone settings for different objects (text, graphics, and photos) on a page.
The printer driver determines which objects appear on a page and uses halftone and color settings that
provide the best print quality for each object.

In the Windows environment, the Automatic and Manual color options are on the Color tab in the printer
driver.

Standard red-green-blue (sRGB)
Standard red-green-blue (sRGB) is a worldwide color standard that HP and Microsoft developed as a
common color language for monitors, input devices (scanners and digital cameras), and output devices
(printers and plotters). It is the default color space used for HP products, Microsoft operating systems,
the World Wide Web, and most office software. The sRGB standard represents the typical Windows
monitor and is the convergence standard for high-definition television.

NOTE: Factors such as the type of monitor you use and the room lighting can affect the appearance
of colors on your screen. For more information, see Match colors on page 107.

The latest versions of Adobe PhotoShop®, CorelDRAW, Microsoft Office, and many other programs use
sRGB to communicate color. Because it is the default color space in Microsoft operating systems, sRGB
has been adopted broadly. When programs and devices use sRGB to exchange color information,
typical users experience greatly improved color matching.

The sRGB standard improves your ability to match colors between the printer, the computer monitor,
and other input devices automatically, and eliminates the need to become a color expert.
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Print in four colors (CMYK)
Cyan, magenta, yellow, and black (CMYK) are the inks that a printing press uses in four-color printing.
Graphic arts (printing and publishing) environments typically use CMYK data files to provide rich,
saturated colors for text and graphics. The printer uses the PS printer driver to accept CMYK colors.

CMYK ink-set emulation (PostScript only)
The HP Color LaserJet CP3505 printers use CMYK color rendering to emulate several standard offset-
press ink sets:

● Default CMYK+: This selection is good for general-purpose rendering of CMYK data. It is designed
to render photographs well while providing rich, saturated colors for text and graphics.

● Specifications for Web Offset Publications (SWOP): This selection replicates the common ink
standard in the U.S. and other locations.

● Euroscale: This selection replicates the common ink standard in Europe and other locations.

● Dainippon Ink and Chemical (DIC): This selection replicates the common ink standard in Japan
and other locations.

● Device: This selection turns off emulation. Color must be managed in the software program or
operating system in order to render photographs correctly.
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Manage color
Setting color options to Automatic typically produces the best possible print quality for color documents.
However, you sometimes might want to print a color document in grayscale (black and white) or change
one of the printer color options.

● In Windows, use the settings on the Color tab in the printer driver to print in grayscale or change
the color options.

● When using a Macintosh computer, use the Color Matching pop-up menu in the Print dialog box
to print in grayscale or change the color options.

Print in Grayscale
Select the Print in Grayscale option from the printer driver to print a color document in black and white.
This option is useful for printing color documents that will be photocopied or faxed.

When Print in Grayscale is selected, the printer uses the monochrome mode, which reduces wear on
the color cartridges.

Automatic or manual color adjustment
The Automatic color adjustment option optimizes the neutral-gray color treatment, halftones, and edge
enhancements for each element in a document. For more information, see your printer driver online
Help.

NOTE: Automatic is the default setting and is recommended for printing all color documents.

Use the Manual color adjustment option to adjust the neutral-gray color treatment, halftones, and edge
enhancements for text, graphics, and photographs. To gain access to the manual color options, from
the Color tab, select Manual, and then select Settings.

Manual color options
Use manual color adjustment to adjust the Color (or Color Map) and Halftoning options individually
for text, graphics, and photographs.

NOTE: In programs that convert text or graphics to raster images, the Photographs settings also
control text and graphics.

Table 9-1  Manual color options

Setting description Setting options

Halftone

Halftone options affect the color output resolution
and clarity.

● Smooth provides better results for large, solid-filled print areas
and enhances photographs by smoothing color gradations. Select
this option when uniform and smooth area fills are the top priority.

● Detail is useful for text and graphics that require sharp distinctions
among lines or colors, or images that contain a pattern or a high
level of detail. Select this option when sharp edges and details are
the top priority.
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Setting description Setting options

Neutral Grays

The Neutral Grays setting determines the method for
creating gray colors used in text, graphics, and
photographs.

● Black Only generates neutral colors (grays and black) by using
only black toner. This guarantees neutral colors without a color
cast.

● 4-Color generates neutral colors (grays and black) by combining
all four toner colors. This method produces smoother gradients
and transitions to other colors, and it produces the darkest black.

Edge Control

The Edge Control setting determines how edges are
rendered. Edge control has two components:
adaptive halftoning and trapping. Adaptive halftoning
increases edge sharpness. Trapping reduces the
effect of color-plane misregistration by overlapping
the edges of adjacent objects slightly.

● Maximum is the most aggressive trapping setting. Adaptive
halftoning is on.

● Normal is the default trapping setting. Trapping is at a medium
level and adaptive halftoning is on.

● Light sets trapping at a minimal level, and adaptive halftoning is
on.

● Off turns off both trapping and adaptive halftoning.

RGB Color ● Default (sRGB) instructs the printer to interpret RGB color as
sRGB. The sRGB standard is the accepted standard of Microsoft
and the World Wide Web Consortium (http://www.w3.org).

● Image optimization (sRGB) instructs the printer to use the best
color matching for rendering sRGB images. Select this option to
print raster objects, such as .BMP, .TIF, or .GIF files.

● Adobe RGB (1998) instructs the printer to use the best color
matching for documents or images that are in the Adobe RGB color
space that some digital cameras and high-end graphics programs
create. When printing with Adobe RGB from a professional
software program, turn off the color management in the program
and allow the printer software to manage the color space.

● None instructs the printer to print RGB data in raw device mode.
You must manage color in the program in which you are working
or in the operating system in order to render photographs correctly
when this option is selected.

● Custom Profile instructs the printer to use a custom input profile
to more accurately predict and control color output. Download
custom profiles from http://www.hp.com.

Color access and control
The HP Color LaserJet CP3505 printers include a RESTRICT COLOR USE setting for networked
printers. A network administrator can use this Color Access and Control setting to restrict user access
to the color printing features to conserve color toner. If you are unable to print in color, contact your
network administrator.

1. Press Menu.

2. Press  to select CONFIGURE DEVICE, and then press .

3. Press  to select PRINT QUALITY, and then press .

4. Press  to select SYSTEM SETUP, and then press .

5. Press  to select RESTRICT COLOR USE, and then press .

Table 9-1  Manual color options (continued)
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6. Press  to select one of the following options:

● DISABLE COLOR: This setting denies the printer color capabilities to all users.

● ENABLE COLOR: This is the default setting, which allows all users to use the printer color
capabilities.

● COLOR IF ALLOWED: This setting allows the network administrator to allow color use for
select users. Use the embedded Web server to designate users who can print in color.

7. Press  to save the setting.
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Match colors
The process of matching printer output color to your computer screen is complex, because printers and
computer monitors use different methods of producing color. Monitors display colors by using light pixels
that use an RGB (red, green, blue) color process, but printers print colors by using a CMYK (cyan,
magenta, yellow, and black) process.

Several factors can influence your ability to match printed colors to those on your monitor:

● Print media

● Printer colorants (inks or toners, for example)

● Printing process (inkjet, press, or laser technology, for example)

● Overhead lighting

● Personal differences in perception of color

● Software programs

● Printer drivers

● Computer operating systems

● Monitors

● Video cards and drivers

● Operating environment (humidity, for example)

Keep these factors in mind when colors on your screen do not perfectly match your printed colors.

For most users, the best method for matching colors is to print sRGB colors.

Sample book color matching
The process for matching printer output to preprinted sample books and standard color references is
complex. In general, you can obtain a reasonably good match to a sample book if cyan, magenta, yellow,
and black inks are used in the sample book. These are usually referred to as process-color sample
books.

Some sample books are created from spot colors, which are specially created colorants. Many of these
spot colors are outside the printer gamut (color range). Most spot color sample books have companion
process sample books that provide CMYK approximations.

Most process sample books have a note about what process standards were used to print the sample
book: SWOP, EURO, or DIC. In most cases, for optimal color matching, select the corresponding ink
emulation from the printer menu. If you cannot identify the process standard, use SWOP ink emulation.

Print color samples
To use the color samples, select the color sample that is the closest match to the desired color. Use the
sample’s color value in your program to describe the object that you wish to match. Colors can vary
depending on paper type and the software program used.
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Use the following procedure to print color samples from the printer control panel:

1. Press Menu.

2. Press  to highlight INFORMATION, and then press .

3. Press  to highlight PRINT CMYK SAMPLES or PRINT RGB SAMPLES, and then press .

108 Chapter 9   Color ENWW



10 Manage and maintain

● Information pages

● Configure e-mail alerts

● Use the embedded Web server

● Use HP Easy Printer Care Software

● Use the HP Printer Utility for Macintosh

● Manage supplies

● Replace supplies and parts

● Clean the printer

● Manage memory
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Information pages
From the printer control panel, you can print pages that give details about the printer and its current
configuration. The table below provides the procedures for printing the information pages.

Page description How to print the page

Menu map

Shows the control-panel menus and
available settings.

1. Press Menu.

2. Press  to highlight INFORMATION, and then press .

3. If PRINT MENU MAP is not highlighted, press  or  until it is highlighted,
and then press .

The content of the menu map varies, depending on the options currently installed in
the printer.

For a complete list of control panel menus and possible values, see Control-panel
menus on page 13.

Configuration page

Shows printer settings and installed
accessories.

1. Press Menu.

2. Press  to highlight INFORMATION, and then press .

3. Press  to highlight PRINT CONFIGURATION, and then press .

NOTE: If the printer contains an HP Jetdirect print server or an optional hard disk
drive, an additional configuration page prints that provides information about those
devices.

Supplies status page

Shows print-cartridge toner levels.

1. Press Menu.

2. Press  to highlight INFORMATION, and then press .

3. Press  to highlight PRINT SUPPLIES STATUS PAGE, and then press .

NOTE: If you are using non-HP supplies, the supplies status page might not show
the remaining life for those supplies. For more information, see Non-HP print
cartridges on page 121.

Usage page

Shows a page count for each size of
paper printed, the number of one-sided
(simplexed) or two-sided (duplexed)
pages, and the average percentage of
coverage for each color.

1. Press Menu.

2. Press  to highlight INFORMATION, and then press .

3. Press  to highlight PRINT USAGE PAGE, and then press .

Demo page

Shows a color photograph that allows
you to check print quality.

1. Press Menu.

2. Press  to highlight INFORMATION, and then press .

3. Press  to highlight PRINT DEMO, and then press .

Color usage log

Shows color use statistics for the
printer.

1. Press Menu.

2. Press  to highlight INFORMATION, and then press .

3. Press  to highlight PRINT COLOR USAGE JOB LOG, and then press .

File directory

Shows information for all installed mass
storage devices.

1. Press Menu.

2. Press  to highlight INFORMATION, and then press .

3. Press  to highlight PRINT FILE DIRECTORY, and then press .
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Page description How to print the page

NOTE: This option does not appear if no mass storage devices are installed.

PCL or PS font list

Shows which fonts are currently
installed in the printer.

1. Press Menu.

2. Press  to highlight INFORMATION, and then press .

3. Press  to highlight PRINT PCL FONT LIST or PRINT PS FONT LIST, and
then press .

NOTE: The font lists also show which fonts are resident on an optional hard disk
accessory or flash DIMM.
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Configure e-mail alerts
You can use HP Web Jetadmin or the embedded Web server to configure the system to alert you of
problems with the printer. The alerts take the form of e-mail messages to the e-mail account(s) that you
specify.

You can configure the following:

● The printer(s) you want to monitor

● The alerts you want to receive (for example, alerts for paper jams, paper out, supplies status, and
cover open)

● The e-mail account(s) to which the alerts should be forwarded

Software Information location

HP Web Jetadmin See HP Web Jetadmin on page 42 for general information about HP Web Jetadmin.

See the HP Web Jetadmin Help system for details on alerts and how to set them up.

Embedded Web server See Use the embedded Web server on page 113 for general information about the
embedded Web server.

See the embedded Web server Help system for details on alerts and how to set them up.
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Use the embedded Web server
NOTE: When the printer is directly connected to a computer, use HP Easy Printer Care Software to
view the printer status.

● View printer control status information

● Set the type of paper loaded in each tray

● Determine the remaining life on all supplies and order new ones

● View and change tray configurations

● View and change the printer control panel menu configuration

● View and print internal pages

● Receive notification of printer and supplies events

● View and change network configuration

● View support content that is specific to the current state of the printer

When the printer is connected to the network, the embedded Web server is automatically available. You
can open the embedded Web server from Windows 95 and later.

Use the embedded Web server to view printer and network status and to manage printing functions from
your computer instead of from the printer control panel.

To use the embedded Web server, you must have Microsoft Internet Explorer 4 and later or Netscape
Navigator 4 and later. The embedded Web server works when the printer is connected to an IP-based
network. The embedded Web server does not support IPX-based or AppleTalk printer connections. You
do not need Internet access to open and use the embedded Web server.

Access the embedded Web server by using a network connection
1. In a supported Web browser on your computer, type the IP address for the printer in the address/

URL field. (To find the IP address, print a configuration page. See Information pages
on page 110.)

NOTE: After you open the URL, you can bookmark it so that you can return to it quickly in the
future.

2. The embedded Web server has three tabs that contain settings and information about the printer:
the Information tab, the Settings tab, and the Networking tab. Click the tab that you want to view.

See the following section for more information about each tab.

Embedded Web server sections
The table below describes the basic screens of the embedded Web server.
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Tab or section Description

Information tab

Provides printer, status, and
configuration information.

● Device Status: Shows the printer status and shows the life remaining of HP supplies,
with 0% indicating that a supply is empty. The page also shows the type and size of
print paper set for each tray. To change the default settings, click Change
Settings.

● Configuration Page: Shows the information found on the printer configuration page.

● Supplies Status: Shows the life remaining of HP supplies, with 0 percent indicating
that a supply is empty. This page also provides supplies part numbers. To order new
supplies, click Order Supplies in the Other Links area on the left side of the window.

● Event log: Shows a list of all printer events and errors.

● Usage page: Shows a summary of the number of pages the printer has printed,
grouped by size and type.

● Diagnostics Page: Provides information about printer calibration, color density, and
other parameters.

● Device Information: Shows the printer network name, address, and model
information. To change these entries, click Device Information on the Settings tab.

● Control Panel: Shows messages from the printer control panel, such as Ready or
Sleep mode on.

● Color Usage Job Log: Shows user color print jobs on a job-by-job basis.

● Print: Allows you to send print jobs to the printer.

Settings tab

Provides the ability to configure the
printer from your computer.

● Configure Device: Allows you to configure printer settings. This page contains the
traditional menus found on printers using a control-panel display.

● E-mail Server: Network only. Used in conjunction with the Alerts page to set up
incoming and outgoing e-mail, as well as to set e-mail alerts.

● Alerts: Network only. Allows you to set up to receive e-mail alerts for various printer
and supplies events.

● AutoSend: Allows you to configure the printer to send automated e-mails regarding
printer configuration and supplies to specific e-mail addresses.

● Security: Allows you to set a password that must be entered to gain access to the
Settings and Networking tabs. Enable and disable certain features of the
embedded Web server.

● Edit Other Links: Allows you to add or customize a link to another Web site. This
link is displayed in the Other Links area on all embedded Web server pages.

● Device Information: Allows you to name the printer and assign an asset number to
it. Enter the name and e-mail address for the primary contact who will receive
information about the printer.

● Language: Allows you to determine the language in which to display the embedded
Web server information.

● Date & Time: Allows time synchronization with a network time server.

● Wake Time: Allows you to set or edit a wake time for the printer.

● Restrict Color: Allows you to set user color print job restrictions.

● Tray Sizes/Types: Allows you to configure trays for various media.

NOTE: The Settings tab can be password-protected. If this printer is on a network,
always consult with the printer administrator before changing settings on this tab.
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Tab or section Description

Networking tab

Provides the ability to change
network settings from your
computer.

Network administrators can use this tab to control network-related settings for the printer
when it is connected to an IP-based network. This tab does not appear if the printer is
directly connected to a computer, or if the printer is connected to a network using anything
other than an HP Jetdirect print server.

NOTE: The Networking tab can be password-protected.

Other links

Contains links that connect you to
the Internet.

● HP Instant Support™: Connects you to the HP Web site to help you find solutions.
This service analyzes your printer error log and configuration information to provide
diagnostic and support information specific to your printer.

● Order Supplies: Connects to the HP Web site, in which you can order genuine
HP supplies, such as print cartridges and paper.

● Product Support: Connects to the support site for the printer, from which you can
search for help regarding general topics.

● Show Me How: Demonstrates how to perform an action.

NOTE: You must have Internet access in order to use any of these links. If you use a
dial-up connection and did not connect when you first opened the embedded Web server,
you must connect before you can visit these Web sites. Connecting might require that you
close the embedded Web server and reopen it.
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Use HP Easy Printer Care Software
HP Easy Printer Care Software is an application that you can use for the following tasks:

● Check the printer status.

● Check supplies status.

● Set up alerts.

● Gain access to troubleshooting and maintenance tools.

You can use HP Easy Printer Care Software when the printer is directly connected to your computer or
when it is connected to a network. You must perform a complete software installation to use HP Easy
Printer Care Software.

NOTE: You do not have to have Internet access to open and use HP Easy Printer Care Software.
However, if you click a Web-based link, you must have Internet access to go to the site associated with
the link.

Supported operating systems
HP Easy Printer Care Software is supported for Windows 2000 and Windows XP.

Open HP Easy Printer Care Software
Use one of the following methods to open HP Easy Printer Care Software:

● On the Start menu, select Programs, select HP, and then select HP Easy Printer Care
Software.

● In the Windows system tray (in the lower righthand corner of the desktop), double-click the HP Easy
Printer Care Software icon.

● Double-click the desktop icon.

HP Easy Printer Care Software sections
HP Easy Printer Care Software contains the sections described in the table below.

Section Description

Overview tab

Contains basic status
information for the
printer.

● Devices list: Shows the printers that you can select.

● Device Status section: Shows printer status information. This section will indicate printer alert
conditions, such as an empty print cartridge. It also shows device-identification information,
control-panel messages, and print-cartridge levels. After you correct a problem with the printer,
click the  button to update the section.

● Supplies Status section: Shows detailed supplies status, such as the percentage of toner
remaining in the print cartridges and the status of the media that is loaded in each tray.

● Supplies Details link: Opens the supplies status page to view more detailed information about
printer supplies, ordering information, and recycling information.
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Section Description

Support tab

Provides help information
and links.

● Provides device information, including alerts for items needing attention.

● Provides links to troubleshooting information and tools.

● Provides links to the HP Web site for registration, support, and for ordering supplies.

NOTE: If you use a dial-up connection and did not connect to the Internet when you first
opened the HP Easy Printer Care Software, you must connect before you can visit these Web
sites.

Supplies Ordering
window

Provides access to online
or e-mail supplies
ordering.

● Ordering list: Shows the supplies that you can order for each printer. If you want to order a
certain item, click the Order check box for that item in the supplies list.

● Shop Online for Supplies button: Opens the HP supplies Web site in a new browser window.
If you have checked the Order check box for any items, the information about those items can
be transferred to the Web site.

● Print Shopping List button: Prints the information for the supplies that have the Order check
box selected.

● Email Shopping List button: Creates a text list of items that have the Order check box
selected. The list can be copied into an e-mail message that you send to your supplier.

Alert Settings window

Allows you to configure
the printer to
automatically notify you
of printer issues.

● Alerts on or off: Activates or deactivates the alerts feature for a certain printer.

● When alerts appear: Sets when you want alerts to appear—either when you are printing to
that particular printer, or anytime there is a printer event.

● Alert event type: Sets whether you want alerts for only critical errors, or for any error, including
continuable errors.

● Notification type: Sets what type of alert should appear (pop-up message or system tray alert,
and e-mail message).

Device List tab

Shows information about
each printer in the
Devices list.

● Printer information, including printer name, make, and model

● An icon (if the View as drop-down box is set to Tiles, which is the default setting)

● Any current alerts for the printer

If you click a printer in the list, the HP Easy Printer Care Software opens the Overview tab for that
printer.

Device List tab information includes the following:

Find Other Printers
window

Allows you to add more
printers to your printer
list.

Clicking the Find Other Printers link in the Devices list opens the Find Other Printers window.
The Find Other Printers window provides a utility that detects other network printers so that you
can add them to the Devices list and then monitor those printers from your computer.
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Use the HP Printer Utility for Macintosh
Use the HP Printer Utility to configure and maintain a printer from a Mac OS X V10.2 or V10.3 computer.

Open the HP Printer Utility

Open the HP Printer Utility in Mac OS X V10.2

1. Open the Finder, and then click Applications.

2. Click Library, and then click Printers.

3. Click hp, and then click Utilities.

4. Double-click HP Printer Selector to open the HP Printer Selector.

5. Select the printer that you want to configure, and then click Utility.

Open the HP Printer Utility in Mac OS X V10.3

1. In the Dock, click the Printer Setup Utility icon.

NOTE: If the Printer Setup Utility icon does not appear in the Dock, open the Finder, click
Applications, click Utilities, and then double-click Printer Setup Utility.

2. Select the printer that you want to configure, and then click Utility.

HP Printer Utility features
The HP Printer Utility consists of pages that you open by clicking in the Configuration Settings list.
The following table describes the tasks that you can perform from these pages.

Item Description

Color Cleaning Prints a cleaning page.

Configuration Page Prints a configuration page.

Supplies Status Shows the printer supplies status and provides links for online supplies-ordering.

HP Support Provides access to technical assistance, online supplies ordering, online registration, and
recycling and return information.

File Upload Transfers files from the computer to the printer.

Upload Fonts Transfers font files from the computer to the printer.

Firmware Update Transfers updated firmware files from the computer to the printer.

Duplex Mode Turns on the automatic two-sided printing mode.

Economode Toner Density Turns on the Economode setting to conserve toner, or adjusts toner density.

Resolution Changes the resolution settings, including the REt setting.

Lock Resources Locks or unlocks storage devices, such as a hard disk.

Stored Jobs Manages print jobs that are stored on the printer hard disk.

Trays Configuration Changes the default printer tray settings.

IP Settings Changes the printer network settings and provides access to the embedded Web server.
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Item Description

Additional Settings Provides access to the embedded Web server.

E-mail Alerts Configures the printer to send e-mail notices for certain events.
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Manage supplies
Using, storing, and monitoring print cartridges can help ensure quality printer output.

Supplies life
The life of the print cartridge depends on usage patterns and the amount of toner that print jobs require.
For example, when printing text at 5 percent coverage, an HP print cartridge lasts an average of 4,000
or 6,000 pages, depending on the printer model. (A typical business letter is about 5 percent coverage.)

Cartridge life expectancy is reduced by frequently printing many 1- or 2-page jobs, heavy coverage, and
automatic duplexing. At any time, you can verify the life expectancy by checking the print cartridge life.
See Check the print-cartridge life on page 120 for more information.

Approximate print-cartridge replacement intervals
The following table lists the estimated replacement intervals for print cartridges and the control-panel
messages that indicate when to replace each item.

Printer Page count Approximate time period1

HP Color LaserJet CP3505 Series
printer

6,000 pages (black) 6 months

6,000 pages (color)

1 Approximate life is based on 1,500 pages per month.
2 Approximate average A4-/letter-size page count based on approximately 5% coverage of individual colors.

To order supplies online, go to http://www.hp.com/support/cljcp3505.

Check the print-cartridge life
You can check the print-cartridge life using the printer control panel, the embedded Web server, printer
software, HP Easy Printer Care Software, or HP Web Jetadmin software. Check the supplies gauge on
the printer control panel for approximate supply levels.

Figure 10-1  Printer display

1 2

3

1 Message/Prompt area

2 Supplies gauge

3 Print cartridge colors from left to right: black, yellow, cyan, and magenta
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For more precise levels, follow the instructions in the table below to print a supplies status page.

Device Procedure

Printer control panel 1. Press Menu.

2. Press  to highlight INFORMATION, and then press .

3. Press  to highlight PRINT SUPPLIES STATUS PAGE, and then press  to
print the supplies status page.

HP Easy Printer Care Software In the Overview tab, in the Supplies Status section, click Supplies Details to open
the supplies status page.

Embedded Web server 1. In your browser, enter the IP address for the printer home page and press
Enter to open the printer status page. See Use the embedded Web server
on page 113.

2. On the left side of the screen, click Supplies Status to open the supplies status
page.

NOTE: The IP address is found on the printer Jetdirect page, which is printed with
the configuration page. See Information pages on page 110.

HP Web Jetadmin In HP Web Jetadmin, select the printer device. The device status page shows print
cartridge information.

Print-cartridge storage
Do not remove the print cartridge from its package until you are ready to use it.

CAUTION: To prevent damage to the print cartridge, do not expose it to light for more than a few
minutes, and do not touch the surface of the roller.

HP print cartridges
When you use a genuine new HP print cartridge, you can obtain the following supplies information:

● Percentage of supplies remaining

● Estimated number of pages remaining

● Number of pages printed

Non-HP print cartridges
Hewlett-Packard Company cannot recommend use of non-HP print cartridges, either new or
remanufactured. Because they are not genuine HP products, HP cannot influence their design or control
their quality. Service or repair that is required as a result of using a non-HP print cartridge will not be
covered under the printer warranty.

If you use a non-HP print cartridge, HP cannot ensure the accuracy of certain features.

If the non-HP print cartridge was sold to you as a genuine HP product, see HP fraud hotline and Web
site on page 122.
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Print-cartridge authentication
The printer automatically authenticates the print cartridges when the cartridges are inserted into the
printer. During authentication, the printer will let you know whether a cartridge is a genuine HP print
cartridge.

If the printer control panel message states that this is not a genuine HP print cartridge and you believe
you purchased an HP print cartridge, see HP fraud hotline and Web site on page 122.

HP fraud hotline and Web site
Call the HP fraud hotline (1-877-219-3183, toll-free in North America) or go to http://www.hp.com/go/
anticounterfeit when you install an HP print cartridge and the printer message says the cartridge is non-
HP. HP will help determine if the product is genuine and take steps to resolve the problem.

Your print cartridge might not be a genuine HP print cartridge if you notice the following:

● You are experiencing a high number of problems with the print cartridge.

● The cartridge does not look like it usually does (for example, the orange pull tab is missing, or the
packaging differs from HP packaging).
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Replace supplies and parts
Carefully follow the guidelines in this section when replacing printer supplies.

Supply replacement guidelines
To facilitate the replacement of supplies, keep the following guidelines in mind when setting up the
printer.

● Sufficient space is required above and in the front of the printer for removing supplies.

● The printer should be located on a flat, sturdy surface.

For instructions on installing supplies, see the installation guides provided with each supply item or see
more information at http://www.hp.com/support/cljcp3505.

CAUTION: Hewlett-Packard recommends the use of HP products in this printer. Use of non-
HP products may cause problems requiring service that is not covered by the HP warranty or service
agreements.

Change print cartridges
When a print cartridge approaches the end of useful life, the control panel displays a message
recommending that you order a replacement. The printer can continue to print using the current print
cartridge until the control panel displays a message instructing you to replace the cartridge.

The printer uses four colors and has a different print cartridge for each color: black (K), cyan (C), magenta
(M), and yellow (Y).

Replace a print cartridge when the printer control panel displays a REPLACE <COLOR>
CARTRIDGE message.

NOTE: If all of the print cartridges wear out at the same time and you are printing mostly monochrome
(black and white), you should change the print mode to MOSTLY BLACK PAGES. See System Setup
sub-menu on page 20 for more information.

Change a print cartridge

1. Open the front door.

CAUTION: Do not place anything on the transfer unit and do not touch the transfer unit, which is
located on the inside of the front door.
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2. Remove the used print cartridge from the printer.

3. Remove the new print cartridge from the bag. Place the used print cartridge in the bag for recycling.

4. Grasp both sides of the print cartridge and distribute the toner by gently rocking the print cartridge
from side to side.

CAUTION: Do not touch the shutter or the surface of the roller.
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5. Remove the orange shipping locks and the shipping tape attached to the left shipping lock from
the new print cartridge. Discard the shipping tape and shipping locks according to local regulations.

6. Align the print cartridge with the tracks inside the printer, and using the handles, insert the print
cartridge until it is firmly seated.

7. Firmly close the front door.

After a short time, the control panel should display Ready.

8. Installation is complete. Place the used print cartridge in the box in which the new cartridge arrived.
See the enclosed recycling guide for recycling instructions.

9. If you are using a non-HP print cartridge, check the printer control panel for further instructions.

For additional help, see the Web sites listed in Supply replacement guidelines on page 123.
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Clean the printer
During the printing process, paper, toner, and dust particles can accumulate inside the printer. Over
time, this buildup can cause print-quality problems, such as toner specks or smearing. This printer has
a cleaning mode that can correct and prevent these types of problems.

Clean the printer using the printer control panel
1. Press Menu.

2. Press  to highlight CONFIGURE DEVICE, and then press .

3. Press  to highlight PRINT QUALITY, and then press .

NOTE: If your printer has an automatic duplexer (HP Color LaserJet CP3505dn and CP3505x),
go to step 7.

4. Press  to highlight CREATE CLEANING PAGE, and then press .

5. Remove all paper from tray 1.

6. Remove the cleaning page and load it face-down in tray 1.

NOTE: If you are not still in the menus, navigate to PRINT QUALITY using the above instructions.

7. At the printer control panel, press  to highlight PROCESS CLEANING PAGE, and then
press .
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Manage memory
The HP Color LaserJet CP3505 Series printers have one dual inline memory module (DIMM) slot that
supports up to 1 GB RAM. Use the DIMM slot to upgrade the printer with the following items:

● More printer memory: DIMMs are available in 128, 256, 512 MB, and 1GB DDR 2

● Other DIMM-based printer languages and printer options

NOTE: Single in-line memory modules (SIMMs) used on previous HP LaserJet printers are not
compatible with the printer.

NOTE: To order DIMMs, see Supplies and accessories on page 181.

You might want to add more memory to the printer if you often print complex graphics or PostScript
documents, or if you use many downloaded fonts. Additional memory also allows the printer to print
multiple collated copies at the maximum speed.

Before ordering additional memory, see how much memory is currently installed by printing a
configuration page. See Information pages on page 110.

Install memory DIMMs
You can install more memory for the printer, and you can also install a font DIMM to allow the printer to
print characters for languages such as Chinese or the Cyrillic alphabet.

CAUTION: Static electricity can damage DIMMs. When handling DIMMs, either wear an antistatic
wrist strap, or frequently touch the surface of the DIMM antistatic package and then touch bare metal
on the printer.

1. Turn the printer off, and then disconnect all power and interface cables.
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2. On the right side of the printer, gently pull the black tabs together, and then pull the formatter
assembly from the printer.

3. Place the formatter board on a clean, flat, grounded surface.

To replace a DIMM that is currently installed, spread the latches apart on each side of the DIMM
slot, lift the DIMM up at an angle, and pull it out.

4. Remove the new DIMM from the antistatic package, and then locate the alignment notch on the
bottom edge of the DIMM.
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5. Holding the DIMM by the edges, align the notch on the DIMM with the bar in the DIMM slot at an
angle and firmly press the DIMM into the slot until it is fully seated. When installed correctly, the
metal contacts are not visible.

6. Push down on the DIMM until both latches engage the DIMM.

NOTE: If you have difficulty inserting the DIMM, make sure that the notch on the bottom of the
DIMM is aligned with the bar in the slot. If the DIMM still does not go in, make sure that you are
using the correct DIMM type.

7. Align the edge of the formatter board in the tracks at the top and bottom of the slot, and then slide
the board back into the printer. Push the formatter firmly until you hear the formatter latches click
into place.
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8. Reconnect the power cable and USB or network cable, and then turn on the printer.

9. After installing a memory DIMM, see Enable memory on page 130.

Enable memory
If you installed a memory DIMM, set the printer driver to recognize the newly added memory.

1. On the Start menu, point to Settings, and click Printers or Printers and Faxes.

2. Select this printer and select Properties.

3. On the Configure tab, click More.

4. In the Total Memory field, type or select the total amount of memory that is now installed.

5. Click OK.

6. Go to Verify the DIMM installation on page 130.

Verify the DIMM installation
Verify that the DIMMs are installed correctly and working.

1. Turn the printer on. Check that the printer is in the Ready state after the it has gone through the
startup sequence. If an error message appears, a DIMM may have been incorrectly installed.

2. Print a configuration page. See Information pages on page 110.

3. Check the Installed Personalities and Options section on the configuration page and compare it
with the configuration page printed before the DIMM installation.

4. The DIMM may not be installed correctly. Repeat the installation procedure.

-or-

The DIMM may be defective. Try a new DIMM.
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11 Problem solve

● Basic troubleshooting checklist

● Control-panel messages

● Common causes of jams

● Clear jams

● Paper-handling problems

● Diagnostic test pages

● Printer response problems

● Printer control-panel problems

● Color-printing problems

● Incorrect printer output

● Macintosh problems

● Software program problems

● Print-quality troubleshooting

ENWW 131



Basic troubleshooting checklist
If you are experiencing problems with the printer, use the following checklist to identify the cause of the
problem:

● Is the printer connected to power?

● Is the printer on?

● Is the printer in the Ready state?

● Are all necessary cables connected?

● Do any messages appear on the control panel?

● Are genuine HP supplies installed?

● Were recently replaced print cartridges installed correctly, and was the pull tab on the cartridge
removed?

For additional information about installation and setup, see the printer getting started guide.

If you cannot find solutions to printer problems in this guide, go to http://www.hp.com/support/cljcp3505

Factors that affect printer performance
Several factors affect the time it takes to print a job:

● Maximum printer speed, measured in pages per minute (ppm)

● The use of special paper (such as transparencies, heavy paper, and custom-size paper)

● Printer processing and download time

● The complexity and size of graphics

● The speed of the computer you are using

● The USB connection

● The printer I/O configuration

● The amount of printer memory installed

● The network operating system and configuration (if applicable)

● Printer personality (HP JetReady, PCL, or PS)

NOTE: Although additional printer memory can resolve memory problems, improve how the printer
handles complex graphics, and improve download times, it will not increase maximum printer speed
(ppm).
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Control-panel messages
Four types of control-panel messages can indicate the status of or problems with the printer.

Message type Description

Status messages Status messages reflect the current state of the printer. They inform you of normal printer operation
and require no interaction to clear them. They change as the state of the printer changes. Whenever
the printer is ready, not busy, and has no pending warning messages, the status message Ready
appears if the printer is online.

Warning messages Warning messages inform you of data and print errors. These messages typically alternate with the
Ready or status messages and remain until the  button is pressed. Some warning messages are
clearable. If CLEARABLE WARNINGS is set to JOB on the printer CONFIGURE DEVICE menu, the
next print job clears these messages.

Error messages Error messages communicate that some action must be performed, such as adding paper or clearing
a jam.

Some error messages are auto-continuable. If AUTO CONTINUE=ON is set on the menus, the printer
will continue normal operation after an auto-continuable error message appears for 10 seconds.

NOTE: Pressing any button during the 10-second auto-continuable error message overrides the
auto-continue feature, and the button function takes precedence. For example, pressing the Stop
button pauses printing and offers the option to cancel the print job.

Critical-error messages Critical error messages inform you of a device failure. Some of these messages can be cleared by
turning the printer off and then on. These messages are not affected by the AUTO CONTINUE setting.
If a critical error persists, service is required.

The following table lists and describes control-panel messages.

Control panel message Description Recommended action

10.32.YY UNAUTHORIZED SUPPLY

Unauthorized supply in use

alternates with

For help press 

A new, non-HP supply has been installed.
This message appears until an HP supply is
installed or you press .

If you believe you purchased an HP supply,
please go to http://www.hp.com/go/
anticounterfeit.

Service or repairs required as a result of using
non-HP supplies are not covered under
HP warranty.

To continue printing, press . The first
pending print job will be cancelled.

10.94.YY REMOVE SHIPPING LOCKS
FROM ALL CARTRIDGES

At least one print cartridge still has a shipping
lock attached.

1. Remove all the print cartridges and
check for orange shipping locks on each
end of each cartridge. Remove any
shipping locks that remain.

2. Reinstall the print cartridges.

10.XX.YY SUPPLY MEMORY ERROR

For help press 

The printer cannot read or write to at least one
print cartridge memory tag, or at least one
memory tag is missing.

1. Open the front door.

2. Remove the print cartridges, and then
reinstall them.

3. Close the front door.

4. Turn the printer off and then on.

5. If the error persists, contact HP Support.
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Control panel message Description Recommended action

11.XX INTERNAL CLOCK ERROR

alternates with

To continue press 

The printer's internal clock is not working
correctly. Printing can continue, but you are
prompted to set the date and time each time
you turn the printer on.

Contact HP support.

13.XX.YY DUPLEX JAM INSIDE FRONT
DOOR

alternates with

For help press 

A jam has occurred inside the front door. Open the front door and clear the jam.

See Clear jams from input trays
on page 150.

If the message persists after clearing all
pages and exiting Help, contact HP Support.

13.XX.YY DUPLEX PATH JAM FRONT
DOOR

alternates with

For help press 

A jam has occurred in the duplex output area
inside the front door.

Open the front door and clear the jam.

See Clear jams from input trays
on page 150.

If the message persists after clearing all
pages and exiting Help, contact HP Support.

13.XX.YY FUSER JAM INSIDE TOP
COVER

alternates with

For help press 

A jam has occurred in the fuser. Open the top cover and clear the jam.

CAUTION: The fuser is hot. Wait
10 minutes for it to cool.

See Clear jams from input trays
on page 150.

If the message persists after clearing all
pages and exiting Help, contact HP Support.

13.XX.YY JAM IN TRAY 1

alternates with

Clear jam then press 

A page is jammed in the multipurpose tray. Clear the jam, and then press .

See Clear jams from input trays
on page 150.

If the message persists after clearing all
pages, contact HP Support.

13.XX.YY JAM IN TRAY 2 A page is jammed in tray 2. Remove tray 2, clear the jam, and then
reinstall tray 2.

See Clear jams from input trays
on page 150.

If the message persists after clearing all
pages, contact HP Support.

13.XX.YY JAM IN TRAY X

alternates with

Clear jam then press 

A page is jammed in tray 1 or tray 3. Clear the jam, and then press .

or

See Clear jams from input trays
on page 150.

If the message persists after clearing all
pages and exiting Help, contact HP Support.

13.XX.YY JAM INSIDE FRONT DOOR

alternates with

For help press 

A jam has occurred inside the front door. Press  for help.

or
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Control panel message Description Recommended action

See Clear jams from input trays
on page 150.

If the message persists after clearing all
pages and exiting Help, contact HP Support.

13.XX.YY JAM INSIDE TOP COVER

alternates with

For help press 

A page is jammed underneath the front cover. Open the front door and remove any jammed
media.

20 INSUFFICIENT MEMORY

alternates with

For help press 

To continue press 

The printer has received more data from the
computer than fits in available memory.

1. Press  to continue printing.

NOTE: Data will be lost.

2. Reduce the complexity of the print job to
avoid this error.

3. Adding memory to the printer may allow
printing of more complex pages.

22 EIO X BUFFER OVERFLOW

alternates with

To continue press 

The printer EIO card in slot X has overflowed
its I/O buffer during a busy state.

1. Press  to continue printing.

NOTE: Data will be lost.

2. If the message persists, contact
HP Support.

22 EMBEDDED I/O BUFFER OVERFLOW The embedded HP Jetdirect print server
buffer has overflowed during a busy state.

1. Press  to continue printing.

NOTE: A loss of data will occur.

2. If the message persists, contact
HP Support.

22 USB I/O BUFFER OVERFLOW

alternates with

To continue press 

The printer's USB buffer has overflowed
during a busy state.

1. Press  to continue printing.

NOTE: Data will be lost.

2. If the message persists, contact
HP Support.

40 EIO X BAD TRANSMISSION

alternates with

To continue press 

A connection with the card in the EIO slot has
broken.

1. Press  to continue printing.

NOTE: Data will be lost.

2. If the message persists, contact
HP Support.

40 EMBEDDED I/0 BAD TRANSMISSION

alternates with

To continue press 

The connection with the HP Jetdirect
embedded print server has broken.

Press  to continue printing.

41.3 UNEXPECTED SIZE IN TRAY X

alternates with

LOAD TRAY X <TYPE> <SIZE>

Media is loaded that is longer or shorter in the
feed direction than the size configured for the
tray.

1. Press  to print from a different tray.

2. To print from the current tray, load the
tray with the size and type indicated.

Ensure that all trays are configured correctly
before printing again. See Configure trays
on page 73 for more information.
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Control panel message Description Recommended action

41.5 UNEXPECTED TYPE IN TRAY X

alternates with

LOAD TRAY X <TYPE> <SIZE>

The printer senses a different media type
than what is configured in the tray.

1. Press  to print from a different tray.

2. To print from the current tray, load the
tray with the size and type indicated.

Ensure that all trays are configured correctly
before printing again. See Configure trays
on page 73 for more information.

41.X ERROR

alternates with

To continue press 

A printer error has occurred. 1. Press  to continue or press  for
more information.

2. If the message persists after exiting
help, turn the printer off and then on.

3. If the message persists, contact
HP Support.

49.XXXXX ERROR

alternates with

To continue turn off then on

A critical firmware error has occurred. 1. Turn the printer off and then on.

2. If the message persists, contact
HP Support.

50.X FUSER ERROR

For help press 

A fuser error has occurred. 1. Turn the printer off.

2. Verify the fuser is installed correctly and
fully seated.

3. Turn on the printer.

4. If the message persists, contact
HP Support.

51.XY ERROR

alternates with

To continue turn off then on

A printer error has occurred. 1. Press  to continue.

2. If the message persists, turn the printer
off and then on.

3. If the message persists, contact
HP Support.

52.XY ERROR

alternates with

To continue turn off then on

A printer error has occurred. 1. Press  to continue.

2. If the message persists, turn the printer
off and then on.

3. If the message persists, contact
HP Support.

53.10.01 ERROR UNSUPPORTED RAM The memory DIMM is not a supported DIMM. Install a supported DIMM.

54.XX ERROR A printer command error has occurred. 1. Turn the printer off and then on.

2. If the message persists, contact
HP support.

57.XX PRINTER ERROR

alternates with

To continue turn off then on

A printer fan error has occurred. 1. Turn the printer off and then on.

2. If the message persists, contact
HP Support.
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Control panel message Description Recommended action

59.XY ERROR

alternates with

To continue turn off then on

A printer motor error has occurred. 1. Turn the printer off and then on.

2. If the message persists, contact
HP Support.

NOTE: This message might also
appear if the transfer unit is missing or
incorrectly installed. Ensure that the
transfer unit is correctly installed.

62 NO SYSTEM No system was found. 1. Turn the printer off and then on.

2. If the message persists, contact
HP Support.

68.X PERMANENT STORAGE FULL

alternates with

To continue press 

A non-volatile storage device is full. Press
 to clear the message. Printing can

continue, but unexpected behavior could
result.

X Description

1 Removable disk (flash or hard)

0 Onboard NVRAM

1. Press  to continue.

2. For 68.0 errors, turn the printer off and
then on.

3. If a 68.0 error persists, contact
HP Support.

4. For 68.1 errors, use the HP Web
Jetadmin software to delete files from
the disk drive.

5. For 68.1 errors that persist, contact
HP Support.

68.X PERMANENT STORAGE WRITE FAIL

alternates with

To continue press 

A non-volatile storage device is full. Press
 to clear the message. Printing can

continue, but unexpected behavior could
result.

X Description

0 Onboard NVRAM

1 Removable disk

1. Press  to continue.

2. If the problem persists, contact
HP Support.

68.X STORAGE ERROR SETTINGS
CHANGED

alternates with

To continue press 

One or more printer settings that were saved
in the non-volatile storage device are invalid
and have been reset to the factory default.
Press  to clear the message. Printing can
continue, but unexpected behavior could
result.

1. Press  to continue.

2. Turn the printer off and then on.

3. If the message persists, contact
HP Support.

79.XXXX ERROR

alternates with

To continue turn off then on

A critical hardware error has occurred. 1. Turn the printer off and then on.

2. If the problem persists, contact
HP Support.

8X.YYYY EIO ERROR The EIO accessory card has encountered a
critical error.

1. Turn the printer off and then on.

2. If the problem persists, contact
HP Support.

8X.YYYY EMBEDDED JETDIRECT ERROR The HP Jetdirect embedded print server has
encountered a critical error.

1. Turn the printer off and then on.

2. If the problem persists, contact
HP Support.
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Control panel message Description Recommended action

<Date> <Time>

To change press 

To skip, press STOP

The printer has an internal clock that tracks
the date and time. You are prompted to set
the correct date and time the first time you
turn on the printer.

Press  to change the date and time.

Press Stop to skip this step. You can set the
date and time later by using the SYSTEM
SETUP menu.

If the prompt appears each time you turn on
the printer, the clock is not working correctly.
Contact HP support.

Access Denied MENUS LOCKED The printer administrator has enabled the
control-panel security mechanism. You
cannot modify control-panel settings in this
circumstance. The message disappears after
a few seconds, and the printer returns to
Ready or BUSY state.

Contact the printer administrator to change
settings.

ACTION NOT CURRENTLY AVAILABLE
ON TRAY X

alternates with

Tray size cannot be ANY SIZE/ANY
CUSTOM

You are trying to set duplex registration for a
tray that is configured for ANY SIZE or ANY
CUSTOM. Duplex registration is not available
when the tray size is set to either of these
settings.

Change the size setting for the tray.

BAD DUPLEXER CONNECTION

alternates with

To continue turn off then on

The duplexer is not installed correctly. Turn the printer off and then on to continue.

Calibrating... The printer is calibrating. No action necessary.

Canceling... <JOB NAME> The printer is in the process of canceling a
job. The message appears while the job is
stopped, the paper path is flushed, and any
remaining incoming data on the active data
channel is received and discarded.

No action necessary.

Checking paper path The engine is turning the rollers to check for
possible jams.

No action necessary.

Checking printer The engine is performing an internal test. No action necessary.

CHOSEN PERSONALITY NOT
AVAILABLE

alternates with

To continue press 

The printer encountered a request for a
personality that did not exist in the printer.
The job is cancelled and no pages are
printed.

1. Press  to continue.

2. Try a different driver.

CLEANING DISK X% COMPLETE

alternates with

DO NOT POWER OFF

The memory disk is being cleaned. This
process might take up to an hour. During this
time, no jobs can be printed.

Do not turn off the printer. Wait for the
process to complete.

The printer automatically restarts at the end
of the cleaning process.

Cleaning... The printer is processing the cleaning page. No action necessary.

Clearing event log This message appears while the event log is
cleared. The printer then returns to the
SERVICE menu.

No action necessary.
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Clearing paper path The printer jammed or detected misplaced
media. The printer is attempting to eject these
pages automatically.

No action necessary.

CLOSE TOP COVER AND FRONT DOOR The top cover and front door need to be
closed.

Close the top cover and front door.

CODE CRC ERROR An error has occurred during a firmware
upgrade.

1. Reinstall the firmware.

2. If the problem persists, contact
HP Support.

COLOR RFU FAILED An error has occurred during a firmware
upgrade.

1. Reinstall the firmware.

2. If the problem persists, contact
HP Support.

Creating...CLEANING PAGE The printer is generating a cleaning page.
The printer returns to the Ready state after
the cleaning page is printed.

1. Load the cleaning page into tray 1.

2. Press Menu.

3. Select PRINT QUALITY, and then press
.

4. Select PROCESS CLEANING PAGE,
and then press .

DATA RECEIVED

alternates with

Ready

The printer received data and is waiting for a
form feed. When the printer receives another
file, the message disappears.

The printer is paused.

If the printer is waiting for a form feed, press
 to continue.

If the printer is paused, press Stop to
continue.

Event Log Empty SHOW EVENT LOG was selected from the
control panel, and the event log is empty.

No action necessary.

Genuine HP supplies installed A new HP cartridge has been installed. The
printer returns to the Ready state after
approximately 10 seconds.

No action necessary.

GENUINE HP SUPPLIES DESIGNED FOR
<PROD>

alternates with

Ready

This genuine HP supply was not designed for
this printer and is not supported. The printer
can print with this supply, but print quality
might be affected.

Replace this supply with a genuine HP supply
that is designed for this printer.

Incorrect The PIN number is incorrect. Contact the network administrator.

INCORRECT <COLOR> CARTRIDGE

alternates with

For help press 

A color cartridge is installed in an incorrect
slot.

Press  for help.

or

See Change print cartridges on page 123 for
more information.

INCORRECT SUPPLIES

For status press 

Two or more print cartridges are installed in
an incorrect slot.

Press  and then press  for help.

or

See Replace supplies and parts
on page 123 for more information.
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INFLATE FAILURE An error has occurred during a firmware
upgrade.

1. Reinstall the firmware.

2. If the problem persists, contact
HP Support.

Initializing This message appears when the printer is
turned on and begins initialization.

No action necessary.

Initializing permanent storage This message appears when the printer is
turned on to show that permanent storage is
being initialized.

No action necessary.

INSERT OR CLOSE TRAY XX A tray is open and the printer is trying to print
from another tray.

Close the tray indicated so that printing can
continue.

INSTALL <COLOR> CARTRIDGE

alternates with

For help press 

The cartridge is either not installed or not
correctly installed in the printer.

Press  for help.

or

See Change print cartridges on page 123 for
more information.

INSTALL FUSER

For help press 

The fuser is either not installed or not
correctly installed in the printer.

Press  for help.

or

Contact HP Customer Support or your
authorized HP service provider.

INSTALL SUPPLIES

For status press 

Two or more cartridges are missing. Install the missing cartridges.

Press  and then press  for help.

or

See Supply replacement guidelines
on page 123 for more information.

INSUFFICIENT MEMORY TO LOAD
FONTS/DATA

This message alternates with the name of the
storage device. The storage device does not
have enough memory to load the fonts or
other data.

Press  to continue printing without using
the data.

To solve the problem, increase the amount of
memory for the device. Press  for more
information.

LOAD TRAY X <TYPE> <SIZE>

alternates with

For help press 

Tray X is either empty or configured for a type
and size other than that specified in the job.
No other tray is available.

Press  for help.

or

See Configure trays on page 73 for more
information.

LOAD TRAY X <TYPE> <SIZE>

alternates with

To use another tray press 

Tray X is either empty or configured for a type
and size other than that specified in the job.

Press  for help.

or

Press  to print from another tray. See
Configure trays on page 73 for more
information.

Loading program X

alternates with

Programs and fonts can be stored on the
printer file system and are loaded into RAM
when the printer is turned on. The number X

No action necessary.
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DO NOT POWER OFF specifies a sequence number indicating the
current program being loaded.

MANUALLY FEED <TYPE> <SIZE>

alternates with

For help press 

Tray 1 is empty and no other tray is available. Load media into tray 1, and press  to
continue.

Press  for help.

or

See Configure trays on page 73 for more
information.

MANUALLY FEED <TYPE> <SIZE>

alternates with

To continue press 

Media is in tray 1, but the print job requires a
specific type and size that is not currently
available.

Press  to print from the tray.

or

Press  for help.

or

See Configure trays on page 73 for more
information.

MANUALLY FEED <TYPE> <SIZE>

alternates with

To use another tray press 

No media is in tray 1, and a print job requires
a specific type and size that is available in
another tray.

Press  to print from another tray. See
Configure trays on page 73 for more
information.

or

Press  for help.

MANUALLY FEED OUTPUT STACK

alternates with

Then press  to print second sides

The first side of a manual 2-sided print job has
been printed and the printer is paused until
for the output stack is reinserted.

Take the printed stack out of the output bin
and reinsert it in tray 1 to print the second side
of the 2-sided print job. Press  to continue.

MEM TEST FAILURE REPLACE DIMM 1 The memory DIMM has failed. Install a supported memory DIMM.

Moving solenoid

alternates with

To exit press STOP key

The printer is testing a solenoid. No action necessary.

NON HP SUPPLY IN USE

alternates with

Ready

The printer has detected that a non-
HP supply is currently installed but 
(override) was pressed.

If you believe you purchased an HP supply,
go to www.hp.com/go/anticounterfeit.

Service or repairs that are required as a result
of using non-HP supplies are not covered
under HP warranty.

NON HP SUPPLY INSTALLED

alternates with

For help press 

A new, non-HP supply has been installed.
This message appears until an HP supply is
installed or you press .

If you believe you purchased an HP supply,
go to www.hp.com/go/anticounterfeit.

Service or repairs that are required as a result
of using non-HP supplies are not covered
under HP warranty.

To continue printing, press .
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Control panel message Description Recommended action

ORDER <COLOR> CARTRIDGE

alternates with

Ready

The identified print cartridge is nearing the
end of its useful life. The printer is ready and
will print for the estimated number of pages
indicated.

Order the identified print cartridge. Printing
will continue until REPLACE <COLOR>
CARTRIDGE appears.

NOTE: Estimated pages remaining is
based upon historical page coverage with this
supply.

See Supplies and accessories on page 181
for more information.

NOTE: To prevent this message from
appearing, in the SYSTEM SETUP menu, set
ORDER AT to 0%.

ORDER SUPPLIES

alternates with

Ready

More than one supply item is low. 1. Press  to identify which supplies
should be ordered.

2. Order the supplies. Printing can
continue until REPLACE SUPPLIES
appears.

or

Press  for help.

See Supplies and accessories on page 181
for more information.

PAPER PATH JAM FRONT DOOR

alternates with

For help press 

A page is jammed in the paper path. Open the front door and remove any jammed
media.

Paused

alternates with

To return to Ready press the STOP key

The printer has paused. Press Stop to resume printing.

Performing upgrade A firmware upgrade is in process. No action necessary. Do not turn off the
printer.

Performing... PAPER PATH TEST The printer is performing a paper-path test. No action necessary.

PRINTING STOPPED

To continue press 

This message appears when a Print/Stop test
runs and the time expires.

Press  to continue printing.

Printing... CONFIGURATION The printer is generating the configuration
page. The printer will return to the Ready
state when the page has printed.

No action necessary.

Printing... DEMO PAGE The printer is generating the demo page. The
printer will return to the Ready state when the
page has printed.

No action necessary.

Printing... DIAGNOSTICS PAGE The printer is generating the diagnostics
page. The printer will return to the Ready
state when the page has printed.

No action necessary.

Printing... EVENT LOG The printer is generating the event log page.
The printer will return to the Ready state
when the page has printed.

No action necessary.
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Printing... FILE DIRECTORY The printer is generating the mass storage
directory page. The printer will return to the
Ready state when the page has printed.

No action necessary.

Printing... FONT LIST The printer is generating either the PCL or PS
personality typeface list. The printer will
return to the Ready state when the page has
printed.

No action necessary.

Printing... MENU MAP The printer is generating the printer menu
map. The printer will return to the Ready state
when the page has printed.

No action necessary.

Printing... PQ troubleshooting The printer is generating the print quality
troubleshooting pages. The printer will return
to the Ready state when the pages are
printed.

Follow the instructions on the printed pages.

Printing... REGISTRATION PAGE The printer is generating the registration
page. The printer will return to the SET
REGISTRATION menu when the page has
printed.

Follow the instructions on the printed pages.

Printing... RGB SAMPLES The printer is generating the RGB samples
page. The printer will return to the Ready
state when the page has printed.

No action necessary.

Printing... SUPPLIES STATUS The printer is generating the supplies status
page. The printer will return to the Ready
state when the page has printed.

No action necessary.

Printing... USAGE PAGE The printer is generating the usage page. The
printer will return to the online Ready state
when the page has printed.

No action necessary.

PROCESSING DUPLEX JOB

alternates with

Do not grab paper until job completes

During duplex printing, the paper emerges for
a short time before it is pulled back into the
printer.

Do not pick up pages until they come to rest
in the output bin.

Processing... The printer is currently processing a job but
is not yet picking pages. When the media
begins to move, this message is replaced by
a message that indicates which tray the job is
being printed from.

No action necessary.

Processing... from tray<X> The printer is actively processing a job from
the designated tray.

No action necessary.

RAM DISK DEVICE FAILURE

alternates with

Ready

To clear press 

The RAM disk has failed. 1. Printing can continue for jobs that do not
require the RAM disk.

2. To remove this message from the
display, press .

RAM DISK FILE OPERATION FAILED

alternates with

Ready

To clear press 

The printer received a PJL file system
command that attempted to perform an
illogical operation (for example, to download
a file to a non-existent directory).

1. Printing can continue.

2. To remove this message from the
display, press .

3. If the message reappears, there might
be a problem with the software program.
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RAM DISK FILE SYSTEM IS FULL

alternates with

Ready

To clear press 

The printer received a PJL file system
command to store something on the file
system, but the file system is full.

1. Use HP Web Jetadmin software to
delete files from the RAM disk memory
and try again.

2. To remove this message from the
display, press .

RAM DISK IS WRITE PROTECTED

alternates with

Ready

To clear press 

The file system is protected and no new files
can be written to it.

1. To enable writing to the RAM disk
memory, use HP Web Jetadmin to turn
off write protection.

2. To remove this message from the
display, press .

RAM DISK X Initializing

alternates with

DO NOT POWER OFF

The new RAM disk installed in slot X is
initializing.

No action necessary.

Receiving upgrade A firmware upgrade is in progress. Do not turn the printer off until the printer
returns to Ready.

REMOVE ALL PRINT CARTRIDGES

alternates with

To exit press STOP key

The printer is performing a component test. Remove all print cartridges.

After diagnostics are complete, reinstall all
print cartridges.

REMOVE AT LEAST ONE PRINT
CARTRIDGE

alternates with

To exit press STOP key

The printer is performing a disable cartridge
check or component test.

Remove one print cartridge.

After the test is complete, reinstall the print
cartridge.

REPLACE <COLOR> CARTRIDGE

alternates with

For help press 

The print cartridge has reached its end of life.
Printing will not continue until the cartridge is
replaced.

Press  for help.

See Change print cartridges on page 123 or
Replace supplies and parts on page 123 for
more information.

See Supplies and accessories on page 181
for more information.

REPLACE <COLOR> CARTRIDGE

alternates with

To continue press .

The print cartridge is nearing the end of its
useful life and the REPLACE SUPPLIES
setting in SYSTEM SETUP is set to STOP AT
LOW. To override, press .

1. Order the print cartridge.

2. Press  to continue.

or

Press  for help.

See Supplies and accessories on page 181
for more information.

REPLACE SUPPLIES

alternates with

For status press 

At least two print cartridges are out and need
to be replaced.

1. Press  to identify which supplies
should be replaced.

2. Press  for help.

See Replace supplies and parts
on page 123 for more information.
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See Supplies and accessories on page 181
for more information.

REPLACE SUPPLIES

alternates with

To continue press 

More than one supply item is low, and the
REPLACE SUPPLIES setting in SYSTEM
SETUP is set to STOP AT LOW.

1. Press Menu and navigate to the
SUPPLIES STATUS menu in order to
identify which supplies should be
ordered.

2. Order the supplies.

3. Press  to continue printing.

See Supplies and accessories on page 181
for more information.

REPLACE SUPPLIES

Override in use

alternates with

Ready

At least one print cartridge is out, but printing
is continuing. Print-quality problems might
occur.

1. Press  to identify which supplies
should be ordered.

2. Order the identified supplies.

See Supplies and accessories on page 181
for more information.

REPLACE SUPPLIES

Using black only

alternates with

Ready

At least one color print cartridge is out.
Printing can continue, but only the black
cartridge is being used.

1. Press  to identify which supplies
should be ordered.

2. Order the identified supplies.

See Supplies and accessories on page 181
for more information.

Request accepted please wait The printer has accepted a request to print an
internal page, but the current job must finish
printing before the internal page will print.

No action necessary.

Resend upgrade The firmware upgrade was not successful. Attempt the upgrade again.

Restoring factory settings The printer is restoring factory settings. No action necessary.

Restoring... The printer is restoring settings. No action necessary.

RESTRICTED FROM PRINTING IN COLOR

alternates with

Ready

The message appears when the printer is set
to COLOR IF ALLOWED and you or your
software program are not authorized to print
in color.

Get your network administrator to set the user
or program permissions that will allow you to
print in color.

RFU LOAD ERROR An error has occurred during a firmware
upgrade.

1. Reinstall the firmware.

2. If the problem persists, contact
HP Support.

Rotating <COLOR> motor

alternates with

To exit press STOP key

A component test is in progress; the
component selected is <color> Cartridge
motor.

Press Stop to stop this test.

Rotating motor

alternates with

To exit press STOP key

The printer is testing a motor. Press Stop to stop this test.
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SANITIZING DISK X% COMPLETE

alternates with

DO NOT POWER OFF

The memory disk is being sanitized. This
process might take up to an hour. During this
time, no jobs can be printed.

Do not turn off the printer. Wait for the
process to complete.

The printer automatically restarts at the end
of the sanitation process.

Setting saved A menu selection has been saved. No action necessary.

SIZE MISMATCH IN TRAY XX

alternates with

Ready

The tray is loaded with a media size that is
different than the size for which the tray is
configured. Printing can continue from other
trays, but not from this one.

1. Make sure the media guides are
adjusted correctly.

2. In the PAPER HANDLING menu,
configure the tray for the correct size.

Sleep mode on The printer is in the sleep mode. Any button
press or the receipt of data clears sleep
mode.

No action necessary. The printer
automatically exits sleep mode.

STANDARD TOP BIN FULL

alternates with

Remove all paper from bin

The output bin is full. Printing cannot
continue.

Empty the output bin. Printing resumes
automatically.

Tray X <TYPE> <SIZE>

alternates with

To change size or type press 

The printer is reporting the current
configuration of tray X.

No action necessary.

Press  to clear the message.

Press  to change the type or size.

See Configure trays on page 73 for more
information.

TRAY XX EMPTY <TYPE> <SIZE>

alternates with

Ready

The tray is empty, but the current print job
does not require this tray.

Fill the tray. The message indicates the type
and size of media for which the tray is
currently configured.

TRAY XX OPEN

For help press 

alternates with

Ready

The tray is open, but printing can continue. Close the tray.

TRAY XX OPEN OR EMPTY

alternates with

Ready

The tray is open or empty, but the current
print job does not require this tray.

Close or fill the tray.

TYPE MISMATCH IN TRAY XX

alternates with

Ready

The tray is loaded with a media type that is
different than the type for which the tray is
configured. Printing can continue from other
trays, but not from this one.

In the PAPER HANDLING menu, configure
the tray for the correct type.

Unauthorized supply in use

alternates with

Ready

The printer has detected that a non-HP
supply is currently installed and  (override)
was pressed.

If you believe you purchased an HP supply,
go to www.hp.com/go/anticounterfeit.

Service or repairs required as a result of using
non-HP supplies are not covered under
HP warranty.
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USB ACCESSORY ERROR The printer has detected too much current on
the USB storage accessory.

1. Turn the printer off.

2. Remove the USB storage accessory.

3. Replace the USB storage accessory.

4. Turn the printer on.

USB Storage <X> initializing The USB storage device is initializing. No action necessary.

USB Storage <X> not functional The USB storage device is not working. Replace the USB storage device.

USB STORAGE DEVICE FAILURE

alternates with

Ready

To clear press 

The USB storage device has failed. 1. Printing can continue for jobs that do not
require the storage device.

2. To remove this message from the
display, press .

3. If the message persists, turn the printer
off, remove and re-install the storage
device, and then turn the printer on.

4. If the message persists, replace the
storage device.

USB STORAGE FILE OPERATION FAILED

alternates with

Ready

To clear press 

The printer received a PJL file system
command that attempted to perform an
illogical operation (for example, to download
a file to a nonexistent directory).

1. Printing can continue.

2. To remove this message from the
display, press .

3. If the message reappears, a problem
might exist in the software program.

USB STORAGE FILE SYSTEM IS FULL

alternates with

Ready

To clear press 

The printer received a PJL file system
command that attempted to store something
on the file system but was unsuccessful
because the file system is full.

1. Use HP Web Jetadmin software to
delete files from the storage device, and
then try again.

2. To remove this message from the
display, press .

USB STORAGE IS WRITE PROTECTED

alternates with

Ready

To clear press 

The file system is protected and no new files
can be written to it.

1. To enable writing to the storage device,
use HP Web Jetadmin to turn off write
protection.

2. To remove this message from the
display, turn the printer off and then on.

USB STORAGE X REMOVED The USB storage accessory was removed
while the printer was turned on.

1. Turn the printer off.

2. To continue using the USB storage
accessory, reinstall it.

3. Turn the printer on.

USE TRAY X <TYPE> <SIZE> The printer is offering a selection of alternate
media to use for the print job.

1. Use  and  to highlight a different
size or type, and then press  to select
the size or type.

2. Press  to return to the previous size
or type.

See Configure trays on page 73 for more
information.
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Common causes of jams
Common causes of jams1

Cause Solution

The media does not meet specifications. Use only media that meets HP specifications. See Supported
paper and print media sizes on page 61.

A component is installed incorrectly. Verify that all print cartridges, the transfer unit, and the fuser
are correctly installed.

You are using media that has already passed through a printer
or copier.

Do not use media that has been previously printed on or
copied.

An input tray is loaded incorrectly. Remove any excess media from the input tray. Make sure that
the stack is below the maximum stack height mark in the tray.
See Configure trays on page 73.

The media is skewed. The input-tray guides are not adjusted correctly. Adjust them
so they hold the stack firmly in place without bending it.

The media is binding or sticking together. Remove the media, flex it, rotate it 180 degrees, or flip it over.
Reload the media into the input tray.

NOTE: Do not fan paper. Fanning can create static
electricity, which can cause paper to stick together.

The media is removed before it settles into the output bin. Reset the printer. Wait until the page completely settles in the
output bin before removing it.

During 2-sided printing, you removed the paper before the
second side of the document was printed.

Reset the printer and print the document again. Wait until the
page completely settles in the output bin before removing it.

The media is in poor condition. Replace the media.

The internal rollers from tray 2 or tray 3 are not picking up the
media.

Remove the top sheet of media. If the media is heavier than
163 g/m2 (43 lb), it might not be picked from the tray.

The media has rough or jagged edges. Replace the media.

The media is perforated or embossed. Perforated or embossed media does not separate easily. Feed
single sheets from tray 1.

Printer supply items have reached the end of their useful life. Check the printer control panel for messages prompting you to
replace supplies, or print a supplies status page to verify the
remaining life of the supplies. See Replace supplies and parts
on page 123.

Paper was not stored correctly. Replace the paper in the trays. Paper should be stored in the
original packaging in a controlled environment.

1 If the printer still continues to jam, contact HP Customer Support or your authorized HP service provider.

148 Chapter 11   Problem solve ENWW



Clear jams
Jam locations

Use this illustration to troubleshoot jams in the printer. For instructions to clear jams, see Clear jams
from input trays on page 150.

Figure 11-1  Jam locations (printer shown without optional tray 3)

1

2

3

4

5

6

1 Output bin

2 Paper path

3 Tray 1

4 Trays 2 or 3

5 Duplex path (for 2-sided printing)

6 Fuser

Jam recovery
This printer automatically provides jam recovery, a feature that you can use to set whether the printer
should attempt to automatically reprint jammed pages.

● AUTO instructs the printer to attempt to reprint jammed pages.

● OFF instructs the printer not to attempt to reprint jammed pages.

NOTE: During the recovery process, the printer might reprint pages that were printed before the jam
occurred. Be sure to remove any duplicated pages.

To improve print speed and increase memory resources, you might want to disable the jam recovery.

Turn off jam recovery

1. Press Menu.

2. Press  to highlight CONFIGURE DEVICE, and then press .

3. Press  to highlight SYSTEM SETUP, and then press .

4. Press  to highlight JAM RECOVERY, and then press .
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5. Press  to highlight OFF, and then press .

6. Press Menu to return to the Ready state.

Clear jams from input trays
Procedures in the following sections correspond with a jam message that might appear on the control
panel.

Tray 1

1. Remove the media from the tray.

2. Grasp the jammed sheet by both corners and pull.

3. Place the media stack in tray 1.
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4. Confirm that the media guides are against the stack without bending it and that the stack does not
extend above the fill tabs.

5. Press  to resume printing.

Tray 2 or tray 3

1. If the optional tray 3 is installed, pull it out and place it on a flat surface. If the jammed sheet is
visible, remove it.

2. If the sheet is not visible, check inside the printer at the top of the tray opening. Remove any jammed
media.

3. Pull out tray 2 and place it on a flat surface.
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4. If the jammed sheet is visible, remove it.

5. If the sheet is not visible, check inside the printer at the top of the tray opening. Remove any jammed
media.

6. Replace tray 2 and optional tray 3.

NOTE: Use tray 1 when printing on heavier paper.

7. Press  to resume printing.

NOTE: When printing from tray 2, printing resumes automatically.
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Clear jams from inside the product

Fuser area (top cover)

1. Open the top cover.

2. If the jammed sheet is visible, remove it and then close the top cover.

3. If the sheet is not visible, turn off the printer.

WARNING! The fuser will be hot. Wait 10 minutes before proceeding.
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4. Place your thumbs on the fuser latches, squeeze the latches, and pull up on the fuser to remove
it.

5. On the fuser, lift the shutter door.

CAUTION: Do not open the shutter door while the fuser is in the printer.

6. Remove any jammed sheets.

NOTE: If the sheet tears, make sure that all fragments are removed before you resume printing.
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7. Hold the fuser with your thumbs on the latches, and then push both sides of the fuser into the
printer. Press the fuser down until it clicks into place.

8. Close the top cover and then turn on the printer.

Front door

1. Open the front door.

CAUTION: Do not place anything on the transfer unit. Do not touch the top of the transfer unit or
the contacts on the left side of it.

NOTE: If the sheet tears, make sure that all fragments are removed before resuming printing.
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2. Remove any visible media.

3. Locate the green registration-plate tabs that are below the bottom print cartridge.

4. Press the tabs, and then lift the registration plate. Remove any jammed media, and then return the
registration plate to its closed position.

NOTE: If the sheet tears, make sure that all fragments are removed before resuming printing.
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5. Close the front door.

Clear jams from the duplexer
NOTE: This issue occurs only in models that provide automatic 2-sided printing.

1. Turn off the printer, and open the top cover.

If any media is visible, remove it.

2. Open the front door.
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3. Rotate the transfer unit up and away from the front door.

4. Remove any jammed sheets from under the transfer unit.

5. Locate the green registration-plate tabs that are below the bottom print cartridge.
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6. Press the tabs, and then lift the registration plate. Remove any jammed media, and then return the
registration plate to its closed position.

NOTE: If the sheet tears, make sure that all fragments are removed before resuming printing.

7. Close the front door and then turn on the printer.
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Paper-handling problems
Use only media that meets the specifications outlined in the HP LaserJet Printer Family Print Media
Specification Guide. For ordering information, see Supplies and accessories on page 181.

For paper specifications for this printer, see Supported paper and print media sizes on page 61.

Printer feeds multiple sheets

Cause Solution

The tray is overfilled. Remove excess media from the tray.

The paper exceeds the maximum stack-height indicator mark
in the tray (trays 2 or 3).

Open the tray and verify that the media stack is below the
maximum stack-height mark.

The paper is sticking together. Remove the media, flex it, rotate it 180 degrees, or flip it over,
and then reload it into the tray.

NOTE: Do not fan paper. Fanning can create static
electricity, which can cause paper to stick together.

The media does not meet the specifications for this printer. Use only media that meets HP paper specifications for this
printer. See Supported paper and print media sizes
on page 61.

Paper is being used in a high-humidity environment. Use another type of paper.

Printer feeds incorrect page size

Cause Solution

The correct size paper is not loaded in the tray. Load the correct size paper in the tray.

The correct size of media is not selected in the software
program or printer driver.

Confirm that the settings in the program and printer driver are
appropriate, because the program settings override the printer-
driver and control-panel settings, and the printer-driver settings
override the control-panel settings.

The correct size or media for tray 1 is not selected on the printer
control panel.

At the control panel, select the correct size for tray 1.

The media size is not configured correctly for the tray. Print a configuration page or use the control panel to determine
the size for which the tray is configured.

Printer pulls from an incorrect tray

Cause Solution

You are using a driver for a different printer. Use a driver for this printer.

The specified tray is empty. Load media in the specified tray.

The tray behavior for the requested tray is set to FIRST in the
SYSTEM SETUP submenu of the CONFIGURE DEVICE
menu.

Change the setting to EXCLUSIVELY.
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Printer pulls from an incorrect tray

Cause Solution

The media size is not configured correctly for the tray. Print a configuration page or use the control panel to determine
the size for which the tray is configured.

The USE REQUESTED TRAY setting on the printer control
panel is set to EXCLUSIVELY, and the requested tray is
empty. The printer will not use another tray.

Load media in the requested tray.

or

Change the setting from EXCLUSIVELY to FIRST on the
CONFIGURE DEVICE menu. The printer can use the media
in other trays if none is loaded in the specified tray.

Media does not feed automatically

Cause Solution

Manual feed is selected in the software program. Load tray 1, or, if the tray is loaded, press .

The correct size of media is not loaded. Load the correct size.

The tray is empty. Load media into the tray.

Media from a previous jam has not been completely removed. Open the printer and remove any media that is in the paper
path. Closely inspect the fuser area for jams. See Clear jams
on page 149.

The media size is not configured correctly for the tray. Print a configuration page or use the control panel to determine
the size for which the tray is configured.

The guides in the tray are not against the media stack. Verify that the guides are touching the stack.

The manual-feed prompt is set to ALWAYS. The printer
always prompts for manual feed, even if the tray is loaded.

Open the tray, reload the media, and then close the tray.

Or, change the manual-feed prompt setting to UNLESS
LOADED so that the printer prompts for manual feed only
when the tray is empty.

The USE REQUESTED TRAY setting on the printer control
panel is set to EXCLUSIVELY, and the requested tray is
empty. The printer will not use another tray.

Load the requested tray.

or

Change the setting from EXCLUSIVELY to FIRST on the
CONFIGURE DEVICE menu. The printer can use other trays
if no media is loaded in the specified tray.

Media does not feed from trays 2 and 3

Cause Solution

Manual feed or tray 1 is selected in the software program. Load tray 1, or, if the tray is loaded, press .

The correct size of media is not loaded. Load the correct size.

The tray is empty. Load the tray.

The correct media type for the tray is not selected on the printer
control panel.

At the printer control panel, select the correct type for the tray.
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Media does not feed from trays 2 and 3

Cause Solution

Media from a previous jam has not been completely removed. Open the printer and remove any media that is in the paper
path. Closely inspect the fuser area for jams. See Clear jams
on page 149.

Tray 3 (500-sheet paper feeder) does not appear as a tray
option.

Tray 3 appears as an option only if it is installed. Verify that
tray 3 is correctly installed and that the printer driver has been
configured to recognize tray 3.

Tray 3 is incorrectly installed. Print a configuration page to confirm that tray 3 is installed. If
not, verify that the optional 500-sheet feeder assembly is
correctly attached to the printer.

The media size is not configured correctly for the tray. Print a configuration page or use the control panel to determine
the size for which the tray is configured.

The guides in the tray are not against the media stack. Verify that the guides are touching the stack.

The USE REQUESTED TRAY setting on the printer control
panel is set to EXCLUSIVELY, and the requested tray is
empty. The printer will not use another tray.

Change the setting from EXCLUSIVELY, or load the requested
tray.

Transparencies or glossy paper will not feed

Cause Solution

Transparencies that do not meet HP specifications might have
been loaded.

Use transparencies designed for HP Color LaserJet printers.

The correct media type is not specified in the software or printer
driver.

Verify that the correct type is selected in the software or printer
driver.

The tray is overfilled. Remove excess media from the tray. Make sure the stack is
below the maximum stack height mark in tray 2 or 3. Do not
exceed the maximum stack height for tray 1.

Media in another tray is the same size as the transparencies,
and the printer is defaulting to the other tray.

Make sure that the tray that contains the transparencies or
glossy paper is selected in the software program or printer
driver. Use the printer control panel to configure the tray to the
type that is loaded. See Configure trays on page 73.

The tray that contains the transparencies or glossy paper is not
configured correctly for type.

Make sure that the tray that contains the transparencies or
glossy paper is selected in the software program or printer
driver. Use the printer control panel to configure the tray to the
type that is loaded. See Configure trays on page 73.

Envelopes jam or will not feed into the printer

Cause Solution

Envelopes are loaded in an unsupported tray. Only tray 1 can
feed envelopes.

Load envelopes into tray 1.

Envelopes are curled or damaged. Try using different envelopes. Store envelopes in a controlled
environment. See Understand paper and print media use
on page 60 for more information.

Envelopes are sealing because the moisture content is too
high.

Try using different envelopes. Store envelopes in a controlled
environment.
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Envelopes jam or will not feed into the printer

Cause Solution

The envelope orientation is incorrect. Verify that the envelope is loaded correctly. See Configure
trays on page 73.

This printer does not support the envelopes. See Supported paper and print media sizes on page 61 or the
HP LaserJet Printer Family Print Media Specification Guide.

Tray 1 is configured for a size other than envelopes. Configure tray 1 size for envelopes.

Output is curled or wrinkled

Cause Solution

The media does not meet the specifications for this printer. Use only media that meets the HP paper specifications for this
printer. See Supported paper and print media sizes
on page 61.

The media is damaged or in poor condition. Remove the media from the tray and load media that is in good
condition.

The printer is operating in an excessively humid environment. Verify that the printing environment is within humidity
specifications.

You are printing large, solid-filled areas. Large, solid-filled areas can cause excessive curl. Try using a
different pattern.

The media was not stored correctly and may have absorbed
moisture.

Remove the media and replace it with media from a fresh,
unopened package.

The media has poorly cut edges. Remove the media, flex it, rotate it 180 degrees, or turn it over,
and then reload it into the tray. Do not fan paper. If the problem
persists, replace the paper.

The specific media type was not configured for the tray or
selected in the software.

Configure the software for the media (see the software
documentation). Configure the tray for the media. See
Configure trays on page 73.

The media was used previously. Do not reuse media.

Printer will not perform duplexing (2-sided printing) or duplexes incorrectly

Cause Solution

You are trying to perform 2-sided printing on unsupported
paper.

Verify that the paper is supported for 2-sided printing. See
Supported paper and print media sizes on page 61.

The printer driver is not set up for 2-sided printing. Configure the printer driver for 2-sided printing.

The first page is printing on the back of preprinted forms or
letterhead.

For tray 1, load the letterhead paper first-side-down, bottom
first. For tray 2 or tray 3, load the letterhead paper first-side-
up, top edge toward the back of the tray. See Print on both
sides of the paper (duplex printing) on page 95 for more
information.
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Printer will not perform duplexing (2-sided printing) or duplexes incorrectly

Cause Solution

The printer model does not support automatic 2-sided printing. The HP Color LaserJet CP3505 and CP3505n printers do not
support automatic 2-sided printing.

The printer configuration is not set for duplexing. Run the automatic configuration feature:

1. On the Windows taskbar, click Start, click Settings, and
then click Printers.

◦ For Windows 2000 and Windows XP, click Start,
and then click Printers.

2. Select the printer.

3. In the File menu, click Properties.

4. Click the Device Settings tab or the Configure tab.

5. Under Installable Options, click Automatic
Configuration.

6. Click Update Now.

Printing is only on one side even when 2-sided (duplex) is selected

Cause Solution

Manual 2-sided printing is not enabled. Configure the printer driver to enable manual 2-sided printing.

The paper size that is selected does not support 2-sided
(duplex) printing.

Load and select a size and type of paper that supports
automatic 2-sided printing.
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Diagnostic test pages
From the printer control panel, you can print information pages that can help you diagnose printer
problems.

Page Description

Paper-path-test page The paper-path-test page is useful for testing the printer paper handling features. You can define the
paper path that you want to test by selecting the source and other available options.

1. Press Menu.

2. Press  to highlight DIAGNOSTICS, and then press .

3. Press  to highlight PAPER PATH TEST, and then press .

The message Performing... PAPER PATH TEST appears on the control-panel display until the
printer finishes the paper-path test. The printer returns to the Ready state after printing the paper-
path-test page.

Registration page The registration page prints a horizontal arrow and a vertical arrow that show how far from center an
image can be printed on the page. Set registration values for a tray to center images on the back and
front of a page. Setting the registration also allows edge-to-edge printing to be set to within
approximately 2 mm (0.08 inch) of all edges of the paper. Image placement varies slightly for each
tray. Perform the registration procedure for each tray.

1. Press Menu.

2. Press  to highlight CONFIGURE DEVICE, and then press .

3. Press  to highlight PRINT QUALITY, and then press .

4. Press  to highlight SET REGISTRATION, and then press .

5. Press  to highlight SOURCE, and then press .

6. Press  or  to highlight a tray, and then press .

7. Press  to highlight PRINT TEST PAGE, and then press .

8. Follow the instructions on the printed page.

Event log The event log lists the printer events, including jams, service errors, and other conditions.

1. Press Menu.

2. Press  to highlight DIAGNOSTICS, and then press .

3. Press  to highlight PRINT EVENT LOG, and then press .

The message Printing... EVENT LOG appears on the control-panel display until the printer finishes
printing the event log. The printer returns to the Ready state after printing the event log.

Diagnostics page This page provides information about printer calibration, color density, and other parameters.

1. Press Menu.

2. Press  to highlight DIAGNOSTICS, and then press .

3. Press  to highlight PRINT DIAGNOSTICS PAGE, and then press .

Print-quality
troubleshooting page

See Print-quality-troubleshooting pages on page 179.
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Printer response problems
The control-panel display is blank

Cause Solution

The printer power button is in the off position. Verify that the printer is on. Fans may run while the printer is
in standby mode (off).

The printer memory DIMMs are defective or installed
incorrectly.

Verify that the printer memory DIMMs are correctly installed
and are not defective.

The power cord is not firmly plugged into both the printer and
the power receptacle.

Turn off the printer and then disconnect and reconnect the
power cord. Turn the printer on.

The line voltage is incorrect. Connect the printer to a correct voltage source, as specified on
the power rating label on the back of the printer.

The power cord is damaged or worn. Replace the power cord.

The power source receptacle is not working correctly. Connect the printer to a different power receptacle.

The formatter might not be installed correctly. Remove the formatter assembly. To reinstall it, align the
formatter board in the tracks at the top and bottom of the slot,
and then slide the board back into the printer. Push the
formatter until you hear the formatter latches click into place.

The control-panel display is difficult to read

Cause Solution

The contrast is too high or too low for the office environment. Adjust the contrast on the control-panel display. See Set the
Display Brightness feature on page 28.

The printer is on, but nothing prints

Cause Solution

The printer Ready indicator light is not lit. Press Stop to return the printer to the Ready state.

The top cover is not closed. Close the top cover firmly.

The Data indicator light is flashing. The printer is probably continuing to receive data. Wait for the
Data indicator to stop flashing.

REPLACE <COLOR> CARTRIDGE appears on the control-
panel display.

Replace the specified print cartridge.

A printer message other than Ready appears on the printer
control panel.

See Control-panel messages on page 133.

The parallel port might have an MS-DOS timeout error. Add a MODE command to the AUTOEXEC.BAT file. See the
MS-DOS manual for additional information.

The PS (PostScript emulation) personality is not selected. Select PS or AUTO for the printer language. See Change
control-panel configuration settings on page 26.

The correct driver is not selected in the software program or
printer driver.

Select the PS driver in the software program or printer driver.

The printer is not configured correctly. See Change control-panel configuration settings on page 26.
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The printer is on, but nothing prints

Cause Solution

The computer port is not configured or is not working correctly. Connect another peripheral to this port to verify that the port is
working.

The printer has not been correctly named for the network or for
a Macintosh.

For Macintosh, use the appropriate utility to name the printer
on the network. From the Chooser, select the AppleTalk zone
and the printer.

The printer is on but is not receiving data

Cause Solution

The printer Ready indicator light is not lit. Press Stop to return the printer to the Ready state.

The front door is not closed. Close the front door firmly.

A printer message other than Ready appears on the printer
control panel.

See Control-panel messages on page 133.

The interface cable is not correct for this configuration. Select the correct interface cable for your configuration. See
USB configuration on page 54.

The interface cable is not securely connected to both the
printer and the computer.

Disconnect and reconnect the interface cable.

The printer is not configured correctly. See Change control-panel configuration settings on page 26.

The interface configurations shown on the printer configuration
page do not match those on the host computer.

Configure the printer to match the computer configuration.

The computer is not working correctly. Try using a program that you know works correctly to check
the computer. Or, if the printer is connected through the parallel
port, open MS-DOS and type Dir>Prn at the MS-DOS
command prompt.

The computer port that the printer is connected to is not
configured or is not working correctly.

Connect another peripheral to this port to verify that the port is
working.

The printer has not been correctly named for the network or
Macintosh.

For Macintosh, use the appropriate utility to name the printer
on the network. From the Chooser, select the AppleTalk zone
and the printer.

Cannot select the printer from the computer

Cause Solution

If you are using a switch box, the printer might not be selected
for the computer.

Select the correct printer through the switch box.

The printer Ready indicator light is not lit. Press Stop to return the printer to the Ready state.

A printer message other than Ready appears on the printer
control panel.

See Control-panel messages on page 133.

The correct printer driver is not installed in the computer. Install the correct printer driver.

The correct printer and port are not selected on the computer. Select the correct printer and port.
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Cannot select the printer from the computer

Cause Solution

The network is not configured correctly for this printer. Use the network software to verify the printer network
configuration, or consult with the network administrator.

The power receptacle is not working correctly. Connect the printer to a different power receptacle.

A message appears that 2-sided printing is not available for the type and size selected

Cause Solution

The selected paper is not supported for automatic 2-sided
printing.

Make sure manual 2-sided printing is enabled.
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Printer control-panel problems
The following table lists common printer control-panel problems and suggested solutions for resolving
them.

When powering up the printer for the first time, the control panel remains blank.

Cause Solution

The formatter became disconnected during shipment. 1. Turn off the printer.

2. The formatter cover has a black lever at the top and
bottom. While pushing the top black lever down and the
bottom black lever up, use the levers to pull the formatter
partially out.

3. Push in the formatter until the black levers click into a
secured position.

4. Turn on the printer.

If the problem persists, go to http://www.hp.com/support/
cljcp3505

Control-panel settings do not work correctly

Cause Solution

The printer control-panel display is blank, even when the fan
is running.

Fans might run while the printer is in standby mode (off). Press
the printer power button to turn on the printer.

Printer settings in the software program or printer driver differ
from the printer control-panel settings.

Confirm that the settings in the program and printer driver are
appropriate. The program settings override the printer-driver
and control-panel settings, and the printer-driver settings
override the control-panel settings.

Control-panel settings were not correctly saved. Reselect the control-panel settings, and then press . An
asterisk (*) should appear to the right of the setting.

The Data indicator light is lit, and no pages are printing. Buffered data remains in the printer. Press  to print the
buffered data by using current control-panel settings. Then, the
new control-panel settings can take effect.

If the printer is on a network, another user might have changed
printer control-panel settings.

Consult the network administrator to coordinate changes to
printer control-panel settings.

Unable to select tray 3 (optional 500-sheet paper feeder)

Cause Solution

Tray 3 does not appear as an input tray option on the
configuration page or on the control panel.

Tray 3 appears as an option only if it is installed. Verify that
tray 3 is installed correctly.

Tray 3 does not appear as an option in the printer driver. Verify that the printer driver configuration recognizes tray 3.
See the printer driver Help to set up and configure additional
trays.
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Color-printing problems
Printing black instead of color

Cause Solution

Grayscale is selected in the software program or printer driver. In the software program or printer driver, select Color mode
instead of Grayscale or Monochrome mode.

The correct printer driver is not selected in your software
program.

Select the correct printer driver.

No color appears on the configuration page. Contact HP support.

The control-panel setting for COLOR SUPPLY OUT is set to
AUTOCONTINUE BLACK, and one of the color print
cartridges is out. The printer continues to print in black only.

Replace the color print cartridge.

The control-panel setting for RESTRICT COLOR USE is set
to DISABLE COLOR, or it is set to COLOR IF ALLOWED and
you do not have permission to print in color.

Change the control-panel setting to ENABLE COLOR.

Incorrect hues print

Cause Solution

The media does not meet the specifications for this printer. See the HP LaserJet Printer Family Print Media Specification
Guide.

Go to http://www.hp.com/support/cljcp3505 for HP LaserJet
Printer Family Print Media Specification Guide ordering
information. When you connect, select Manuals.

The printer operates in excessively humid or dry conditions. Verify that the printer environment is within humidity
specifications.

Store the print media in the same environment as the printer.

Calibrate the printer. See Print Quality sub-menu on page 19.

NOTE: For more information about color-quality problems
see Print-quality troubleshooting on page 178.

A color is missing

Cause Solution

The HP print cartridge is defective. Replace the cartridge.

Inconsistent colors print after installing a print cartridge

Cause Solution

New print cartridges sometimes require printing several pages
before they deliver consistent print quality.

Try printing approximately 50 pages with the new cartridge,
and then try the print job again.

Another print cartridge might be low. Check the supplies gauge on the control panel or print a
supplies status page. See Information pages on page 110.
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Inconsistent colors print after installing a print cartridge

Cause Solution

The printer might need calibration. Calibrate the printer. See Calibrate the printer on page 180.

The print cartridge might be a refilled cartridge. Use a genuine HP print cartridge. See Supplies and
accessories on page 181.

Printed colors do not match screen colors

Cause Solution

Extremely light screen colors are not being printed. The software program might interpret extremely light colors as
white. If so, avoid using extremely light colors.

Extremely dark screen colors print in black. The software program might interpret extremely dark colors as
black. If so, avoid using extremely dark colors.

The printer might need calibration. Calibrate the printer. See Calibrate the printer on page 180.

The colors on the computer screen differ from the printer
output.

1. On the printer driver Color tab, in the Color Options
section, select Manual.

2. Click Settings.

3. In Manual Color Options, in the Color Options section,
select Default (sRGB) for each object.

4. Click OK to finish.

NOTE: Several factors can influence your ability to match
printed colors to those on your screen: paper, overhead
lighting, software programs, operating system palettes,
monitors, and video cards and drivers. See Color
on page 101.
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Incorrect printer output
Printer output problems

Incorrect fonts print

Cause Solution

The font has not been correctly selected in the software
program.

Reselect the font in the software program.

The font is not available to the printer. Download the font to the printer or use another font. (In
Windows, the driver does this automatically.)

The correct printer driver is not selected. Select the correct printer driver.

The font might be correct, but the characters appear blurry
because the colors are not aligned correctly.

Perform a full printer calibration. See Calibrate the printer
on page 180.

Cannot print all characters in a symbol set

Cause Solution

The correct font is not selected. Select the correct font.

The correct symbol set is not selected. Select the correct symbol set.

The software program does not support the selected character
or symbol set.

Use a font that supports the character or symbol.

Text drifts between pages

Cause Solution

The software program is not resetting the printer to the top of
the page.

See the software documentation or the PCL/PJL Technical
Reference Package for specific information.

Characters are erratic or missing, or the printout is interrupted

Cause Solution

The interface cable is of poor quality. Try using a different, higher quality, IEEE-compliant interface
cable.

The interface cable is loose. Disconnect and reconnect the interface cable.

The interface cable is damaged or bad. Try using a different interface cable.

The power cable is loose. Disconnect and reconnect the power cable.

You are attempting to print a PCL job, but the printer is
configured for PS.

From the printer control panel, select the correct printer
personality and then resend the print job.

You are attempting to print a PS job, but the printer is
configured for PCL.

From the printer control panel, select the correct printer
personality and then resend the print job.
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Partial printout

Cause Solution

A memory-error message appears on the printer control panel. 1. Increase printer memory by deleting unneeded
downloaded fonts, style sheets, and macros from the
printer memory.

or

2. Add more memory to the printer.

The file that you are printing contains errors. Check the software program to verify that the file does not
contain errors.

1. From within the same program, print another file that you
know is error-free.

or

2. Print the file from another program.

Smears, vertical lines, toner specks, or repetitive marks appear on printouts

Cause Solution

The printer needs to be cleaned. Clean the printer. See Clean the printer on page 126. If the
problem persists, see Print-quality troubleshooting
on page 178.

Guidelines for printing with different fonts
● The 80 internal fonts are available in PostScript Emulation (PS) and PCL mode.

● To conserve printer memory, download only those fonts that are needed.

● If you require several downloaded fonts, consider installing additional printer memory.

Some software programs automatically download fonts at the beginning of each print job. It might be
possible to configure those programs to download only soft fonts that are not already resident in the
printer.
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Macintosh problems
This section lists problems that can occur when using Mac OS X.

The printer driver is not listed in the Print Center or Printer Setup Utility.

Cause Solution

The printer software might not have been installed or was installed
incorrectly.

Make sure that the printer PPD file is in the following hard-drive folder:
Library/Printers/PPDs/Contents/Resources/
<lang>.lproj, where <lang> is the two-letter language code for
the language that you are using. If necessary, reinstall the software.
See the getting started guide for instructions.

The PPD file is corrupt. Delete the PPD file from the following hard-drive folder: Library/
Printers/PPDs/Contents/Resources/<lang>.lproj,
where <lang> is the two-letter language code for the language that
you are using. Reinstall the software. See the getting started guide
for instructions.

The printer name, IP address, or Rendezvous host name does not appear in the printer list in the Print Center or Printer Setup
Utility.

Cause Solution

The printer might not be ready. Make sure that the cables are connected correctly, the printer is on,
and the ready light is on. If you are connecting through a USB or
Ethernet hub, try connecting directly to the computer or use a different
port.

The wrong connection type might be selected. Make sure that USB, IP Printing, or Rendezvous is selected,
depending on the type of connection.

The wrong printer name, IP address, or Rendezvous host name is
being used.

Print a configuration page. Verify that the printer name, IP address,
or Rendezvous host name on the configuration page matches the
printer name, IP address, or Rendezvous host name in the Print
Center or Printer Setup Utility.

The interface cable might be defective or of poor quality. Replace the interface cable with a high-quality cable.

The printer driver does not automatically set up your selected printer in the Print Center or Printer Setup Utility.

Cause Solution

The printer might not be ready. Make sure that the cables are connected correctly, the printer is on,
and the ready light is on. If you are connecting through a USB or
Ethernet hub, try connecting directly to the computer or use a different
port.

The printer software might not have been installed or was installed
incorrectly.

Make sure that the printer PPD file is in the following hard-drive folder:
Library/Printers/PPDs/Contents/Resources/
<lang>.lproj, where <lang> is the two-letter language code for
the language that you are using. If necessary, reinstall the software.
See the getting started guide for instructions.
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The printer driver does not automatically set up your selected printer in the Print Center or Printer Setup Utility.

Cause Solution

The PPD file is corrupt. Delete the PPD file from the following hard-drive folder: Library/
Printers/PPDs/Contents/Resources/<lang>.lproj,
where <lang> is the two-letter language code for the language that
you are using. Reinstall the software. See the getting started guide
for instructions.

The interface cable might be defective or of poor quality. Replace the interface cable with a high-quality cable.

A print job was not sent to the printer that you wanted.

Cause Solution

The print queue might be stopped. Restart the print queue. Open print monitor and select Start Jobs.

The wrong printer name, IP address, or Rendezvous host name is
being used.

Print a configuration page. Verify that the printer name, IP address,
or Rendezvous host name on the configuration page matches the
printer name, IP address, or Rendezvous host name in the Print
Center or Printer Setup Utility.

An EPS file prints with incorrect fonts.

Cause Solution

This problem occurs with some programs. ● Try downloading the fonts that are contained in the EPS file to
the printer before printing.

● Send the file in ASCII format instead of binary encoding.

You are unable to print from a third-party USB card.

Cause Solution

This error occurs when the software for USB printers is not
installed.

When adding a third-party USB card, you might need the Apple USB
Adapter Card Support software. The most current version of this
software is available from the Apple Web site.

When connected with a USB cable, the printer does not appear in the Print Center or Printer Setup Utility after the driver is selected.

Cause Solution

This problem is caused by either a software or a hardware
component.

Software troubleshooting

● Check that your Macintosh supports USB and has the
appropriate USB software from Apple.

● Verify that your Macintosh operating system is Mac OS X V10.2
or later.
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When connected with a USB cable, the printer does not appear in the Print Center or Printer Setup Utility after the driver is selected.

Cause Solution

Hardware troubleshooting

● Check that the printer is turned on.

● Verify that the USB cable is connected correctly.

● Check that you are using the appropriate high-speed USB cable.

● Ensure that you do not have too many USB devices drawing
power from the chain. Disconnect all of the devices from the
chain, and connect the cable directly to the USB port on the host
computer.

● Check to see if more than two nonpowered USB hubs are
connected in a row on the chain. Disconnect all of the devices
from the chain and connect the cable directly to the USB port on
the host computer.

NOTE: The iMac keyboard is a nonpowered USB hub.
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Software program problems
Cannot change system selections

Cause Solution

The printer control panel locks out system software changes. Contact the network administrator.

The software program does not support system changes. See the software program documentation.

The correct printer driver is not loaded. Load the correct printer driver.

The correct program driver is not loaded. Load the correct program driver.

Cannot select a font from the software

Cause Solution

The font is not available to the software program. See the software program documentation.

Cannot select colors

Cause Solution

The software program does not support color. See the software documentation.

Color mode is not selected in the software program or printer
driver.

Select Color mode instead of Grayscale or Monochrome
mode.

The correct printer driver is not loaded. Load the correct printer driver.

Printer driver does not recognize tray 3 or the 2-sided printing accessory

Cause Solution

The printer driver has not been configured to recognize tray 3
or the 2-sided printing accessory.

See the printer driver online Help for instructions to configure
the driver to recognize printer accessories.

The accessory might not be installed. Verify that the accessory is installed correctly.
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Print-quality troubleshooting
If you are experiencing problems with print quality, the following sections might help you identify the
cause of the problem.

Print-quality problems associated with media
Some print-quality problems arise from the use of inappropriate media.

● Use media that meets HP paper specifications. See Supported paper and print media sizes
on page 61.

● The surface of the media is too smooth. Use paper that meets HP paper specifications. See
Supported paper and print media sizes on page 61.

● The moisture content is uneven, too high, or too low. Use media from a different source or from an
unopened ream.

● Some areas of the media reject toner. Use media from a different source or from an unopened
ream.

● The letterhead you are using is printed on rough paper. Use a smoother, xerographic paper. If this
solves your problem, ask the supplier of your letterhead to use paper that meets the specifications
for this printer. See Supported paper and print media sizes on page 61.

● The paper is excessively rough. Use a smoother, xerographic paper.

● The driver setting is incorrect. To change the media type setting, see Type and Size on page 87.

● The media that you are using is too heavy for the media type setting that you selected, and the
toner is not fusing to the media.

Overhead transparency defects
Overhead transparencies can display the same image-quality problems as other types of media and
also defects that are specific to printing on transparencies. Also, because transparencies are pliable in
the print path, the paper-handling components can mark their surface.

NOTE: Allow transparencies to cool for at least 30 seconds before handling them.

● In the printer driver Paper tab, select Transparency as the paper type. Also, make sure that the
tray is correctly configured for transparencies.

● Make sure that the transparencies meet the specifications for this printer. See Supported paper
and print media sizes on page 61.

● The transparencies are not designed for correct toner adhesion. Use only transparencies that are
designed for HP Color LaserJet printers.

● Handle transparencies by the edges. Oil from fingers can cause spots and smudges.

● Small, random, dark areas on the trailing edge of solid-fill pages might result when transparencies
stick together in the output bin. Try printing the job in smaller batches.
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● If printed colors look wrong when printed, select different colors in the software program or printer
driver.

● If you are using a reflective overhead projector with the printed transparencies, use a standard
overhead projector instead.

Print-quality problems associated with the environment
If the printer is operating in excessively humid or dry conditions, verify that the printing environment is
within specifications. See the printer getting started guide for operating-environment specifications.

Print quality problems associated with jams
Make sure that all sheets are cleared from the paper path. See Jam recovery on page 149.

● If the printer recently jammed, print two to three pages to clean the printer.

● If the sheets do not pass through the fuser, which causes image defects on subsequent documents,
print two to three pages to clean the printer. However, if the problem persists, see Print-quality-
troubleshooting pages on page 179.

Print-quality problems associated with toner buildup inside the printer
Over time, toner and other particles can collect inside the printer. This buildup can cause the following
print-quality problems:

NOTE: To help reduce toner buildup, always configure the media type in the tray to match the media
type that you are using. Printing on media that is a different type than the configuration setting can cause
excess toner buildup.

● Marks at even intervals on the printed side of the page

● Toner that smears easily

● Toner specs on the page

● Vertical streaks or bands on the page

To correct these types of problems, clean the printer. See Clean the printer on page 126.

Print-quality-troubleshooting pages
Use the built-in print-quality-troubleshooting pages to help diagnose and solve print-quality problems.

1. Press Menu.

2. Press  to highlight DIAGNOSTICS, and then press .

3. Press  to highlight PQ TROUBLESHOOTING, and then press  to print the pages.

The printer returns to the Ready state after printing the print-quality-troubleshooting pages. If you see
print-quality defects on the print-quality-troubleshooting pages, calibrate the printer. See Calibrate the
printer on page 180. If defects continue to appear, go to http://www.hp.com/go/printquality/cljcp3505
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Calibrate the printer
Calibration is a printer function that optimizes print quality. If you experience any print-quality problems,
calibrate the printer.

1. Press Menu.

2. Press  to highlight CONFIGURE DEVICE, and then press .

3. Press  to highlight PRINT QUALITY, and then press .

4. Press  to highlight FULL CALIBRATE NOW, and then press .
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A Supplies and accessories

● To order supplies in the U.S., go to http://www.hp.com/sbso/product/supplies.

● To order supplies worldwide, go to http://www.hp.com/ghp/buyonline.html.

● To order supplies in Canada, go to http://www.hp.ca/catalog/supplies.

● To order supplies in Europe, go to http://www.hp.com/go/supplies.

● To order supplies in Asia-Pacific, go to http://www.hp.com/paper/.

● To order accessories, go to http://www.hp.com/go/accessories.
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Parts and supplies
Spare parts and supplies for this printer will be available for at least five years after production has
stopped.

The table below lists available supplies and accessories for the HP Color LaserJet CP3505 printers.

Table A-1  Supplies, accessories, and part numbers

Part Part number Type/size

Memory upgrades (DIMMs) CC409A Synchonous 128 MB DDR2 SDRAM DIMM

CC410A Synchronous 256 MB DDR2 SDRAM DIMM

CC411A Synchronous 512 MB DDR2 SDRAM DIMM

CC412A Synchronous 1 GB DDR2 SDRAM DIMM

Accessories Q5958A Optional 500-sheet paper feeder (tray 3)

Internal (EIO) connectivity J6073A/G HP Jetdirect high-performance hard disk (20 GB)

J7989A HP Jetdirect 620n print server (10/100base-TX Ethernet)

J7960A HP Jetdirect 625n print server (10/100/1000T Ethernet)

External (EX) connectivity J6035D HP Jetdirect print server (fast Ethernet, 10/100base-TX,
USB 1.1)

J7942A HP Jetdirect en3700 print server (fast Ethernet, full feature
set, 10/100base-TX, USB 2.0)

J7951A HP Jetdirect ew2400 wired/wireless print server (fast
Ethernet, value feature set, USB 2.0)

J7988G HP Jetdirect en1700 USB 2.0 print server

Printer supplies Q6470A Black print cartridge

Q7581A Cyan print cartridge

Q7582A Yellow print cartridge

Q7583A Magenta print cartridge

Cables C6518A USB 2.0 printer cable (2-meter [6.5-foot] standard)

Reference materials 5851-1468 HP LaserJet Printer Family Print Media Specification Guide

5021-0337 PCL/PJL Technical Reference Package

For downloadable versions, go to http://www.hp.com/
support/cljcp3505. When connected, select Manuals.
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Ordering by using the embedded Web server
Use the following steps to order printing supplies directly through the embedded Web server (see Use
the embedded Web server on page 113).

1. In the Web browser on the computer, type the IP address for the printer. The printer status window
appears. Or, go to the URL provided in the alert e-mail.

2. If asked to provide a password, type the password.

3. On the left side of the Device Configuration window, click Order Supplies. This provides the URL
where you can purchase supplies and view supplies information, including part numbers and printer
information.

4. Select the part numbers you want to order and follow the onscreen instructions.
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B Service and support
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Hewlett-Packard limited warranty statement
HP PRODUCT DURATION OF LIMITED WARRANTY

HP Color LaserJet CP3505 Series Printer One-year limited warranty

HP warrants to you, the end-user customer, that HP hardware and accessories will be free from defects
in materials and workmanship after the date of purchase, for the period specified above. If HP receives
notice of such defects during the warranty period, HP will, at its option, either repair or replace products
which prove to be defective. Replacement products may be either new or equivalent in performance to
new.

HP warrants to you that HP software will not fail to execute its programming instructions after the date
of purchase, for the period specified above, due to defects in material and workmanship when properly
installed and used. If HP receives notice of such defects during the warranty period, HP will replace
software which does not execute its programming instructions due to such defects.

HP does not warrant that the operation of HP products will be uninterrupted or error free. If HP is unable,
within a reasonable time, to repair or replace any product to a condition as warranted, you will be entitled
to a refund of the purchase price upon prompt return of the product.

HP products may contain remanufactured parts equivalent to new in performance or may have been
subject to incidental use.

Warranty does not apply to defects resulting from (a) improper or inadequate maintenance or calibration,
(b) software, interfacing, parts or supplies not supplied by HP, (c) unauthorized modification or misuse,
(d) operation outside of the published environmental specifications for the product, or (e) improper site
preparation or maintenance.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTIES ARE EXCLUSIVE AND
NO OTHER WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR
IMPLIED AND HP SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF
MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE.
Some countries/regions, states or provinces do not allow limitations on the duration of an implied
warranty, so the above limitation or exclusion might not apply to you. This warranty gives you specific
legal rights and you might also have other rights that vary from country/region to country/region, state
to state, or province to province.

HP's limited warranty is valid in any country/region or locality where HP has a support presence for this
product and where HP has marketed this product. The level of warranty service you receive may vary
according to local standards. HP will not alter form, fit or function of the product to make it operate in a
country/region for which it was never intended to function for legal or regulatory reasons.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE REMEDIES IN THIS WARRANTY STATEMENT
ARE YOUR SOLE AND EXCLUSIVE REMEDIES. EXCEPT AS INDICATED ABOVE, IN NO EVENT
WILL HP OR ITS SUPPLIERS BE LIABLE FOR LOSS OF DATA OR FOR DIRECT, SPECIAL,
INCIDENTAL, CONSEQUENTIAL (INCLUDING LOST PROFIT OR DATA), OR OTHER DAMAGE,
WHETHER BASED IN CONTRACT, TORT, OR OTHERWISE. Some countries/regions, states or
provinces do not allow the exclusion or limitation of incidental or consequential damages, so the above
limitation or exclusion may not apply to you.

THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT
LAWFULLY PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION TO
THE MANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.
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Customer self repair warranty service
HP products are designed with many Customer Self Repair (CSR) parts to minimize repair time and
allow for greater flexibility in performing defective parts replacement. If during the diagnosis period, HP
identifies that the repair can be accomplished by the use of a CSR part, HP will ship that part directly to
you for replacement. There are two categories of CSR parts: 1) Parts for which customer self repair is
mandatory. If you request HP to replace these parts, you will be charged for the travel and labor costs
of this service. 2) Parts for which customer self repair is optional. These parts are also designed for
Customer Self Repair. If, however, you require that HP replace them for you, this may be done at no
additional charge under the type of warranty service designated for your product.

Based on availability and where geography permits, CSR parts will be shipped for next business day
delivery. Same-day or four-hour delivery may be offered at an additional charge where geography
permits. If assistance is required, you can call the HP Technical Support Center and a technician will
help you over the phone. HP specifies in the materials shipped with a replacement CSR part whether
a defective part must be returned to HP. In cases where it is required to return the defective part to HP,
you must ship the defective part back to HP within a defined period of time, normally five (5) business
days. The defective part must be returned with the associated documentation in the provided shipping
material. Failure to return the defective part may result in HP billing you for the replacement. With a
customer self repair, HP will pay all shipping and part return costs and determine the courier/carrier to
be used.
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Limited warranty for print cartridges and image drums
This HP Print Cartridge is warranted to be free from defects in materials and workmanship.

This warranty does not apply to print cartridges that (a) have been refilled, refurbished, remanufactured
or tampered with in any way, (b) experience problems resulting from misuse, improper storage, or
operation outside of the published environmental specifications for the printer product or (c) exhibit wear
from ordinary use.

To obtain warranty service, please return the product to place of purchase (with a written description of
the problem and print samples) or contact HP customer support. At HP’s option, HP will either replace
products that prove to be defective or refund your purchase price.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTY IS EXCLUSIVE AND NO
OTHER WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR
IMPLIED AND HP SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF
MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE.

TO THE EXTENT ALLOWED BY LOCAL LAW, IN NO EVENT WILL HP OR ITS SUPPLIERS BE
LIABLE FOR DIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL (INCLUDING LOST PROFIT OR
DATA), OR OTHER DAMAGE, WHETHER BASED IN CONTRACT, TORT, OR OTHERWISE.

THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT
LAWFULLY PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION TO
THE MANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.
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Color LaserJet Image Fuser Kit and Image Transfer Kit
Limited Warranty Statement

This HP product is warranted to be free from defects in materials and workmanship until the printer
provides a low-life indicator on the control panel.

This warranty does not apply to products that (a) have been refurbished, remanufactured or tampered
with in any way, (b) experience problems resulting from misuse, improper storage, or operation outside
of the published environmental specifications for the printer product or (c) exhibit wear from ordinary
use.

To obtain warranty service, please return the product to place of purchase (with a written description of
the problem) or contact HP customer support. At HP’s option, HP will either replace products that prove
to be defective or refund your purchase price.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTY IS EXCLUSIVE AND NO
OTHER WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR
IMPLIED AND HP SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF
MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE.

TO THE EXTENT ALLOWED BY LOCAL LAW, IN NO EVENT WILL HP OR ITS SUPPLIERS BE
LIABLE FOR DIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL (INCLUDING LOST PROFIT OR
DATA), OR OTHER DAMAGE, WHETHER BASED IN CONTRACT, TORT, OR OTHERWISE.

THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT
LAWFULLY PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION TO
THE MANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.
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Customer support
Get telephone support, free during your warranty period, for
your country/region

Have the product name, serial number, date of purchase, and
problem description ready.

Country/region phone numbers are on the flyer that was in the
box with your product or at www.hp.com/support/.

Get 24-hour Internet support http://www.hp.com/support/cljcp3505

Get support for products used with a Macintosh computer www.hp.com/go/macosx

Download software utilities, drivers, and electronic information http://www.hp.com/go/cljcp3505_software

Order supplies and paper www.hp.com/go/suresupply

Order genuine HP parts or accessories www.hp.com/buy/parts

Order additional HP service or maintenance agreements www.hp.com/go/carepack
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HP maintenance agreements
HP has several types of maintenance agreements that meet a wide range of support needs.
Maintenance agreements are not part of the standard warranty. Support services may vary by area.
Check with your local HP dealer to determine the services available to you.

On-site service agreements
To provide you with the level of support best suited to your needs, HP has on-site service agreements
with a selection of response times.

Next-day on-site service
This agreement provides support by the next working day following a service request. Extended
coverage hours and extended travel beyond HP’s designated service zones are available on most on-
site agreements (for additional charges).

Weekly (volume) on-site service
This agreement provides scheduled weekly on-site visits for organizations with many HP products. This
agreement is designated for sites using 25 or more workstation products, including printers, plotters,
computers, and disk drives.

Extended warranty
HP SupportPack provides coverage for the HP hardware product and all HP-supplied internal
components. The hardware maintenance covers a 1 to 3 year period from date of the HP product
purchase. The customer must purchase HP SupportPack within the stated factory warranty. For more
information, contact the HP Customer Care Service and Support group.
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Repack the printer
If your printer needs to be moved or shipped to another location, perform the following procedure to
repack the printer.

CAUTION: Shipping damage as a result of inadequate packing is the customer's responsibility. The
printer must remain upright during shipment.

Repack the printer

CAUTION: It is extremely important to remove the print cartridges before shipping the printer. Print
cartridges left in the printer during shipping will leak and entirely cover the printer engine and other parts
with toner.

To prevent damage to the print cartridge, avoid touching the roller, and store the print cartridge in its
original packing material or so that it is not exposed to light.

1. Remove all four print cartridges and ship separately.

2. Remove optional tray 3 and ship the tray separately.

3. Use the original shipping container and packing material, if possible. If you have already disposed
of the printer packing material, contact a local mailing service for information about repacking the
printer. HP recommends insuring the equipment for shipment.
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C Printer specifications

The printer specifications provide information about the size and weight, amount of power needed and
used, and noise output of the printer. The specifications also describe how the different operating modes
affect power consumption, heat output, and noise output.

Physical specifications
Table C-1  Physical dimensions for the HP Color LaserJet CP3505 printers

Product Height Depth Width Weight1

Base model 400 mm (15.7 in) 450 mm (17.7 in) 400 mm (15.7 in)
20.3 kg
(44.8 lbs)

Base model plus duplexer 423 mm (16.7 in) 450 mm (17.7 in) 400 mm (15.7 in)
21.5 kg
(47.4 lbs)

Base model plus optional tray 3 540 mm (21.3 in) 450 mm (17.7 in) 400 mm (15.7 in) 25.4 kg (56 lbs)

Base model plus duplexer and optional
tray 3

563 mm (22.2 in) 450 mm (17.7 in) 400 mm (15.7 in) 26.6 kg
(58.6 lbs)

1 Printer weight does not include print cartridges.
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Electrical specifications
WARNING! Power requirements are based on the country/region where the printer is sold. Do not
convert operating voltages. This may damage the printer and void the product warranty.

Table C-2  Electrical specifications for the HP Color LaserJet CP3505 printers

Item 110-volt models 220-volt models

Power requirements 100 to 127 V (+/-10%)

50 to 60 Hz (+/-2 Hz)

220 to 240 V (+/-10%)

50 to 60 Hz (+/-2 Hz)

Minimum recommended circuit capacity 6.5 A 3.5 A
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Power-consumption specifications
Table C-3  Power consumption (average, in watts)1

Product Model Printing2 Ready3 Sleep4 Off Heat output-
Ready (BTU/
hour)5

HP Color LaserJet CP3505 437 48 15 0.5 162

HP Color LaserJet
CP3505n

437 48 15 0.5 162

HP Color LaserJet
CP3505dn

437 48 15 0.5 162

HP Color LaserJet
CP3505x

407 46 15 0.7 162

1 The power consumption reflects the highest values measured for color and monochrome printing when using standard
voltages.

2 Printing speed is 20 ppm for letter-size media and 21 ppm for A4-size media.
3 The default activation time from ready mode to sleep mode is 30 minutes.
4 The recovery time from sleep mode to the start of printing is 6 seconds.
5 Maximum heat dissipation for all models in ready mode is 171 BTU per hour.

NOTE: These values are subject to change.
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Acoustic specifications
Table C-4  Acoustic emissions for theHP Color LaserJet CP3505 printers

Sound power level Declared per ISO 9296

Printing (20 ppm)1 LWAd = 6.4 Bels (A) [64 dB (A)]

Ready LWAd = 5.4 Bels (A) [54 dB (A)]

Sound pressure level: bystander position Declared per ISO 9296

Printing (20 ppm)1 LpAm = 50 dB (A)

Ready LpAm = 40 dB (A)

1 The printing speed is 20 ppm for letter-size media and 21 ppm for A4-size media.

NOTE: These values are subject to change.
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Operating-environment specifications
Table C-5  Operating environment specifications

Environment Recommended Allowed

Temperature 17 to 25° C (62.6 to 77° F) 10 to 27° C (50 to 81° F)

Humidity 20 to 60% relative humidity (RH) 10 to 70% RH

Altitude Not applicable 0 to 2600 m (0 to 8530 ft)

NOTE: These values are subject to change.
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D Regulatory information

This section contains the following regulatory information:

● FCC statement

● Environmental stewardship

● Declaration of conformity

● Country/region specific statements
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FCC statement
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant
to Part 15 of the FCC rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses, and can radiate radio
frequency energy. If this equipment is not installed and used in accordance with the instructions, it may
cause harmful interference to radio communications. However, there is no guarantee that interference
will not occur in a particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the user is
encouraged to try to correct the interference by one or more of the following measures:

● Reorient or relocate the receiving antenna.

● Increase separation between equipment and receiver.

● Connect equipment to an outlet on a circuit different from that to which the receiver is located.

● Consult your dealer or an experienced radio/TV technician.

NOTE: Any changes or modifications to the printer that are not expressly approved by HP could void
the user’s authority to operate this equipment.

Use of a shielded interface cable is required to comply with the Class B limits of Part 15 of FCC rules.
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Environmental stewardship
Protecting the environment

Hewlett-Packard Company is committed to providing quality products in an environmentally sound
manner. This product has been designed with several attributes to minimize impacts on our environment.

Ozone production
This product generates no appreciable ozone gas (O3).

Power consumption
Power usage drops significantly while in Ready and Sleep mode, which saves natural resources and
saves money without affecting the high performance of this product. To determine the ENERGY STAR®
qualification status for this product, see the Product Data Sheet or Specifications Sheet. Qualified
products are also listed at:

www.hp.com/go/energystar

Toner consumption
EconoMode uses less toner, which might extend the life of the print cartridge.

Paper use
This product’s manual/optional automatic duplex feature (two-sided printing) and N-up printing (multiple
pages printed on one page) capability can reduce paper usage and the resulting demands on natural
resources.

Plastics
Plastic parts over 25 grams are marked according to international standards that enhance the ability to
identify plastics for recycling purposes at the end of the product’s life.

HP LaserJet print supplies
It’s easy to return and recycle your empty HP LaserJet print cartridges—free of charge—with HP Planet
Partners. Multilingual program information and instructions are included in every new HP LaserJet print
cartridge and supplies package. You help reduce the toll on the environment further when you return
multiple cartridges together rather than separately.

HP is committed to providing inventive, high-quality products and services that are environmentally
sound, from product design and manufacturing to distribution, customer use, and recycling. When you
participate in the HP Planet Partners program, we ensure your HP LaserJet print cartridges are recycled
properly, processing them to recover plastics and metals for new products and diverting millions of tons
of waste from landfills. Please note that the cartridge will not be returned to you. Thank you for being
environmentally responsible!

NOTE: Use the return label to return original HP LaserJet print cartridges only. Please do not use this
label for HP inkjet cartridges, non-HP cartridges, refilled or remanufactured cartridges, or warranty
returns. For information about recycling your HP inkjet cartridges, please go to www.hp.com/recycle.
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Return and recycling instructions

United States and Puerto Rico
The enclosed label in the HP LaserJet toner cartridge box is for the return and recycling of one or more
HP LaserJet print cartridges after use. Please follow the applicable instructions below.

Multiple returns (two to eight cartridges)

1. Package each HP LaserJet print cartridge in its original box and bag.

2. Tape up to eight single boxes together using strapping or packaging tape (up to 70 lbs).

3. Use a single pre-paid shipping label.

OR

1. Use your own suitable box, or request a free bulk collection box from the http://www.hp.com/
recycle or 1-800-340-2445 (holds up to eight HP LaserJet print cartridges).

2. Use a single pre-paid shipping label.

Single returns

1. Package the HP LaserJet print cartridge in its original bag and box.

2. Place the shipping label on the front of the box.

Shipping

For all HP LaserJet print cartridge recycling returns, give the package to UPS during your next delivery
or pickup, or take it to an authorized UPS drop-off center. For the location of your local UPS drop-off
center, call 1-800-PICKUPS or visit http://www.ups.com. If you are returning via USPS label, give the
package to a U.S. Postal Service carrier or drop off at a U.S.Postal Service Office. For more information,
or to order additional labels or boxes for bulk returns, visit http://www.hp.com/recycle or call
1-800-340-2445. Requested UPS pickup will be charged normal pickup rates. Information subject to
change without notice.

Non-US returns
To participate in HP Planet Partners return and recycling program, just follow the simple directions in
the recycling guide (found inside the packaging of your new printer supply item) or visit
http://www.hp.com/recycle. Select your country/region for information on how to return your HP LaserJet
printing supplies.

Paper
This product is capable of using recycled papers when the paper meets the guidelines outlined in the
HP LaserJet Printer Family Print Media Guide. This product is suitable for the use of recycled paper
according to EN12281:2002.

Material restrictions
This HP product does not contain added mercury.

This HP product contains a battery that might require special handling at end-of-life. The batteries
contained in or supplied by Hewlett-Packard for this product include the following:
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HP Color LaserJet CP3505 printers

Type: carbon monofluoride lithium battery BR1632

Weight: (1.5 g)

Location: On formatter board

User-removable: No

For recycling information, you can go to http://www.hp.com/recycle, or contact your local authorities or
the Electronics Industries Alliance: http://www.eiae.org.

Disposal of waste equipment by users in private households in the
European Union

This symbol on the product or on its packaging indicates that this product must not be disposed of with
your other household waste. Instead, it is your responsibility to dispose of your waste equipment by
handing it over to a designated collection point for the recycling of waste electrical and electronic
equipment. The separate collection and recycling of your waste equipment at the time of disposal will
help to conserve natural resources and ensure that it is recycled in a manner that protects human health
and the environment. For more information about where you can drop off your waste equipment for
recycling, please contact your local city office, your household waste disposal service or the shop where
you purchased the product.

Material Safety Data Sheet (MSDS)
Material Safety Data Sheets (MSDS) for supplies containing chemical substances (for example, toner)
can be obtained by accessing the HP Web site at www.hp.com/go/msds or www.hp.com/hpinfo/
community/environment/productinfo/safety.
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For more information
To obtain information about these environmental topics:

● Product environmental profile sheet for this and many related HP products

● HP’s commitment to the environment

● HP’s environmental management system

● HP’s end-of-life product return and recycling program

● Material Safety Data Sheets

Visit www.hp.com/go/environment or www.hp.com/hpinfo/globalcitizenship/environment.
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Declaration of conformity
Declaration of Conformity
according to ISO/IEC 17050-1 and EN 17050-1
Manufacturer’s Name: Hewlett-Packard Company
Manufacturer's Address: 11311 Chinden Boulevard,

Boise, Idaho 83714-1021, USA
declares, that the product

Product Names:3) HP Color LaserJet CP3505 Series printers
Regulatory Model:2) BOISB-0504-00

Including

Q5985A – Optional 500 Sheet Input Tray
Product Options: ALL
Print Cartridges: Q6470A, Q7581A, Q7582A, Q7583A
conforms to the following Product Specifications:

SAFETY: IEC 60950-1:2001 / EN60950-1: 2001 +A11
IEC 60825-1:1993 +A1 +A2 / EN 60825-1:1994 +A1 +A2 (Class 1 Laser/LED Product)
GB4943-2001

EMC: CISPR22:2005 / EN55022:2006 - Class B1)

EN 61000-3-2:2000
EN 61000-3-3:1995 +A1
EN 55024:1998 +A1 +A2
FCC Title 47 CFR, Part 15 Class B / ICES-003, Issue 4
GB9254-1998, GB17625.1-2003

Supplementary Information:

The product herewith complies with the requirements of the EMC Directive 89/336/EEC and the Low Voltage Directive 73/23/EEC, and carries
the CE-Marking accordingly.

This Device complies with Part 15 of the FCC Rules. Operation is subject to the following two Conditions: (1) this device may not cause
harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

1) The product was tested in a typical configuration with Hewlett-Packard Personal Computer Systems.

2) For regulatory purposes, these products are assigned a Regulatory model number. This number should not be confused with the product
name or the product number(s).

3) CLJ3600 series and CLJ3800 series are similar in design, but using various interface boards.

Boise, Idaho 83713, USA

February 1, 2007

For Regulatory Topics only, contact:

European Contact Your Local Hewlett-Packard Sales and Service Office or Hewlett-Packard Gmbh, Department HQ-TRE / Standards
Europe, Herrenberger Strasse 140, Böblingen, D-71034, Germany, (FAX +49-7031-14-3143)

USA Contact Product Regulations Manager, Hewlett-Packard Company, PO Box 15, Mail Stop 160, Boise, ID 83707-0015, USA,
(Phone: 208-396-6000)

ENWW Declaration of conformity 205



Country/region specific statements
Laser safety

The Center for Devices and Radiological Health (CDRH) of the U.S. Food and Drug Administration has
implemented regulations for laser products manufactured since August 1, 1976. Compliance is
mandatory for products marketed in the United States. The device is certified as a “Class 1” laser product
under the U.S. Department of Health and Human Services (DHHS) Radiation Performance Standard
according to the Radiation Control for Health and Safety Act of 1968. Since radiation emitted inside the
device is completely confined within protective housings and external covers, the laser beam cannot
escape during any phase of normal user operation.

WARNING! Using controls, making adjustments, or performing procedures other than those specified
in this user guide may result in exposure to hazardous radiation.

Canadian DOC regulations
Complies with Canadian EMC Class A requirements.

« Conforme la classe A des normes canadiennes de compatibilit lectromagntiques. « CEM ». »

VCCI statement (Japan)

Power cord statement (Japan)

EMI statement (Korea)

EMI statement (Taiwan)
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Laser statement for Finland
Luokan 1 laserlaite

Klass 1 Laser Apparat

HP Color LaserJet CP3505, CP3505n, CP3505dn, CP3505x, laserkirjoitin on käyttäjän kannalta
turvallinen luokan 1 laserlaite. Normaalissa käytössä kirjoittimen suojakotelointi estää lasersäteen
pääsyn laitteen ulkopuolelle. Laitteen turvallisuusluokka on määritetty standardin EN 60825-1 (1994)
mukaisesti.

VAROITUS !

Laitteen käyttäminen muulla kuin käyttöohjeessa mainitulla tavalla saattaa altistaa käyttäjän
turvallisuusluokan 1 ylittävälle näkymättömälle lasersäteilylle.

VARNING !

Om apparaten används på annat sätt än i bruksanvisning specificerats, kan användaren utsättas för
osynlig laserstrålning, som överskrider gränsen för laserklass 1.

HUOLTO

HP Color LaserJet CP3505, CP3505n, CP3505dn, CP3505x - kirjoittimen sisällä ei ole käyttäjän
huollettavissa olevia kohteita. Laitteen saa avata ja huoltaa ainoastaan sen huoltamiseen koulutettu
henkilö. Tällaiseksi huoltotoimenpiteeksi ei katsota väriainekasetin vaihtamista, paperiradan
puhdistusta tai muita käyttäjän käsikirjassa lueteltuja, käyttäjän tehtäväksi tarkoitettuja ylläpitotoimia,
jotka voidaan suorittaa ilman erikoistyökaluja.

VARO !

Mikäli kirjoittimen suojakotelo avataan, olet alttiina näkymättömällelasersäteilylle laitteen ollessa
toiminnassa. Älä katso säteeseen.

VARNING !

Om laserprinterns skyddshölje öppnas då apparaten är i funktion, utsättas användaren för osynlig
laserstrålning. Betrakta ej strålen. Tiedot laitteessa käytettävän laserdiodin säteilyominaisuuksista:
Aallonpituus 775-795 nm Teho 5 m W Luokan 3B laser.
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Substances Table (China)
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Symbols/Numerics
2-sided printing

binding options 96
control panel settings 95

A
accessibility features 4
accessories

ordering 181
address, printer

Macintosh,
troubleshooting 174

auto continue 29
automatic media sensing 76

B
bin

locating 5
blank pages

printing 90
both sides, printing on 28
brightness, control panel

display 28
buttons, control panel 10

C
Canadian DOC regulations 206
cancelling a print job 88
cartridges

features 4
recycling 201
status messages 11

cartridges, print
Macintosh status 52
warranty 188

cleaning the printer 126
clearable warnings 29
color

adjusting 104
halftone options 104

HP ImageREt 2400 102
HP ImageREt 3600 102
managing 104
matching 107
print in grayscale 104
printed vs. monitor 107
sRGB 102
using 102

Color tab settings 51,  98
configuration page

printing 110
configuring

e-mail alerts 112
control panel

buttons 10
display 11
display brightness 28
language, setting default 31
lights 10
locating 5
menus 13
overview 9
settings 26,  37,  46
shared environments 32

controlling print jobs 87
cover pages 49,  89
custom paper sizes 62
custom-size paper

driver settings 94
custom-size paper settings

Macintosh 49
customer support

online 190

D
device status

Macintosh Services tab 52
diagnostics 165
diagnostics menu 25

DIMMs
installing 127

display, control panel
brightness, setting 28
language, setting default 31
messages 11

doors, locating 5
double-sided printing 28,  51,

95,  96
drivers

Macintosh settings 49
Macintosh,

troubleshooting 174
Services tab 100
settings 37,  38,  46
shortcuts (Macintosh) 49
shortcuts (Windows) 92
supported 35
Windows settings 92

Duplex Blank Pages feature 28
duplex printing 95

E
e-mail alerts

configuring 112
Easy Printer Care software 42
EIO (Enhanced Input/Output)

configuring 58
EIO slot 6
embedded Web server

checking toner level 121
ordering supplies 183
using 113
using to configure alerts 112

Energy Star compliance 3
enlarging documents 93
envelopes

loading in tray 1 66
EPS files, troubleshooting 175
error messages, control panel 11
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errors, auto-continuable 29
European Union, waste

disposal 203
extended warranty 191

F
FCC statement 200
features 3
file directory page

printing 110
Finnish laser safety

statement 207
first page

blank 90
use different paper 49,  89

font list
printing 111

fonts
EPS files, troubleshooting 175

front door, locating 5

G
grayscale printing 104

H
HP Customer Care 190
HP Easy Printer Care Software

using 116
HP Easy Printer Care

software 42
HP fraud hotline 122
HP Jetdirect print servers 58
HP SupportPack 191
HP Web Jetadmin

checking toner level 121
using to configure e-mail

alerts 112
HP-UX software 44

I
I/O menu 23
information menu 15
input trays

configuring 16,  73
installers, Windows 43
installing

Macintosh software for direct
connections 47

Macintosh software on
networks 47

IP address
Macintosh,

troubleshooting 174

J
jam recovery 30
jams

common causes 148
configuring e-mail alerts 112
locations 149
recovery 149

Japanese VCCI statement 206
Jetadmin, HP Web 42

K
Korean EMI statement 206

L
language, setting default 31
laser safety statements 206,  207
lights, control panel 10,  11
Linux software 44

M
Macintosh

driver settings 46,  49
drivers, troubleshooting 174
installing printing system for

direct connections 47
installing printing system for

networks 47
problems,

troubleshooting 174
removing software 48
resize documents 49
software 46
software components 43
support 190
supported operating

systems 46
USB card,

troubleshooting 175
Macintosh driver settings

custom-size paper 49
Services tab 52
watermarks 50

maintenance agreements 191
manual feed 27
Material Safety Data Sheet

(MSDS) 203

media
automatic sensing 76
configuring trays 26
custom-size 94
custom-size, Macintosh

settings 49
document size, selecting 93
first page 49,  89
load 64
manual feed 27
pages per sheet 50,  97
supported sizes 61

memory
adding 127
enabling 130
installing 127

menu map
printing 110

menus
diagnostics 25
I/O 23
information 15
paper handling 16
print quality 19
printing 17
resets 23
system setup 20

messages, control panel 11
multiple pages per sheet 50,  97

N
n-up printing 50,  97
networks

configuring 55
control panel use in 32
default gateway 56
disabling AppleTalk 57
disabling DLC/LLC 58
disabling IPX/SPX 57
disabling protocols 57
IP address 55
Macintosh installation 47
ports, locating 6
subnet mask 56

O
on-site service agreements 191
on/off switch 6
online support 190
operating systems supported 46
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operating systems, supported 34
output bin extender 64
output bins

locating 5

P
pages per sheet 50,  97
paper

configuring trays 26
custom sizes 62
custom-size 94
custom-size, Macintosh

settings 49
document size, selecting 93
first page 49,  89
loading in tray 1 64
manual feed 27
pages per sheet 50,  97
supported sizes 61

paper handling menu 16
paper path test page 165
pausing a print job 88
PCL drivers 35
Personality feature 28
ports

locating 6
troubleshooting

Macintosh 175
power saving. See Sleep Mode

feature
power switch 6
print cartridge

authentication 122
checking the toner level 120
genuine HP 121
managing 120
non-HP 121
replacing 123
storing 121

print cartridges
features 4
Macintosh status 52
recycling 201
status messages 11
warranty 188

Print Document On 93
print media

load 64
supported 61

print quality menu 19

printer information pages 110,
179

printing menu 17
priority, settings 37,  46
product stewardship

program 201
PS Defer Media feature 27
PS Emulation drivers 35

R
recycling

HP printing supplies returns and
environmental program 202

reducing documents 93
registration page 165
regulations

FCC 200
removing Macintosh software 48
repacking the printer 192
Replace Supplies setting 30
resets menu 23
resize documents

Macintosh 49
resizing documents 93

S
safety statements 206,  207
scale documents

Macintosh 49
scaling documents 93
service agreements 191
Services tab

Macintosh 52
settings

driver shortcuts
(Macintosh) 49

drivers 38,  46
priority 37,  46
shortcuts (Windows) 92

shared environments 32
shipping the printer 192
shortcuts 92
shortcuts (Macintosh) 49
Size/Type Prompt feature 27
Sleep Delay feature 80
Sleep Mode feature 80
software

direct connection installation,
Macintosh 47

embedded Web server 42,
48

HP Easy Printer Care 42
HP Web Jetadmin 42
Macintosh 43,  46
network installation,

Macintosh 47
settings 37,  46
supported operating

systems 34,  46
uninstalling Macintosh 48
Windows 33,  43

Solaris software 44
special media

guidelines 63
special paper

guidelines 63
specifications

features 3
media 59

status
Macintosh services tab 52

status, supplies
control panel messages 11
printer features 4
settings 30

subnet mask 56
supplies

ordering 181
recycling 201
replacement intervals 120

supplies low
configuring e-mail alerts 112

supplies out
configuring alerts 112

supplies status
control panel messages 11
printer features 4
settings 30

supplies status page
printing 110

supply-status, Services tab
Macintosh 52

support
online 190

supported media 61
supported operating systems 34
SupportPack, HP 191
system setup menu 20
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T
Taiwan EMI statement 206
technical support

online 190
test pages 165
toner cartridge. See print cartridge
top cover, locating 5
tray 1 51,  96
Tray Behavior menu 26
trays

configuring 26
double-sided printing 51,  96
locating 5

troubleshooting
checklist 132
EPS files 175
incorrect printer output 172
jams 149
Macintosh problems 174
overhead transparencies 178
print quality 178

two-sided printing 28,  95

U
uninstalling Macintosh

software 48
UNIX software 44
usage page

printing 110
USB port

locating 6
Macintosh installation 47
troubleshooting

Macintosh 175
Use Another Tray feature 27
Use different paper/covers 89
Use Requested Tray feature 26

W
warranty

Customer self repair 187
extended 191
print cartridge 188
product 186

watermarks 50,  91
Web sites

customer support 190
Macintosh customer

support 190

Material Safety Data Sheet
(MSDS) 203

printer features 3
Windows

driver settings 38,  92
drivers supported 35
software components 43
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